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Preface
This guide includes instructions for installing and upgrading to Kofax TotalAgility 7.6.0, including:
• Preparations, decisions, precautions, settings, and tips to help you install Kofax TotalAgility
• Instructions for installing Kofax TotalAgility in silent mode or using the wizard in a client/server or
standalone configuration
• Information about installing other Kofax products used with Kofax TotalAgility
• Information about updating various TotalAgility configuration files post installation, instead of manually
updating each configuration file and the settings separately.
Read this guide completely before installing the software.

Related documentation
The full documentation set for Kofax TotalAgility is available at the following location.
https://docshield.kofax.com/Portal/Products/KTA/7.6.0-d4fslp3xyr/KTA.htm
In addition to this guide, the documentation set includes the following items:
• Kofax TotalAgility Prerequisites Guide: Provides system requirements for installing TotalAgility,
instructions for running the prerequisite utility, and a software checklist for various installation types.
• Kofax TotalAgility Integration Server Installation Guide: Describes how to install Kofax Integration
Server and integrate it with other products.
• Kofax TotalAgility On-Premise Multi-Tenancy Installation Guide: Describes how to install and configure
On-Premise Multi-Tenant system.
• Kofax TotalAgility Configuration Utility Guide: Explains how to use the Configuration Utility to update
settings across various configuration files for different types of installation and deployment.
• Kofax TotalAgility Administrator's Guide: Provides information to the administrator on configuring and
maintaining a TotalAgility installation.
• Kofax TotalAgility Architecture Guide: Provides an overview of the TotalAgility architecture, covering
various deployments for on-premise, on-premise multi-tenancy and Azure environments.
• Kofax TotalAgility Best Practices Guide: Describes the best practices you must follow when using
TotalAgility to improve performance, cost, maintenance, availability and security.
• Kofax TotalAgility Features Guide: Provides an overview of the TotalAgility features.
• Kofax TotalAgility Migration Guide: Provides information on TotalAgility upgrades from different versions
and post upgrade configuration.
• Kofax TotalAgility Help: Provides details about using TotalAgility to design business jobs and cases,
assign resources, create forms, integrate with external applications, and more.
• Kofax TotalAgility Workspace Help: Describes how to use the Workspace to manage activities, jobs,
and resources.
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• Kofax TotalAgility On-Premise Multi-Tenant System Help: Describes how to create and manage tenants
using the TotalAgility On-Premise Multi-Tenant system.
• Kofax TotalAgility Web Capture Control Help: Provides details on using a Web Capture control in
creating multi-page documents, creating a new document in a new folder, deleting pages that have
been incorrectly scanned, and more; also, describes the buttons available in a Web Capture control
toolbar.
• Kofax Analytics for TotalAgility Product Features Guide: Provides an overview of the dashboards that
help you track data through the workflow, analyze the effectiveness of the processes and resources,
and address business problems.
• Kofax TotalAgility Tables: Describes the Kofax TotalAgility tables and fields used by Kofax Analytics for
TotalAgility.
• Migration From Kofax Products Guide: Provides information about migrating TotalAgility files and Kofax
Transformation Modules projects to TotalAgility.

Offline documentation
Customers who require offline documentation can download the individual zip files available
on a per language basis, such as Kofax TotalAgilityDocumentation7.6.0_EN.zip and Kofax
TotalAgilityDocumentation7.6.0_DE.zip from the Kofax Fulfillment Site.
See Access the TotalAgility documentation for more information

Training
Kofax offers both classroom and computer-based training that will help you make the most of your Kofax
TotalAgility solution. Visit the Kofax website at www.kofax.com for complete details about the available
training options and schedules.

Getting help with Kofax products
The Kofax Knowledge Base repository contains articles that are updated on a regular basis to keep you
informed about Kofax products. We encourage you to use the Knowledge Base to obtain answers to your
product questions.
To access the Kofax Knowledge Base, go to the Kofax website and select Support on the home page.
Note The Kofax Knowledge Base is optimized for use with Google Chrome, Mozilla Firefox or Microsoft
Edge.
The Kofax Knowledge Base provides:
• Powerful search capabilities to help you quickly locate the information you need.
Type your search terms or phrase into the Search box, and then click the search icon.
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• Product information, configuration details and documentation, including release news.
Scroll through the Kofax Knowledge Base home page to locate a product family. Then click a product
family name to view a list of related articles. Please note that some product families require a valid
Kofax Portal login to view related articles.
• Access to the Kofax Customer Portal (for eligible customers).
Click the Customer Support link at the top of the page, and then click Log in to the Customer Portal.
• Access to the Kofax Partner Portal (for eligible partners).
Click the Partner Support link at the top of the page, and then click Log in to the Partner Portal.
• Access to Kofax support commitments, lifecycle policies, electronic fulfillment details, and self-service
tools.
Scroll to the General Support section, click Support Details, and then select the appropriate tab.
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Installation planning
The primary source of information about supported operating systems and other Kofax TotalAgility
requirements is the Technical Specifications document, which is available on the Kofax website at
www.kofax.com.
Review these important notes before you proceed with the installation.
• To view information on the system requirements for installing TotalAgility, instructions for running
the prerequisite utility, and the software checklist for various installation types, download the Kofax
TotalAgility Prerequisites Guide from the Kofax Fulfillment Site.
• If your solution includes multiple Kofax products, review the Technical Specifications document.
• Obtain a license key for Kofax TotalAgility either from your Account Manager or from Kofax Support.
• Before extracting TotalAgility installation ZIP file, unblock the file from the file properties window.
• Upgrade installations of Transformation Designer that connects to Kofax TotalAgility 7.6.0.
• TotalAgility includes a limited number of VRS Elite licenses. You may need to purchase additional
licenses, depending on the number of scanners you plan to use with VRS. See the Kofax Scanner
Configurator to verify VRS certification and licensing requirements for your scanner.

Utilities
The following utilities are available on the TotalAgility installation media.
• To ensure all the required software is installed on your computer before installing TotalAgility, run the
Prerequisite utility. For more information, see the Kofax TotalAgility Prerequisites Guide.
• After installing TotalAgility, you can update the configuration settings by editing each configuration file
separately or by running the configuration utility available on the installation media. The utility allows
you to modify or update the settings across multiple configuration files at one go instead of editing each
file separately. You must manually copy the utility onto each server where the configuration settings are
to be modified. See the Kofax TotalAgility Configuration Utility Guide.
• To test how an image will look once the eVRS setting is applied to it, run the EVRSCheck utilty.

License Proxy
Use TotalAgility License Proxy when the license server is not directly accessible from VRS stations or the
linked TotalAgility server, for example, due to security restrictions or on using Azure. Using the License
Proxy, you can use a TotalAgility license configuration through TotalAgility web services rather than by
directly addressing the license server.
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A license proxy is also useful for network topologies where multiple networks are logically separate, such
as Microsoft Azure cloud. A License proxy allows computers in Network A to use a TotalAgility license
server in Network B. A license proxy uses TotalAgility web services (over HTTP/HTTPS) to communicate
with the license server. The license proxy computer needs a working internet connection to facilitate the
HTTP/HTTPS traffic to the License server.
See TotalAgility License Proxy installation.
Important If you have previously upgraded from Kofax TotalAgility 7.1.0 to 7.2.0 and are now upgrading
to 7.6.0 and want to use License Proxy, then you must manually setup the license proxy on TotalAgility
7.2.0 before upgrading to 7.6.0. This action is not required if directly upgrading from TotalAgility 7.1.0 to
7.6.0.

Licensing information
This section provides information on licensing details.

Concurrent user licensing
In the Concurrent User model, many users can simultaneously log into the system. Each user
session consumes a license. For example, if a single user logs into the Designer and the Workspace
simultaneously or the user logs into the Designer in two browsers such as Internet Explorer and Chrome,
the user consumes two concurrent licenses. When a user logs off from a session, the license server
automatically releases the license.
When the number of concurrent users reaches the maximum, the system automatically checks for
available reserved licenses. If any reserved license is available, the user can log on and the count of
available reserve licenses is reduced by 1. Keep the following items in mind when managing reserved
licenses:
• A reserved license expires seven days after you begin using the license.
• You can use each reserved license only twice within 12 months.
If the user tries to log on after the number of concurrent logons reaches the limit and there are no
reserved licenses, the system displays an error message and additional users cannot log on.
If a reserved license expires, an error message appears in the TotalAgility Designer and TotalAgility
Workspace.

Activate a license in TotalAgility
The license period starts once the license is activated. So you can skip activation during installation and
only activate it when you are ready to use TotalAgility.
If you log on to TotalAgility for the first time and the license is not activated, the License Activation window
opens.
1. In the License Activation window, either click Next to accept the default values for the License
Server and Port Number, or enter the new values.
2. Click Set License Server to save the information.
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3. For further instructions, see Activate the License Server step in Perform a standard installation .
Note Should you have issues activating your licence, contact Kofax support at: http://
www.kofax.com/support/tools/

Kofax Message Connector
Kofax Message Connector is a Windows service responsible for importing messages and files in many
electronic formats. It retrieves documents from various sources and saves them in its internal storage
making them available for retrieval through a web service interface. Kofax TotalAgility connects to the
Message Connector web service interface and retrieves the documents for import.
Kofax Message Connector can import messages and files from a number of sources:
• Email messages including attachments using various email protocols (SMTP, POP3, IMAP, EWS).
• Fax messages (via internal fax over IP server or external fax servers: Kofax Communication Server,
RightFax, Biscom).
• Files from a local or network folder
For information on prerequisites for the Kofax Message Connector, see the Kofax TotalAgility
Prerequisites Guide and for information on deployment scenarios and advanced configurations, see the
Kofax TotalAgility Administrator's Guide.

System limits
Following system limits are applicable for 64-bit installations. For 32-bit installations, these limits may vary.
• The maximum size of a message in Message Connector storage is 8 GB.
• Up to three Message Connector instances on a single computer are allowed.
• For KfxConverter, the maximum system memory usage limit is up to 4 GB.
Note The limit of the input file size may vary depending on the number of pages in a document, type
of document and type of conversion.

Reporting Server
Kofax Reporting provides centralized storage of historical operational metrics and audit data. Kofax
Reporting includes the components such as the ETL Agent and databases.
Important Due to high process utilization by Transformation Server (99%), Reporting Server is known to
produce "SQL Timeout error" when installed on the same machine as Transformation Server. Therefore,
you must install Reporting Server separately from Transformation Server.
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Kofax VRS Elite
We highly recommend Kofax VRS Elite, a patented image perfection software that dramatically improves
scanning productivity and document capture efficiency when used with a VRS-certified scanner. If
your scanner is not VRS-certified, you can use the Kofax image processing technology included with
TotalAgility.
Several Kofax VRS licensing options are available:
Kofax VRS Basic or Professional OEM
Automatically activate a Kofax VRS Basic or Professional OEM license that is included with many
industry-standard scanners. License activation for these scanners is required only when upgrading to
Kofax VRS Elite.
Standalone workstation
Manually activate a standalone license, which stays on the workstation until it is deactivated. The
standalone license can only be activated on one scan station at a time.
TotalAgility license server
Centrally manage concurrent VRS Elite licenses from the TotalAgility license server.
To centrally manage VRS licenses through the Kofax TotalAgility license server, each VRS station needs
to communicate with the license server directly or through a license proxy.

Web Capture Service
To enable web scanning, you must install the Kofax Web Capture Service.
When installing through the browser, you must have administrative rights to complete the installation.
You need to install the Web Capture Service only once, and web scanning is enabled across all the
supported browsers.
Install the Kofax Web Capture Service either at the default location or to a custom location.
Temporary files are created under the folder “Interprocess”. The user must have read/write access to this
folder.
You can also use the Web Capture Service on multiuser environments.

Scan Agent Service
The Scan Agent Service is an asynchronous upload capability, which allows scan operator to continue on
to the next batch, without needing to wait for the previous scan job to complete upload.
This service is useful in remote scanning scenarios, where the scan station has limited network bandwidth
to the main TotalAgility site.
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The capability allows scan operator to keep up with physical scanning throughput, while image upload is
done in the background, thus enhancing the scan operator efficiency.
This feature is only available for Scan Create New Job forms.
A Scan Create New Job form automatically uses the asynchronous image upload mode if it detects Scan
Agent Service installed on the scan station. Otherwise, it uses the synchronous image upload mode if the
Scan Agent Service is not detected.
For Device Create New Job form, a pre-condition of [SCANNED] > 0 must be added to the first activity in
a process, to allow the process to wait for all images to be uploaded before moving on to the first activity.
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TotalAgility installation
This chapter describes two methods for installing TotalAgility:
• Silent installation for multiple servers that use the same configuration.
• Standard installation using the installation wizard.
You can install TotalAgility as one of the following types:
• Database Only: Installs only the database component of Kofax TotalAgility only; no other components
are installed.
• Web Server: Installs a server to point to any Application server. In case you install TotalAgility on
a computer other than the default port, you must enter the Application Server machine name and
port number. For example, <appserver_name:82>. A Web server installs the SDK Services and user
interfaces for the Designer and Workspace.
• Application Server: Installs a server to which remote clients will connect and sets up their web
servers. An Application server only installs Core services and does not install user interfaces and any
shortcuts for the Designer and Workspace.
• Web and Application Server: Installs the Web and Application servers on a single computer.
• Real Time Transformation Service: Installs the Real Time Transformation Service.
Note
• You must have administrator account to install TotalAgility.
• Ensure that the user who will run TotalAgility has "Log on as Service" rights.
• You can use hotkeys to navigate to next screen.
• Post installation, you can modify the configuration settings by editing each configuration file
separately or running the configuration utility. The configuration utility is available on the installation
media. You must manually copy the utility onto each server where the configuration settings are to be
modified. See the Kofax TotalAgility Configuration Utility Guide.

Perform a silent installation
Use the TotalAgility silent installation to install TotalAgility automatically from a command line or a batch
file. After you edit the silent installation file, the installation proceeds without any user interaction.
See also:
• Silent installation of Web and Application on the same server
• Silent installation on a separate Web or Application server
• Silent installation for Real Time Transformation Server
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• Silent installation for Database Only
• Upgrade TotalAgility in silent mode

Silent installation for Database Only
1. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor.
2. In SilentInstallConfig.xml, update the following parameters.
Parameter

Default Value

Description

true

Installs the databases.

DatabaseInformation
InstallDatabases

Set to false to ignore installing
databases.
OverwriteIfExisting

false

Set to true to overwrite the existing
databases.

DatabaseName

TotalAgility

Specify the name of the Main
database.

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

Main Database

Note When installing
TotalAgility with a remote
database, update
SilentInstallConfig.xml
with the server name
(<Server>servername</
Server>) of the machine on
which the database resides.
The account used to connect
to the database during
the installation requires
DB_CREATOR rights.
SqlScript
CreateScript

Create_Main.SQL

Accept the default.

DropScript

Drop_Main.sql

Accept the default.

InitializeScript

Initialise_Main.sql

Accept the default.

ConversionScript

Convert_Main.SQL

Only required for patch when there
are SQL changes.

Security
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Parameter

Default Value

Description

WindowsAuthentication

true

Uses Windows credentials for
logging in.
If set to false, provide the user
name and password. Otherwise,
leave the user name and password
blank.

UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility

Specify the name of the Audit
database.

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

CreateScript

Create_Audit.sql

Accept the default.

DropScript

Drop_Audit.sql

Accept the default.

InitializeScript

Initialise_Audit.sql

Accept the default.

ConversionScript

Convert_Audit.SQL

Only required for patch when there
are SQL changes.

true

Uses Windows credentials for
logging in.

Audit Database

SqlScript

Security
WindowsAuthentication

If set to false, provide the user
name and password. Otherwise,
leave the user name and password
blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility

Specify the name of the Finished
Jobs database.

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

CreateScript

Create_Archive.sql

Accept the default.

DropScript

Drop_Archive.sql

Accept the default.

Conversion Script

Convert_Archive.SQL

Only required for patch when there
are SQL changes.

Finished Jobs Database

SqlScript
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Parameter

Default Value

Description

true

Uses Windows credentials for
logging in.

Security
WindowsAuthentication

If set to false, provide the user
name and password. Otherwise,
leave the user name and password
blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DataLayer - TotalAgility_Documents Database
DatabaseName

TotalAgility_Documents

Specify the name of the
TotalAgility_Documents database.

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

CreateScript

Repository2012_TablesCreate.sql

Accept the default.

DropScript

Repository2012_Drop.sql

Accept the default.

Conversion Script

Repository2012_Convert.SQL

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

SqlScript

Security
WindowsAuthentication

If set to false, provide the
username and password.
Otherwise, leave the username and
password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility_Simulator

Specify the name of the
TotalAgility_Simulator database.

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

CreateScript

Create_Simulator.SQL

Accept the default.

DropScript

Drop_Simulator.SQL

Accept the default.

InitializeScript

empty

Accept the default.

Simulator Database

SqlScript
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Parameter

Default Value

Description

Conversion Script

empty

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

Security
Windows Authentication

If set to false, provide the
username and password.
Otherwise, leave the username and
password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility_Reporting

Specify the name of the
TotalAgility_Reporting database.

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

Kofax.Reporting.Analytics.

Accept the default.

Reporting_Analytics Database

SqlScript
CreateScript

SQL_TablesCreate.sql
DropScript

Kofax.Reporting.Analytics.

Accept the default.

SQL_Drop.sql
InitializeScript

Kofax.Reporting.Analytics.

Accept the default.

SQL_Initialize.sql
Conversion Script

empty

Only required for patch when SQL
changes are needed.

true

Set to true to use Windows
credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the
username and password.
Otherwise, leave the username and
password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

TotalAgility_Reporting_Staging

Specify the name of the
TotalAgility_Reporting_Staging
database.

Reporting_Staging Database
DatabaseName
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Parameter

Default Value

Description

Server

server name

Enter the Fully Qualified Domain
Name (FQDN) of the server.

Kofax.Reporting.Analytics.

Accept the default.

SqlScript
CreateScript

Staging.SQL_TablesCreate.sql
DropScript

Kofax.Reporting.Analytics.

Accept the default.

Staging.SQL_Drop.sql
InitializeScript

Kofax.Reporting.Analytics.

Accept the default.

Staging.SQL_Initialize.sql
Conversion Script

Convert_Simulator.SQL

Only required for patch or upgrade
when SQL changes are needed.

true

Uses Windows credentials for
logging in.

Security
WindowsAuthentication

If set to false, provide the user
name and password. Otherwise,
leave the user name and password
blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

Both

Change the value to DatabaseOnly.

Install Info
InstallType

Note When you install only
databases, the system
ignores the services, and
does not install services
such as CoreworkerService,
ImportService and
ExportService.
<SiteRoot>

Default Web Site

Install TotalAgility under a custom
site that uses a non-standard port
other than the standard ports (80
and 443).
For example, create a custom site
called "testsite" under IIS using the
port number 85.

3. Save and close the file.
4. On the Command Prompt, change the command line to the root directory of the Setup.exe file.
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5. Run Setup.exe /Silent.
The databases are installed automatically.
The system generates a log file that reports errors (if any).
The success or failure of installation is indicated in the event log.
When automating the installation, if you run setup.exe from the command line, or run setup.exe as a
silent installation, one of the codes returns to indicate the following:
• 0= Success
• 1= Success with warnings
• 2= Failure

Silent installation of Web and Application on the same server
Update the following parameters for a Web-Application server installation.
1. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor.
2. In SilentInstallConfig.xml, update the following parameters.
Note Fix the line breaks if you copy and paste the code from this guide.
Parameter

Default value

Description

CoreWorkerService

true

Installs the Core Worker Service. You
can set it to False, if needed.

ImportService

true

Installs the Import Service. You can set it
to False, if needed.

ExportService

true

Installs the Export Service. You can set it
to False, if needed.

ReportingService

true

Installs the Reporting Service. You can
set it to False, if needed.

LicenseService

true

Installs the License Service. You can set
it to False, if needed.

TransformationService

true

Installs the Transformation Service. You
can set it to False, if needed.

CoreServices

true

Installs the Core services. You can set it
to False, if needed.

LicenseServerName

localhost

Enter the name of the license server.

PortNumber

3581

Do not change this value.

SerialNumber

empty

Enter your TotalAgility serial number.

ProductCode

empty

Enter your TotalAgility product code.

ServicesInstallOptions

LicenseServer
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Parameter

Default value

Description

SkipLicense

true

Skips activating the license.
Set to FALSE to activate the license; you
must enter the serial number and product
code to install TotalAgility.

InstallDirectory

C:\Program Files\

Specify the TotalAgility destination
directory.

true

Installs the databases.

Kofax\TotalAgility
DatabaseInformation
InstallDatabases

Set to false to ignore installing
databases.
OverwriteIfExisting

true

Overwrites the existing databases.

ScriptsLocation

C:\Program Files
\Kofax\TotalAgility
\ DatabaseScripts\SQL
Server\

Specify the directory for installing scripts.

DatabaseName

TotalAgility

Specify the name of the Main database.

Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

Main Database

Note When installing TotalAgility
with a remote database,
update SilentInstallConfig.xml
with the server name
(<Server>servername</Server>) of
the machine on which the database
resides.
The account used to connect to
the database during the installation
requires DB_CREATOR rights.
SqlScript
CreateScript

Create_Main.SQL

Accept the default.

DropScript

Drop_Main.sql

Accept the default.

InitializeScript

Initialise_Main.sql

Accept the default.

ConversionScript

Convert_Main.SQL

Only required for patch when there are
SQL changes.

true

Uses Windows credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.
UserName

empty
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Parameter

Default value

Description

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility

Specify the name of the Audit database.

Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

CreateScript

Create_Audit.sql

Accept the default.

DropScript

Drop_Audit.sql

Accept the default.

InitializeScript

Initialise_Audit.sql

Accept the default.

ConversionScript

Convert_Audit.SQL

Only required for patch when there are
SQL changes.

true

Uses Windows credentials for logging in.

Audit Database

SqlScript

Security
WindowsAuthentication

If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility

Specify the name of the Finished Jobs
database.

Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

CreateScript

Create_Archive.sql

Accept the default.

DropScript

Drop_Archive.sql

Accept the default.

Conversion Script

Convert_Archive.SQL

Only required for patch when there are
SQL changes.

true

Uses Windows credentials for logging in.

Finished Jobs Database

SqlScript

Security
WindowsAuthentication

If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.
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Parameter

Default value

Forms

empty

Description

DataLayer - TotalAgility_Documents Database
DatabaseName

TotalAgility_Documents

Specify the name of the
TotalAgility_Documents database.

Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

CreateScript

Repository2012_TablesCreate
.sql

Accept the default.

DropScript

Repository2012_Drop.sql

Accept the default.

Conversion Script

Repository2012_Convert.SQL

Only required for patch when there are
SQL changes.

true

Uses Windows credentials for logging in.

SqlScript

Security
WindowsAuthentication

If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility_Simulator

Specify the name of the
TotalAgility_Simulator database.

Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

CreateScript

Create_Simulator.SQL

Accept the default.

DropScript

Drop_Simulator.SQL

Accept the default.

InitializeScript

empty

Accept the default.

Conversion Script

Convert_Simulator.SQL

Only required for patch when there are
SQL changes.

true

Uses Windows credentials for logging in.

Simulator Database

SqlScript

Security
Windows Authentication

If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.
UserName

empty

Password

empty
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Parameter

Default value

Description

NewDatabase

false

Set to true to create new database.

Reporting_Analytics Database
DatabaseName

TotalAgility_Reporting

Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

Kofax.Reporting.Analytics.

Accept the default.

SqlScript
CreateScript

SQL_TablesCreate.sql
DropScript

Kofax.Reporting.Analytics.

Accept the default.

SQL_Drop.sql
InitializeScript

Kofax.Reporting.Analytics.

Accept the default.

SQL_Initialize.sql
Conversion Script

empty

Only required for patch when SQL
changes are needed.

true

Uses Windows credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

TotalAgility_Reporting_

Specify the name of the
TotalAgility_Reporting_Staging database.

Reporting_Staging Database
DatabaseName

Staging
Server

server name

Specify the fully qualified domain name
(FQDN) of the server.

Kofax.Reporting.Analytics.

Accept the default.

SqlScript
CreateScript

Staging.SQL_TablesCreate.sql
DropScript

Kofax.Reporting.Analytics.

Accept the default.

Staging.SQL_Drop.sql
InitializeScript

Kofax.Reporting.Analytics.

Accept the default.

Staging.SQL_Initialize.sql
Conversion Script

empty

Only required for patch when SQL
changes are needed.

Security
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Parameter

Default value

Description

WindowsAuthentication

true

Uses Windows credentials for logging in.
If set to false, provide the user name and
password. Otherwise, leave the user
name and password blank.

UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

UserName

username

Enter the user name of the Windows
service account for the TotalAgility
services.

Password

password

Enter the password of the windows
service account for the TotalAgility
services.

RunAsSystemAccount

false

Accept the default.

Identity Information

If set to true, the AppPool and Kofax
TotalAgility services are created with
LocalSystem account.
Note If you set this parameter to
true, databases should be created
using SQL authentication.
RunAsNetworkServiceAccount

false

If set to true, the AppPool and Kofax
TotalAgility services are created with the
NT Authority\Network Service username.
Note If you set this parameter to
true, databases should be created
using SQL authentication.

Prerequisite Info
ValidOS

true

Checks if the Operating System is valid.

SQLServerInstalled

true

Set to true to check if the SQL Server is
installed.

SQLClientInstalled

false

Set to true to check if the SQL Client is
installed.

IISInstalled

true

Checks if IIS is installed.

SslEnabled

false

Set to true to enable https. See
Configure for HTTPS communication.

InstallAction

Install

Accept the default.

InstallMode

Silent

Accept the default.

InstallType

Both

Accept the default.

Install Info
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Parameter

Default value

Description

AuthenticationMode

Windows

Set the authentication mode to Windows.

Transformation Server Info
Note Configure these settings if TransformationService is "true".
TSConfigFile

empty

Specify the path to .ini file along with
the name for Transformation Server to
configure.
Important If you provide the .ini
file, the TransformationServerInfo
settings are taken from the .ini file;
the parameters mentioned in the
SilentInstallConfig are ignored.
See the .INI file Sample for the
parameters.

LogFile

Log file with full path.

Set the location where the
Transformation Server log file will be
created.
Example:
C:\Program Files
\Kofax\TotalAgility
\TransformationServer
\TSLog.txt

InstallLocation

C:\Program Files
\Kofax\TotalAgility
\TransformationServer

To install to a different location, specify
the Transformation Server destination
directory.

WindowsServiceAccount

username

Enter the name of the user who will run
the Transformation Server.
To specify a domain user, enter the user
name in the format Domain\User.
Ensure that the account details
are correct, as under this account
Transformation Server authenticates in
all places where Windows authentication
is used. Example: TA database.
All communication and resource access
will be run under this account. Therefore,
the account under which Transformation
Server is running must be not some
dummy account.

WindowsServicePassword

password

Enter the password for the user.

UseSpecificPool

false

Set this parameter to TRUE to add this
Transformation Server to a pool.
Any other value, including no value, is
treated as false and the Transformation
Server process all activities regardless of
pool.
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Parameter

Default value

Description

PoolName

empty

If you set UseSpecificPool=true, enter
the Transformation Server pool name.
Note If you leave the pool name
empty, all activities are processed
regardless of their pools.

OLEnabled

true

Enables online learning tasks on this
Transformation Server instance.
Set to FALSE or any other value to
disable online learning tasks.
Note In case where multiple
instances of Transformation Server
are installed for improving the
throughput of the capture activities,
online learning should be enabled
only on a single transformation
server instance in the cluster.

WcfPort

9001

Enter the port that is used by TotalAgility
to communicate with Transformation
Server during synchronous calls, such as
fuzzy searches and pushed activities.

ReservedSlots

0

Enter the number of slots on this
Transformation Server that are reserved
for pushed activities and high-priority
activities.

OverrideDefSlots

Empty

By default, the Transformation Server
determines the number of simultaneously
working Transformation Server controlled
processes that do actual processing
based on the machine CPU cores.
To specify your own values, enter the
value here.

MaxSlots

0

If you set
CPUSERVER_OVERRIDE_DEF_
SLOTS to TRUE, enter the number of
processing slots for this Transformation
Server.

EnableSyncCalls

true

Enables synchronous calls.
Set to FALSE to disable synchronous
calls.

IsIntegration Server

false

Set to TRUE to install the TotalAgility
Integration Server.

InstallLicenseProxy

false

Set to TRUE to install License Proxy.
If set to TRUE, provide the username
and password. Otherwise, leave the
username and password blank.
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Parameter

Default value

Description

UserName

empty

Provide the user name if
InstallLicenseProxy is set to true.

Password

empty

Provide the password if
InstallLicenseProxy is set to true.

KTAResourcePassword

empty

Specify a password for the TotalAgility
user to be created on installation.

StartServices

true

Starts the services.

ImportWorkspacePackage

false

Set to TRUE to import Workspace
package.

<SiteRoot>

Default Web Site

Install TotalAgility under a custom site
that uses a non-standard port other than
the standard ports (80 and 443).
For example, create a custom site called
"testsite" under IIS using the port number
85.

3. Save and close the file.
4. On the Command Prompt, change the command line to the root directory of the Setup.exe file.
5. Run Setup.exe /Silent.
Based on the parameters set to True in the silent configuration file, the following items are installed:
• Kofax TotalAgility
• Kofax Import Connector (KIC)
• Kofax Transformation Designer
Note
• Transformation Designer is installed only when the TransformationDesignerInstaller.exe is
available in the TotalAgility build folder.
• When you install Kofax TotalAgility from a network share, make sure the user has the Write
permissions to the share; otherwise, the Import Connector will not get installed successfully.
• Utility for Kofax Export Connector
• Licensing Service
• Transformation Server, if the "TransformationService" parameter is set to true and the following
parameters are set for Transformation Server:
• WindowsServiceAccount
• WindowsServicePassword
The system generates a log file that reports any errors.
The success or failure of installation is indicated in the event log.
When automating the installation, if you run setup.exe from the command line, or run setup.exe as a
silent installation, one of the codes returns to indicate the following:
• 0= Success
• 1= Success with warnings
• 2= Failure
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.INI file sample
TS_SERVICE_ACCOUNT=username
TS_SERVICE_PASSWORD=password
TS_USE_SPECIFIC_POOL=FALSE
TS_POOL_NAME=
TS_OL_ENABLED=TRUE
TS_WCF_PORT=9001
TS_RESERVED_SLOTS=0
TS_OVERRIDE_DEF_SLOTS=
TS_MAX_SLOTS=0
TS_ENABLE_SYNC_CALLS=TRUE
TS_MAIN_DB_CONNECTION_STRING=Server=servername;Trusted_Connection=Yes;Database=TotalAgility;
TS_SYNCHRONOUS_ONLY=false

Silent installation on a separate Web or Application server
Install TotalAgility on a separate Web or Application server.

Silent installation on an Application Server
Update the following parameters for an Application Server.
1. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor.
2. In SilentInstallConfig.xml, update the following parameters.
• InstallType = ApplicationServer.
• For other parameters, see Silent installation of Web and Application on the same server.
Note You can choose to install or not to install certain components by setting the values to True/
False in the ServicesInstallOptions section of the Silent Configuration file.
3. Save and close the file.
4. On the Command Prompt, change the command line to the root directory of the Setup.exe file.

31

Kofax TotalAgility Installation Guide

5. Run Setup.exe /Silent.
Based on the parameters set to True in the silent configuration file, the following items are installed:
• Kofax TotalAgility
• Kofax Import Connector (KIC)
• Kofax Transformation Designer
Note
• Transformation Designer is installed only when the Transformation DesignerInstaller.exe is
available in the TotalAgility build folder.
• When you install Kofax TotalAgility from a network share, make sure the user has the Write
permissions to the share; otherwise, the Import Connector will not get installed successfully.
• Utility for Kofax Export Connector
• Licensing Service
• Transformation Server, if the "TransformationService" parameter is set to true and the following
parameters are set for Transformation Server:
• WindowsServiceAccount
• WindowsServicePassword
The system generates a log file that reports errors (if any).
The success or failure of installation is indicated in the event log.
When automating the installation, if you run setup.exe from the command line, or run setup.exe as a
silent installation, one of the codes returns to indicate the following:
• 0= Success
• 1= Success with warnings
• 2= Failure

Silent installation on a Web Server
1. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor.
2. In SilentInstallConfig.xml, update the following parameters.
Parameter

Default

Description

InstallDirectory

C:\Program Files\

Specify the TotalAgility destination directory.

Kofax\ TotalAgility
ApplicationServerName no default

Enter the Fully Qualified Domain Name (FQDN) of the
application server.
Note If the Application server is installed on
a non-standard port, you must modify the
<ApplicationServerName> parameter in the
SilentInstallConfig.xml on the Web server as
follows:
<ApplicationServerName>FQDN:portnumber
<ApplicationServerName>"
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Parameter

Default

Description

UserName

username

Enter the name of the user who will run TotalAgility if
RunAsSystemAccount is false.

Password

password

Enter the password for the user who will run TotalAgility
if RunAsSystemAccount is false.

RunAsSystemAccount

false

Accept the default.

Identity Information

If set to true, the AppPool and Kofax TotalAgility services
are created with LocalSystem account.
Note If you set this parameter to true, databases
should be created using SQL authentication.
RunAsNetworkService

false

Account

If set to true, the AppPool and Kofax TotalAgility services
are created with the NT Authority\Network Service
username.
Note If you set this parameter to true, databases
should be created using SQL authentication.

Prerequisite Info
ValidOS

true

Set to true to check if the Operating System is valid.

SQLServerInstalled

true

Set to true to check if the SQL Server is installed.

SQLClientInstalled

false

Set to true to check if the SQL Client is installed.

IISInstalled

true

Set to true to check if IIS is installed.

SslEnabled

false

Set to true to enable https. See Configure for HTTPS
Communication.

InstallAction

Install

Accept the default.

InstallMode

Silent

Accept the default.

InstallType

Both

Enter WebServer.

<SiteRoot>

Default Web Site

Install TotalAgility under a custom site that uses a nonstandard port other than the standard ports (80 and
443).

Install Info

For example, create a custom site called "testsite" under
IIS using the port number 85.

3. Save and close the file.
4. On the Command Prompt, change the command line to the root directory of the Setup.exe file.
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5. Run Setup.exe /Silent.
The Kofax TotalAgility is installed automatically.
The system generates a log file that reports errors (if any).
The success or failure of installation is indicated in the event log.
When automating the installation, if you run setup.exe from the command line, or run setup.exe as a
silent installation, one of the codes returns to indicate the following:
• 0= Success
• 1= Success with warnings
• 2= Failure

Silent installation for Real Time Transformation Server
1. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor.
2. In SilentInstallConfig.xml, update the following parameters.
Parameter

Default Value

Description

InstallDirectory

C:\Program Files\

Specify the TotalAgility destination
directory.

InstallDatabases

false

Set to false to ignore installing
databases.

OverwriteIfExisting

false

Set to true to overwrite the existing
databases.

DatabaseName

TotalAgility

Specify the name of the Main
database.

Server

Server name

Specify the fully qualified domain
name (FQDN) of the server.

Kofax\ TotalAgility
DatabaseInformation

Main Database

Note When installing TotalAgility
with a remote database,
update SilentInstallConfig.xml
with the server name
(<Server>servername</Server>)
of the machine on which the
database resides.
The account used to connect
to the database during
the installation requires
DB_CREATOR rights.
SqlScript
CreateScript

Create_Main.SQL

Accept the default.

DropScript

Drop_Main.sql

Accept the default.

InitializeScript

Initialise_Main.sql

Accept the default.
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Parameter

Default Value

Description

ConversionScript

Convert_Main.SQL

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility

Specify the name of the Audit
database.

Server

server name

Specify the fully qualified domain
name (FQDN) of the server.

CreateScript

Create_Audit.sql

Accept the default.

DropScript

Drop_Audit.sql

Accept the default.

InitializeScript

Initialise_Audit.sql

Accept the default.

ConversionScript

Convert_Audit.SQL

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

Audit Database

SqlScript

Security
WindowsAuthentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility

Specify the name of the Finished
Jobs database.

Server

server name

Specify the fully qualified domain
name (FQDN) of the server.

CreateScript

Create_Archive.sql

Accept the default.

DropScript

Drop_Archive.sql

Accept the default.

Finished Jobs Database

SqlScript
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Parameter

Default Value

Description

Conversion Script

Convert_Archive.SQL

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DataLayer - TotalAgility_Documents Database
DatabaseName

TotalAgility_Documents

Specify the name of the
TotalAgility_Documents database.

Server

server name

Specify the fully qualified domain
name (FQDN) of the server.

CreateScript

Repository2012_TablesCreate.sql

Accept the default.

DropScript

Repository2012_Drop.sql

Accept the default.

Conversion Script

Repository2012_Convert.SQL

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

SqlScript

Security
WindowsAuthentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility_Simulator

Specify the name of the
TotalAgility_Simulator database.

Server

server name

Specify the fully qualified domain
name (FQDN) of the server.

CreateScript

Create_Simulator.SQL

Accept the default.

DropScript

Drop_Simulator.SQL

Accept the default.

InitializeScript

empty

Accept the default.

Simulator Database

SqlScript

36

Kofax TotalAgility Installation Guide

Parameter

Default Value

Description

Conversion Script

empty

Only required for patch when there
are SQL changes.

true

Set to true to use Windows
credentials for logging in.

Security
Windows Authentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility_Reporting

Specify the name of the
TotalAgility_Reporting database.

Server

server name

Specify the fully qualified domain
name (FQDN) of the server.

Kofax.Reporting.Analytics.

Accept the default.

Reporting_Analytics Database

SqlScript
CreateScript

SQL_TablesCreate.sql
DropScript

Kofax.Reporting.Analytics.

Accept the default.

SQL_Drop.sql
InitializeScript

Kofax.Reporting.Analytics.

Accept the default.

SQL_Initialize.sql
Conversion Script

empty

Only required for patch when SQL
changes are needed.

true

Set to true to use Windows
credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

DatabaseName

TotalAgility_Reporting_Staging

Specify the name of the
TotalAgility_Reporting_Staging
database.

Server

server name

Specify the fully qualified domain
name (FQDN) of the server.

Reporting_Staging Database
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Parameter

Default Value

Description

Kofax.Reporting.Analytics.

Accept the default.

SqlScript
CreateScript

Staging.SQL_TablesCreate.sql
DropScript

Kofax.Reporting.Analytics.

Accept the default.

Staging.SQL_Drop.sql
InitializeScript

Kofax.Reporting.Analytics.

Accept the default.

Staging.SQL_Initialize.sql
Conversion Script

empty

Only required for patch when SQL
changes are needed.

true

Set to true to use Windows
credentials for logging in.

Security
WindowsAuthentication

If set to false, provide the username
and password. Otherwise, leave the
username and password blank.
UserName

empty

Password

empty

NewDatabase

false

Set to true to create new database.

UserName

username

Enter the user name of the Windows
service account for the TotalAgility
services.

Password

password

Enter the password of the windows
service account for the TotalAgility
services.

RunAsSystemAccount

false

Accept the default.

Identity Information

If set to true, the AppPool and Kofax
TotalAgility services are created with
LocalSystem account.
Note When you set this
parameter to true, databases
should be created using SQL
authentication.
RunAsNetworkServiceAccount

false

If set to true, the AppPool and Kofax
TotalAgility services are created with
the NT Authority\Network Service
username.
Note When you set this
parameter to true, databases
should be created using SQL
authentication.
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Parameter

Default Value

Description

RTTS

Accept the default.

Install Info
InstallType

Note When you install
RTTS, it ignores the
services. The services such
as CoreworkerService,
ImportService, ExportService
are not installed.
SslEnabled

false

You can set to true to enable
https. See Configure for HTTPS
Communication.

TransformationService

true

Accept the default.

TSConfigFile

no default

Specify the path to .ini file along with
the name for Transformation Server
to configure.

Transformation Server Info

Important If you
provide the .ini file, the
TransformationServerInfo
settings are taken from the .ini
file; the parameters mentioned
in the SilentInstallConfig are
ignored. See the .INI file Sample
for the parameters.
LogFile

no default

Set the location where the
Transformation Server log file will be
created.

InstallLocation

For example, C:\Program Files Specify the Transformation Server
(x86)\Kofax\ TotalAgility\ destination directory.
TransformationServer

WindowsServiceAccount

username

Enter the name of the user who will
run the Transformation Server.

WindowsServicePassword

password

Enter the password for the user.

UseSpecificPool

false

Set true to add this Transformation
Server to a pool. Set false (or leave
blank or assign any other value) to
have Transformation Server process
all activities regardless of pool.
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Parameter

Default Value

Description

PoolName

empty

If you set UseSpecificPool=true,
enter the Transformation Server pool
name.
Note If you leave the pool
name empty, all activities are
processed regardless of their
pools.

OLEnabled

true

Set to true to enable online learning
tasks on this Transformation Server
instance. Set to false or any other
value to disable online learning
tasks.
Note In case where multiple
instances of Transformation
Server are installed for
improving the throughput of
the capture activities, online
learning should be enabled
only on a single transformation
server instance in the cluster.

WcfPort

9001

Enter the port that is used by
TotalAgility to communicate with
Transformation Server during
synchronous calls (such as fuzzy
searches and pushed activities).

ReservedSlots

0

Enter the number of slots on this
Transformation Server that are
reserved for pushed activities and
high-priority activities.

OverrideDefSlots

empty (false)

To override the default number
of processing slots for this
Transformation Server, set this
parameter to true. Any other value,
including empty, is treated as false
and the system automatically sets
the default number of processing
slots based on the system
configuration.

MaxSlots

0

If you set
CPUSERVER_OVERRIDE_DEF_
SLOTS to TRUE, enter the
number of processing slots for this
Transformation Server.

EnableSyncCalls

true

Set to true to enable synchronous
calls or FALSE to disable these calls.
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Parameter

Default Value

Description

<InstallSynchronous>

false

Set true to install the Transformation
Server in a synchronous mode.
Specify the port number (default:
9001) for the Transformation Server
service. The port number is stored in
the TotalAgility Web.config file as an
application setting:
<add
key="TSExternalServicePortFor
SyncProcessing"
value="9001" />

Note If you wish to change the
default port number, you must
update the Web.config file and
restart the Kofax TotalAgility IIS
Application Pool.
StartServices

true

<SiteRoot>

Default Web Site

Install TotalAgility under a custom
site that uses a non-standard port
other than the standard ports (80
and 443).
For example, create a custom site
called "testsite" under IIS using the
port number 85.

3. Save and close the file.
4. On the Command Prompt, change the command line to the root directory of the Setup.exe file.
5. Run Setup.exe /Silent.
The Real Time Transformation Server is installed. The Real Time Transformation Service sets up
Transformation Server in a synchronous mode and configures the core and SDK APIs of TotalAgility
which clients can invoke.
The system generates a log file that reports errors (if any).
The success or failure of installation is indicated in the event log.
When automating the installation, if you run setup.exe from the command line, or run setup.exe as a
silent installation, one of the codes returns to indicate the following:
• 0= Success
• 1= Success with warnings
• 2= Failure

Upgrade TotalAgility in silent mode
When upgrading to TotalAgility 7.6.0, do the following.
1. Go to the root directory of setup.exe.
2. Navigate to \\TotalAgility\TotalAgilityInstall and open SilentInstallConfig.xml using a
text editor.
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3. In SilentInstallConfig.xml, update the following parameters.
Parameter

Default value

Description

UserName

username

Enter the name of the user who will run
TotalAgility.

Password

password

Enter the password for the user who will run
TotalAgility.

upgrade

Use this setting to upgrade TotalAgility
components including databases.

upgradeTotalAgilitydatabases

Use this setting only if you are upgrading
the databases before upgrading TotalAgility
components.

Identity Information

Install Info
InstallAction

Note If you wish to upgrade TotalAgility
components before upgrading
databases, you must do the following:
a. Open SilentInstallConfig.xml
available at the following location:
\\TotalAgility
Installation Information
\Kofax TotalAgility
b. Update the <InstallAction>
section with the following
parameter: <InstallAction>
=Upgradedatabasesfor
existingTotalAgility

c. Run Setup.exe /Silent /U from the
above mentioned path.
upgradeTotalAgilitycomponents Use this setting to upgrade only TotalAgility
components.
StartServices

true

Starts the services automatically after
upgrade installation.
Set to false to start the services manually
after upgrade installation.

ImportWorkspacepackage

false

Set to true to import the Workspace
package after upgrade installation.
Note Review the Kofax TotalAgility
Release Notes to import the required
updates for the Workspace package.

4. Open the Command Prompt window as an Administrator and change the command line to the root
directory of the Setup.exe file.
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5. Run Setup.exe /Silent /Upgrade.
Based on the parameters set to True in the silent configuration file, the following items are upgraded
automatically:
• Kofax TotalAgility
• Kofax Import Connector (KIC)
• Kofax Transformation Designer
• Utility for Kofax Export Connector
The system generates a log file which reports errors (if any).
The success or failure of installation is indicated in the event log.
6. Save and close the file.

Perform a standard installation
You can install TotalAgility using the standard installer wizard.
When you run the installation wizard for the Application Server or the Web/Application Server, based on
the installation type selected, following items are installed:
• TotalAgility
• Kofax Import Connector
• Transformation Designer
Note
• Transformation Designer is installed only when the TransformationDesignerInstaller.exe is available
in the TotalAgility installation folder.
• When you install Kofax TotalAgility from a network share, make sure the user has the Write
permissions to the share; otherwise, the Import Connector will not get installed successfully.
• Utility for Kofax Export Connector
• Licensing Service
• Reporting Service
Note The reporting client is installed automatically on the Transformation Server and during the
TotalAgility server installation.

Install Database Only
1. Navigate to \\TotalAgility\TotalAgility Install on the installation media and run one of the following
commands:
• If UAC (User Account Control) is enabled, right-click Setup.exe and select Run As Administrator.
• If UAC is not enabled, run Setup.exe.
The system starts the installation.
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2. In the Kofax TotalAgility Installation Program window, click Next or press Enter to move to the next
window.
Note To exit the setup, click Cancel or press Esc.
3. In the Kofax Inc. Software License Agreement window, accept the terms in the License Agreement
and click Next.
4. In the Type of Install window, select Database Only.
5. Click Next.
The Databases window opens.
6. Either use the default settings or do the following:
• If the database with the same name already exists, and if you want to overwrite the existing
database, select the Overwrite databases if they exist? check box. Click Yes to confirm
overwriting databases.
• If you want to point to existing database in your local machine, clear the Install Databases and
Overwrite databases if they exist? check boxes. Enter a name for each database and follow
Step 10.
• If you want to point to existing databases in a different machine, clear the Install Databases and
Overwrite databases if they exist? check boxes and for each database do the following: enter
a name; click ellipsis for Server; select the database server where the databases reside; in the
Security group, either use Windows Authentication, or select the SQL Server authentication
providing the user name and password, and then click OK. If all the databases reside on the same
server, select the Apply these settings to all other Databases check box.
7. Click Next.
The DB Connection Results window opens and displays the results of connecting to databases.
8. Click Next.
The Software Checks window opens. The system displays a list of required software and whether
the software is installed.
9. Review the Detected Software list and proceed as follows:
• If your system does not have all the required software, click Cancel to close the installer and
install the software.
• If your system has all the required software, click Next. The Kofax TotalAgility Resource
Credentials window opens.
10. Enter the credentials (password and confirm password) for the user to be created on installation.
11. Click Next.
The Install Options window opens.
12. To automatically restart services, keep the Automatically Restart Services check box selected and
click Next.
The Installation Review window opens and displays the settings.
13. Click Next.
The Installation Progress window opens. The setup installs the required files, databases, and other
integrated products.
The Licensing window opens.
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14. To connect to the license server, do the following:
a. In the License Server field, enter the location of the License Server.
Note To connect to a shared License Server, enter the name or the IP address of a shared
License Server.
b. In the Port Number field, enter the port number on which the License Server listens.
15. Click Next.
Alternatively, click Skip if you want to skip connecting to the License Server now but connect when
launching TotalAgility.
16. Click Finish.
Your installation is now complete.
Note If any errors occur during the installation, TotalAgility creates a log file called Kofax
TotalAgility.txt on your desktop. Check this log file for error details. The success or failure of
installation is indicated in the event log.
See also:
• Perform a standard installation
• Install the Application Server
• Install the Web and Application Server
• Install the Web Server
• Install Real Time Transformation Server

Install the Application Server
1. Navigate to \\TotalAgility\TotalAgility Install on the installation media and run one of the following
commands:
• If UAC (User Account Control) is enabled, right-click Setup.exe and select Run As Administrator.
• If UAC is not enabled, run Setup.exe.
The system starts the installation.
2. In the Kofax TotalAgility Installation Program window, click Next or press Enter to move to the
next window.
Note To exit the setup, click Cancel or press Esc.
3. In the Kofax Inc. Software License Agreement window, accept the terms in the License
Agreement and click Next.
4. In the Type of install window, select Application Server and click Next.
5. The Application Server window opens.
6. By default, all the services listed under Windows Services and WCF Services are selected and
installed. If you do not want to install any service, clear the check box for the service, otherwise, click
Next.
The Destination window opens.
7. Use the default installation folder or click Browse to select a different folder, and click Next.
The Credentials window opens.
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8. Enter the credentials for the user who will run TotalAgility.
When you enter the credentials of a non-admin account, changes need to be made to ensure the
Streaming Service will run.
9. On the Root Website to host TotalAgility Application list, select the website to host the TotalAgility
application. By default, the Default Web Site is selected.
Note The websites added in IIS Manager appear on this list. To add a website in IIS Manager, click
Start > Run > IIS Manager > Sites > Add Web Site.
10. To support SSL, select the Support SSL check box.
Note The SSL option is only available if you have configured the https binding in IIS. See
Configure TotalAgility for HTTPS communication.
11. Click Next.
The Databases window opens.
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12. Do one of the following:
Option

Description

Use the default settings.
A database with the same name
already exists, and you want to
overwrite the existing database.

b. Click Yes to confirm overwriting databases.

Point to existing database in your
local machine.

a. Clear the Install Databases and Overwrite databases if they
exist? check boxes.

a. Select the Overwrite databases if they exist? check box.

b. Enter a name for each database and follow Step 13.
Point to existing databases in a
different machine.

a. clear the Install Databases and Overwrite databases if they
exist? check boxes
b. For each database do the following:
1. Enter a name.
2. Click ellipsis for Server; select the database server where the
databases reside.
3. In the Security group, either use Windows Authentication,
or select the SQL Server authentication providing the user
name and password, and then click OK.
4. If all the databases reside on the same server, select the
Apply these settings to all other Databases check box.

Manually install the databases.

a. Still run the setup.exe wizard to this screen.
b. Clear the Install Databases and Overwrite databases if they
exist? check boxes.
c. Install the databases.
d. After installing the databases, configure appropriate settings on this
screen, and follow Step 13.

Note
• If Apppool is running under a System account, the System displays an error.
• You must have a trusted account to interact with databases. Provide the SQL credentials and
click OK.
• If you clear the "Instal Databases" and "Overwrite Databases, if they exist?" options, then the DB
Connection Results window does not appear.
• If you install TotalAgility without any databases, you can use the Configuration Utility to
point to the databases when they are available at a later a stage. See the Kofax TotalAgility
Configuration Utility Guide.
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13. Click Next.
The DB Connection Results window opens and displays the results of connecting to databases.
Note The DB Connection Results window only opens if the "Install Databases" and "Overwrite
databases if they exist?" options are selected in the previous step.
14. If you wish to make any changes, click Back and make your changes, otherwise, click Next.
The Software Checks window opens. The system displays a list of required software based on
services and databases selection and whether the software is installed.
15. Review the Detected Software list and proceed as follows:

16.

17.

18.

19.
20.

• If your system does not have all the required software, click Cancel to close the installer and
install the software.
• If your system has all the required software, click Next. The Kofax TotalAgility Resource
Credentials window opens
Enter the credentials (password and confirm password) for the user to be created on installation and
click Next.
The Install Options window opens.
To automatically start the services, keep the Automatically Start Services check box selected, and
click Next.
The Installation Review window opens and displays the settings.
Click Next to start installation.
The Installation Progress window opens. The setup installs the required files, databases, and other
integrated products.
Click Next.
The Licensing window opens.
Do one of the following:
Option
Connect to the License Server

Description
a. In the License Server field, enter the location of the License
Server.
Note To connect to a shared License Server, enter the name
or the IP address of a shared License Server.
b. In the Port Number field, enter the port number on which the
License Server listens.
c. Click Next. The second Licensing window opens. Follow the next
step.

Skip connecting to the License
Server now but connect when
launching TotalAgility.

a. Click Skip.
b. Click Finish.

OR
If you have selected to install
databases manually (in Step 12).
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21. Enter your TotalAgility Serial Number and Product code.
The Serial Number and Product code appear by default, if the License Server is a shared license
server.
22. The ID of the selected License Server appears in the Machine ID field.
23. To activate the license, select the license activation method:
• Automatic: Use this option when internet connectivity is available. The license is activated online.
• Manual: Use this option when there is no internet connectivity, or if automatic activation is not
successful from the installer or license utility for your Kofax product. The Activation Code box is
displayed where you can specify the activation code.
a. To obtain the activation code:
1. Enter the following URL in your browser:
http://activatelegacy.kofax.com/support/Activation/manual.aspx
The Kofax Product License Activation page opens.
2. Enter the Serial Number issued to you at the time of purchase. If you have a hardware
key, the serial number (usually 7 characters) is printed on the key.
3. Enter the email address where Kofax can send the information you need to activate the
product license.
4. Click Next to proceed with the activation process.
Note Ignore the Version selection field if you do not have Kofax Capture or Ascent
Capture.
5. Copy and paste the Activation Code into the field on the Licensing window.
6. Click Activate to activate the license, or click Skip. If you skip activating the license, a
warning informs that you need to activate the license later.
b. Once you get the activation code, copy the code.
c. Paste the code in the Activation Code field on the Licensing window.
d. Click Activate to activate the license, or click Skip to activate the license later. If you skip
activating the license, the summary panel displays the warning that you need to activate the
license later.
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24. Click Finish.
Your installation is now complete.
After TotalAgility is installed, the installer prompts you to install the Kofax Transformation Server
bundle.
Note
• If you want to install any further services, you should uninstall TotalAgility and reinstall by
selecting the required services in the Application Server window.
• If any errors occur during installation, TotalAgility creates a log file called Kofax TotalAgility.txt at
C:\Users\xxxx\AppData\Local\Temp (where xxxx is the currently logged on user). Check this log
file for error details. The success or failure of installation is indicated in the event log.
After you install TotalAgility, further configure TotalAgility to:
• Launch TotalAgility
• Integrate with SharePoint
• Integrate with Dynamics CRM
• Integrate with Dynamics AX
• Integrate with Microsoft Outlook
• Integrate with Micro Focus Content Manager
Note To view the TotalAgility version you installed, login to TotalAgility Designer and navigate to
System > System settings. The version information is available at the bottom right corner of the
System settings page. The last three digits correspond to the build number.
See also:
• Perform a standard installation
• Install Database Only
• Install the Web and Application Server
• Install the Web Server
• Install Real Time Transformation Server

Install the Web and Application Server
This installation type installs the Web and Application servers on a single machine.
1. Navigate to \\TotalAgility\TotalAgility Install on the installation media and run one of the following
commands:
• If UAC (User Account Control) is enabled, right-click Setup.exe and select Run As Administrator.
• If UAC is not enabled, run Setup.exe.
The system starts the installation.
2. In the Kofax TotalAgility Installation Program window, click Next or press Enter to move to the
next window.
Note To exit the setup, click Cancel or press Esc.
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3. In the Kofax Inc. Software License Agreement window, accept the terms in the License
Agreement and click Next.
4. In the Type of install window, select Web/Application Server and click Next.
5. The Application Server window opens.
6. By default, all the Windows Services are selected and installed. The Windows services include: Core
Worker, Reporting, License, Transformation, Import and Export. If you do not want to install any
service, clear the check box for the service, otherwise, click Next.
The Destination window opens.
7. Use the default installation folder or click Browse to select a different path and click Next.
The Credentials window opens.
8. Enter the credentials for the user who will run TotalAgility.
When you enter the credentials of a non-admin account, changes need to be made to ensure the
Streaming Service will run.
9. On the Root Website to host TotalAgility Application list, select the website to host the TotalAgility
application. By default, the Default Web Site is selected.
Note The websites added in IIS Manager appear on this list. To add a website in IIS Manager, click
Start > Run > Inetmgr > Sites > Add Web Site.
10. To support SSL, select the Support SSL check box.
Note The SSL option is only available if you have configured the https binding in IIS. See
Configure TotalAgility for HTTPS communication.
11. Do either of the following in Windows Authentication option:
• To log on automatically to TotalAgility Designer and Workspace, keep the Windows
Authentication check box selected (default).
• To log on manually to TotalAgility Designer and Workspace, clear the Windows Authentication
check box.
12. Click Next.
The Databases window opens.
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13. Do one of the following:
Option

Description

Use the default settings.
A database with the same name
already exists, and you want to
overwrite the existing database.

b. Click Yes to confirm overwriting databases.

Point to existing database in your
local machine.

a. Clear the Install Databases and Overwrite databases if they
exist? check boxes.

a. Select the Overwrite databases if they exist? check box.

b. Enter a name for each database and follow Step 13.
Point to existing databases in a
different machine.

a. clear the Install Databases and Overwrite databases if they
exist? check boxes
b. For each database do the following:
1. Enter a name.
2. Click ellipsis for Server; select the database server where
the databases reside.
3. In the Security group, either use Windows Authentication,
or select the SQL Server authentication providing the user
name and password, and then click OK.
4. If all the databases reside on the same server, select the
Apply these settings to all other Databases check box.

Manually install the databases.

a. Still run the setup.exe wizard to this screen.
b. Clear the Install Databases and Overwrite databases if they
exist? check boxes.
c. Install the databases.
d. After installing the databases, configure appropriate settings on
this screen, and follow Step 13.

Note
• If Apppool is running under a System account, the System displays an error.
• You must have a trusted account to interact with databases. Provide the SQL credentials and
click OK.
• If you install TotalAgility without any databases, you can use the Configuration Utility to
point to the databases when they are available at a later a stage. See the Kofax TotalAgility
Configuration Utility Guide.
14. Click Next.
The DB Connection Results window opens and displays the results of connecting to databases.
Note The DB Connection Results window only opens if the Install Databases and Overwrite
databases if they exist? options are selected in the previous step.
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15. If you wish to make any changes, click Back and make your changes, otherwise, click Next.
The Software Checks window opens. The system displays a list of required software based on
services and databases selection and whether the software is installed.
16. Review the Detected Software list and proceed as follows:
• If your system does not have all the required software, click Cancel to close the installer and
install the software.
• If your system has all the required software, click Next. The TotalAgility Resource Credentials
window opens
17. Enter the credentials (password and confirm password) for the user to be created on installation and
click Next.
The Install Options window opens.
18. Do the following:
a. To automatically start the services, keep the Automatically Start Services check box selected.
b. Click Next.
The Installation Review window opens and displays the settings.
19. Click Next.
The Installation Progress window opens. The setup installs the required files, databases, and other
integrated products.
20. Click Next.
The Licensing window opens.
21. Do one of the following:
Option
Connect to the License Server

Description
a. In the License Server field, enter the location of the License
Server.
Note To connect to a shared License Server, enter the
name or the IP address of a shared License Server.
b. In the Port Number field, enter the port number on which the
License Server listens.
c. Click Next. The second Licensing window opens. Follow the
next step.

Skip connecting to the License Server
now but connect when launching
TotalAgility.

a. Click Skip.
b. Click Finish.

OR
If you have selected to install
databases manually (in Step 13).

53

Kofax TotalAgility Installation Guide

22. To connect to the License Server:
a. In the License Server field, enter the location of the License Server.
Note To connect to a shared License Server, enter the name or the IP address of a shared
License Server.
b. In the Port Number field, enter the port number on which the License Server listens.
c. Click Next. The second Licensing window opens.
Alternatively, click Skip and proceed to Step 24 in the following cases:
• If you want to skip connecting to the License Server now but connect when launching
TotalAgility.
• If you had selected to install databases manually (in Step 12).
23. Enter your TotalAgility Serial Number and Product Code.
Note The Serial Number and Product Code appear by default if the License Server is a shared
license server.
24. The ID of the selected License Server appears in the Machine ID field.
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25. To activate the license, select the license activation method:
• Automatic: Use this option when internet connectivity is available. The license is activated online.
• Manual: Use this option when there is no internet connectivity, or if automatic activation is not
successful from the installer or license utility for your Kofax product. The Activation Code box is
displayed where you can specify the activation code.
a. To obtain the activation code:
1. Enter the following URL in your browser:
http://activatelegacy.kofax.com/support/Activation/manual.aspx
The Kofax Product License Activation page opens.
2. Enter the Serial Number issued to you at the time of purchase. If you have a hardware
key, the serial number (usually 7 characters) is printed on the key.
3. Enter the email address where Kofax can send the information you need to activate the
product license.
4. Click Next to proceed with the activation process.
Note Ignore the "Version" selection field if you do not have Kofax Capture or Ascent
Capture.
5. Copy and paste the Activation Code into the field on the Licensing window.
6. Click Activate to activate the license, or click Skip. If you skip activating the license, a
warning informs that you need to activate the license later.
b. Once you get the activation code, copy the code.
c. Paste the code in the Activation Code field on the Licensing window.
d. Click Activate to activate the license, or click Skip to activate the license later. If you skip
activating the license, the summary panel displays the warning that you need to activate the
license later.
Note The license period starts once the license is activated. So you can skip activation during
installation and only activate it when you are ready to use TotalAgility. You are required to
activate the license when you log in to TotalAgility for the first time.
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26. Click Finish.
Your installation is now complete.
After TotalAgility is installed, the installer prompts you to install Transformation Server.
Note
• To install any further services, you must uninstall TotalAgility and reinstall by selecting the
required services in the Application Server window.
• If any errors occur during the installation, TotalAgility creates a log file called Kofax TotalAgility.txt
at C:\Users\xxxx\AppData\Local\Temp (where xxxx is the currently logged on user). Check this
log file for error details. The success or failure of installation is indicated in the event log.
After you install TotalAgility, further configure TotalAgility to:
• Launch TotalAgility.
• Integrate with SharePoint.
• Integrate with Dynamics CRM.
• Integrate with Dynamics AX.
• Integrate with Microsoft Outlook.
• Integrate with Micro Focus Content Manager.
Note To view the TotalAgility version you installed, login to TotalAgility Designer and navigate to
System > System settings. The version information is available at the bottom right corner of the
System settings page. The last three digits correspond to the build number.
See also:
• Perform a standard installation
• Install Database Only
• Install the Application Server
• Install the Web Server
• Install Real Time Transformation Server

Install the Web Server
1. Navigate to \\TotalAgility\TotalAgilityInstall on the installation media and run one of the following
commands:
• If UAC (User Account Control) is enabled, right-click Setup.exe and select Run As Administrator.
• If UAC is not enabled, run Setup.exe.
The system starts the installation.
2. In the Kofax TotalAgility Installation Program window, click Next or press Enter to move to the
next window.
Note To exit the setup, click Cancel or press Esc.
3. In the Kofax Inc. Software License Agreement window, accept the terms in the License Agreement
and click Next.
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4. In the Type of install window, select Web Server and click Next.
The Destination window opens.
5. Use the default installation folder or click Browse to select a different path, and click Next.
The Choose Server Location with Options window opens.
6. In the Server Name field enter the name of your existing TotalAgility
application server. The name must be a fully qualified, such as
<machinename>.<fullyqualifieddomainname>:<portnumber>.
Note The port number is only required if it is other than port 80.
7. To support SSL, select the Support SSL check box.
Note The SSL option is only available if you have configured the https binding in IIS. See
Configure TotalAgility for HTTPS Communication.
8. Click Next.
The Credentials window opens.
9. Enter the credentials (Password and Confirm password) for the user who will run TotalAgility.
10. On the Root Website to host TotalAgility Application list, select the website to host the TotalAgility
application. By default, the Default Web Site is selected.
Note The websites added in IIS Manager appear on this list. To add a website in IIS Manager, click
Start > Run > Inetmgr > Sites > Add Web Site.
11. Do either of the following in Windows Authentication option:
• To log on automatically to TotalAgility Designer and Workspace, keep the Windows
Authentication check box selected (default).
• To log on manually to TotalAgility Designer and Workspace, clear the Windows Authentication
check box.
12. Click Next.
The Software Checks window opens. The system displays a list of required software and whether
the software is installed.
13. Review the Detected Software list and proceed as follows:
• If your system does not have all the required software, click Cancel to close the installer and
install the software.
• If your system has all the required software, click Next. The Install Options window opens.
14. Click Next.
The Installation Review window opens and displays the settings.
15. Review the settings and click Next.
The Installation Progress window opens. The setup installs the required files, databases, and other
integrated products.
16. Click Finish.
Your installation is now complete.
Note If any errors occur during installation, TotalAgility creates a log file called Kofax TotalAgility.txt
on your desktop. Check this log file for error details. The success or failure of installation is
indicated in the event log.
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See also:
•
•
•
•
•

Perform a standard installation
Install Database Only
Install the Application Server
Install the Web and Application Server
Install Real Time Transformation Server

Install Real Time Transformation Server
1. Navigate to \\TotalAgility\TotalAgility Install on the installation media and run one of the following
commands:
• If UAC (User Account Control) is enabled, right-click Setup.exe and select Run As Administrator.
• If UAC is not enabled, run Setup.exe.
The system starts the installation.
2. In the Kofax TotalAgility Installation Program window, click Next or press Enter to move to the
next window.
Note To exit the setup, click Cancel or press Esc.
3. In the Kofax Inc. Software License Agreement window, accept the terms in the License
Agreement and click Next.
4. In the Type of Install window, select Real Time Transformation Service and clickNext.
The Destination window opens.
5. Use the default installation folder or click Browse to select a different path and click Next.
The Credentials window opens.
6. Enter the credentials (password and confirm password) for the user who will run TotalAgility.
7. On the Root Website to host TotalAgility Application list, select the website to host the TotalAgility
application. By default, the Default Web Site is selected.
Note The websites added in IIS Manager appear on this list. To add a website in IIS Manager, click
Start > Run > Inetmgr > Sites > Add Web Site.
8. To support SSL, select the Support SSL check box.
Note The SSL option is only available if you have configured the https binding in IIS. See
Configure TotalAgility for HTTPS communication.
9. Do either of the following in Windows Authentication option:
• To log on automatically to TotalAgility Designer and Workspace, keep the Windows
Authentication check box selected (default).
• To log on manually to TotalAgility Designer and Workspace, clear the Windows Authentication
check box.
10. Click Next.
The Databases window opens.
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11. Either use the default settings or do the following:

12.

13.

14.

15.

• If you want to point to existing database in your local machine, enter a name for each database
and enter the credentials (password and confirm password) for the user to be created on
installation.
• If you want to point to existing databases in a different machine, enter a name for each database;
click ellipsis for Server; select the database server where the databases reside; in the Security
group, either use Windows Authentication, or select the SQL Server authentication providing the
user name and password, and then click OK. If all the databases reside on the same server, select
the Apply these settings to all other Databases check box.
Click Next.
The Software Checks window opens. The system displays a list of required software and whether
the software is installed.
Review the Detected Software list and proceed as follows:
• If your system does not have all the required software, click Cancel to close the installer and
install the software.
• If your system has all the required software, click Next. The Installation Review window opens.
Review the settings and click Next.
The Installation Progress window opens. The setup installs the required files, databases, and other
integrated products.
Click Finish.
Your installation is now complete.
Note If any errors occur during the installation, TotalAgility creates a log file called Kofax
TotalAgility.txt on your desktop. Check this log file for error details. The success or failure of
installation is indicated in the event log.

Upgrade Transformation Designer Help
The Transformation Designer help is not automatically upgraded when you install Kofax TotalAgility 7.6.0.
As a result, you need to follow these manual steps to upgrade the documentation.
1. Navigate to the location where the Transformation Designer documentation is installed. By default,
this is %ProgramData%/Kofax/Transformation.
A directory called "Help" is displayed.
2. Rename the folder to "Help_7.6.0" or something similar.
Leave the window open as you will need it again later.
3. In the Kofax TotalAgility 7.6.0 ISO file, navigate to Kofax TotalAgility\TotalAgility
\Transformation Designer.
A ZIP file called "Help.zip" is displayed.
4. Extract the "Help.zip" to %ProgramData%/Kofax/Transformation and ensure that the resulting
directory is called "Help"
5. Open Transformation Designer and press F1 to open the help.
The upgraded help is displayed.
If the help does not display, ensure that the structure of the Help directory matches that of the
"Help_7.6.0" directory and try again.
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Perform TotalAgility installation in a Docker container
A Docker is an open platform for developing, shipping, and running applications. Docker enables you to
separate an application from its infrastructure. Using Docker, you can manage your infrastructure in the
same way you manage your applications.
Docker provides the ability to package and run an application, such as TotalAgility in a loosely
isolated environment called a Container. The isolation and security allows you to run many containers
simultaneously on a given host using less resources than virtual machines.
You can deploy TotalAgility application into your production environment, as an independent container
or an orchestrated set of containers. This works the same whether your production environment is a
local datacenter, a cloud provider, or a hybrid of the two. This means you would not need to use the
TotalAgility installation program when TotalAgility is deployed in a Docker container. Instead the container
would already have TotalAgility installed and only the relevant configuration settings (such as database
connection strings) are required when the container runs.
By default, all TotalAgility containers do not have limits for memory or CPU. SQL Server runs either on
another Windows container or another machine, it does not run in the TotalAgility container.
See also:
• Docker installation on the Windows server
• Create a TotalAgility docker container image
• Run a docker container
• Use Windows authentication with IIS and SQL server

Docker installation on the Windows server
Setup Docker on your Windows server.
1. Open an elevated PowerShell command prompt, and type the following commands.
Install-Module DockerMsftProvider -Force
Install-Package Docker -ProviderName DockerMsftProvider -Force

2. Check if a reboot is required. If required, restart your instance using the following command:
(Install-WindowsFeature Containers).RestartNeeded
If the output of this command is Yes, restart the server using the following command: RestartComputer.
3. Test your Docker Engine - Enterprise installation by running the hello-world container.
docker run hello-world:nanoserver
Unable to find image 'hello-world:nanoserver' locally
nanoserver: Pulling from library/hello-world
bce2fbc256ea: Pull complete
3ac17e2e6106: Pull complete
8cac44e17f16: Pull complete
5e160e4d8db3: Pull complete
Digest: sha256:25eac12ba40f7591969085ab3fb9772e8a4307553c14ea72d0e6f98b2c8ced9d
Status: Downloaded newer image for hello-world:nanoserver
Hello from Docker!

This message shows that your installation appears to be working correctly.
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Create a TotalAgility docker container image
A container is defined by its image as well as any configuration options you provide to it when you create
or start it.
To create a docker image, you need Internet connectivity because docker uses the Microsoft's "microsoft/
aspnet" image as a base onto which the prerequisites get installed (from the base OS or from Internet
when any feature is not available on the image).
1. Extract the contents of KofaxTotalAgility-7.6.0.ZIP to a "<source directory>".
2. Create a "<workingdirectory>".
Your docker commands will be run from this directory.
3. Copy the contents of <source directory>\TotalAgility\Utilities\Docker to "<working
directory>".
4. Move the "<source directory>" folder to <working directory>\ContainerFiles
\TotalAgility.
The file structure should be as follows (with the rest of the folders under containerfiles being empty):
<working directory>\Dockerfile
<working directory>\ContainerFiles\TotalAgility
<working directory>\ContainerFiles\PowerShellScripts
5. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor and update the parameters as needed for each container
type. See Perform a silent installation in a docker container for more information.
6. To create the image, open a PowerShell window on the container host and run the following
command:
docker build -t <imagenamegoeshere> "<fullpathtoworkingdirectory>"

Note Container host is the machine where docker server is installed. Performance of a build
command depends on the number of processors in the container host machine. Command may
take approximately one hour to complete with quad core processors configuration.
Example The following command generates the image with the name "kofaxop" using the contents
inside the C:\Docker\Kofax TotalAgility directory:
docker build -t kofaxop "C:\Docker\Kofax TotalAgility"

Perform a silent installation in a docker container
Use the TotalAgility silent installation to install TotalAgility automatically in a docker container from a
command line or a batch file. After you edit the silent installation file, the installation proceeds without any
user interaction.
1. On the installation media, navigate to \\TotalAgility\TotalAgilityInstall and open
SilentInstallConfig.xml using a text editor.
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2. In SilentInstallConfig.xml, update the following parameters for various installation types.
•
•
•
•
•
•

Demo
Application Server (Core Services and Core Worker)
Web Server
Web Server and Application Server (Core Services and Core Worker)
Reporting Server
Real Time Transformation Service
Note Fix the line breaks if you copy and paste the code from this guide.

Demo
Update the following parameters for a Demo server installation.
Parameter

Default value

Description

ImportService

FALSE

Accept the default, as we do not support Import Service inside
Docker containers.

ExportService

FALSE

Accept the default, as we do not support Export Service inside
Docker containers.

LicenseService

FALSE

Accept the default, as we do not support License Service
inside Docker containers.

CoreWorkerService

TRUE

ReportingService

TRUE

TransformationService

TRUE

CoreServices

TRUE

ServicesInstallOptions

DatabaseInformation
InstallDatabases

FALSE

Accept the default to ignore installing databases.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

RunAsSystemAccount

TRUE

Accept the default to allow the AppPool and Kofax TotalAgility
services to be created with LocalSystem account.

InstallType

Both

Accept the default.

AuthenticationMode

Anonymous

Set the authentication mode to Windows or Anonymous, as
needed.

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

Identity Information

Install Info

Transformation Server Info
WindowsServiceAccount
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Parameter

Default value

Description

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

Application Server (Core Services and Core Worker)
Update the following parameters for Application server installation.
Parameter

Default value

Description

ImportService

FALSE

Accept the default, as we do not support Import Service inside
Docker containers.

ExportService

FALSE

Accept the default, as we do not support Export Service inside
Docker containers.

ReportingService

FALSE

LicenseService

FALSE

CoreWorkerService

TRUE

CoreService

TRUE

TransformationService

FALSE

ServicesInstallOptions

Accept the default, as we do not support License Service
inside Docker containers.

DatabaseInformation
InstallDatabases

FALSE

Accept the default to ignore installing databases.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

RunAsSystemAccount

TRUE

Accept the default to allow the AppPool and Kofax TotalAgility
services to be created with LocalSystem account.

Identity Information

Install Info
InstallType

ApplicationServer Accept the default.

AuthenticationMode

Anonymous

Set the authentication mode to Windows or Anonymous, as
needed.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

Web Server
Update the following parameters for Web server installation.
Parameter

Default value

Description

FALSE

Accept the default to ignore installing databases.

DatabaseInformation
InstallDatabases
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Parameter

Default value

Description

UserName

KTA_admin

A user inside the docker image for installingKofax TotalAgility,
so it should not be modified.

RunAsSystemAccount

TRUE

Accept the default to allow the AppPool and Kofax TotalAgility
services to be created with LocalSystem account.

InstallType

WebServer

Accept the default.

AuthenticationMode

Anonymous

Set the authentication mode to Windows or Anonymous, as
needed.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

Identity Information

Install Info

Web Server and Application Server (Core Services and Core Worker)
Update the following parameters for both Web and Application server installation.
Parameter

Default value

Description

ImportService

FALSE

Accept the default, as we do not support Import Service inside
Docker containers.

ExportService

FALSE

Accept the default, as we do not support Export Service inside
Docker containers.

ReportingService

FALSE

LicenseService

FALSE

CoreWorkerService

TRUE

CoreService

TRUE

TransformationService

FALSE

ServicesInstallOptions

Accept the default, as we do not support License Service
inside Docker containers.

DatabaseInformation
InstallDatabases

FALSE

Accept the default to ignore installing databases.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

RunAsSystemAccount

TRUE

Accept the default to allow the AppPool and Kofax TotalAgility
services to be created with LocalSystem account.

InstallType

Both

Accept the default.

AuthenticationMode

Anonymous

Set the authentication mode to Windows or Anonymous, as
needed.

Identity Information

Install Info
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Parameter

Default value

Description

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

Reporting Server
Update the following parameters for Reporting server installation.
Parameter

Default value

Description

ImportService

FALSE

Accept the default, as we do not support Import Service inside
Docker containers.

ExportService

FALSE

Accept the default, as we do not support Export Service inside
Docker containers.

ReportingService

TRUE

LicenseService

FALSE

CoreWorkerService

FALSE

CoreService

TRUE

Installs the Core services. You can set it to False, if needed.

TransformationService

TRUE

Installs the Transformation Service. You can set it to False, if
needed.

InstallDatabases

FALSE

Accept the default to ignore installing databases.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility, so it
should not be modified.

ServicesInstallOptions

Accept the default, as we do not support License Service inside
Docker containers.

DatabaseInformation

Transformation Server
Update the following parameters for both Transformation server installation.
Parameter

Default value

Description

ServicesInstallOptions
CoreWorkerService

FALSE

ImportService

FALSE

Accept the default, as we do not support Import Service inside
Docker containers.

ExportService

FALSE

Accept the default, as we do not support Export Service inside
Docker containers.

ReportingService

FALSE

LicenseService

FALSE

TransformationService

TRUE

CoreServices

FALSE

Accept the default, as we do not support License Service
inside Docker containers.
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Parameter

Default value

Description

FALSE

Accept the default to ignore installing databases.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

RunAsSystemAccount

TRUE

Accept the default to allow the AppPool and Kofax TotalAgility
services to be created with LocalSystem account.

InstallType

Both

Accept the default.

AuthenticationMode

Anonymous

Set the authentication mode to Windows or Anonymous, as
needed.

WindowsServiceAccount

KTA_admin

We create a user with the name “KTA_admin” inside the
docker image for installing TotalAgility, so it should not be
modified.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

DatabaseInformation
InstallDatabases
Identity Information

Install Info

Transformation Server Info

Real Time Transformation Service
Update the following parameters for Real Time Transformation service installation.
Parameter

Default value

Description

FALSE

Accept the default to ignore installing databases.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

RunAsSystemAccount

TRUE

Accept the default to allow the AppPool and Kofax TotalAgility
services to be created with LocalSystem account.

InstallType

RTTS

Accept the default.

AuthenticationMode

Anonymous

Set the authentication mode to Windows or Anonymous, as
needed.

WindowsServiceAccount

KTA_admin

We create a user with the name “KTA_admin” inside the
docker image for installing TotalAgility, so it should not be
modified.

UserName

KTA_admin

A user inside the docker image for installing Kofax TotalAgility,
so it should not be modified.

DatabaseInformation
InstallDatabases
Identity Information

Install Info

Transformation Server Info
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Run a docker container
A Docker container runs on any machine that supports the container's runtime environment. Applications
are not required to be tied to the host operating system, so both the application environment and the
underlying operating environment can be kept clean and minimal.
Note When a running container is stopped, any changes to its state that are not stored in persistent
storage disappear.
Before running a docker container, it is expected that databases are already setup (using Database only
installation mode) before bringing the containers up and running.
1. Generate “dockersettings.env” using Configuration Utility in the docker mode. The file will be used
later for the container initialization. Refer the Kofax TotalAgilityConfiguration Utility Guide for more
information.
2. To run the TotalAgility container using Windows authentication:
a. Set up an account and create win.json using Windows authentication.
Win.json contains the credentials in the Json format which will be passed to the container during
creation.
b. To bring the container up, use the settings provided inside the env file using the Windows
authentication account with credentials specified under the win.json file.
To run the TotalAgility container using manual authentication, configuration is not needed.
3. Container access can be limited to the container host or can be port forwarded for the global access.
Enable the required exposed port number in firewall settings of host machine.
4. Execution commands:
a. Container access can be limited to container host with windows authentication "docker run
--env-file <fullpathtoenvfile> --security-opt "credentialspec=file://
win.json" <imagenamegoeshere>"
Example The following command will bring a container up using the kofaxop image with the
Kofax TotalAgility settings applied from dockersettings.env file using Windows authentication
with the credentials specified in the win.json file.
docker run --env-file "C:\Docker\TotalAgility\dockersettings.env" -security-opt "credentialspec=file://win.json" kofaxop,
b. Container access can be limited to container host with client credentials: "docker run -env-file <fullpathtoenvfile> <imagenamegoeshere>".
Example The following command will bring a container up using the kofaxop image with the
Kofax TotalAgility settings applied from dockersettings.env file using client credentials.
docker run --env-file "C:\Docker\TotalAgility\dockersettings.env"
c. Port forwarded container access which is not limited to the container host with Windows
authentication using the following command to bring the container up using the settings
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provided inside the env file forwarding the site from within the container in port <portonimage>
on to port <dockerserverexposedport> on the docker server.
"docker run --env-file <fullpathtoenvfile> --security-opt
"credentialspec=file://win.json" -p <dockerserverexposedport>:<portonimage>
<imagenamegoeshere>"

Example The following command will bring a container up using the kofaxop image with the
Kofax TotalAgility settings applied from dockersettings.env file with the credentials for
Windows authentication specified under the win.json file, and forwarding the port 80 from the
container into the 5000 port on the container host:
docker run --env-file "C:\Docker\TotalAgility\dockersettings.env" -security-opt "credentialspec=file://win.json" -p 5000:80 kofaxop
d. Port forwarded container access which is not limited to the container host with client credentials,
using the following command to bring the container up using the settings provided inside
the env file forwarding the site from within the container in port <portonimage> onto port
<dockerserverexposedport> on the docker server.
"docker run --env-file <fullpathtoenvfile> -p
<dockerserverexposedport>:<portonimage> <imagenamegoeshere>"
Example The following command will bring a container up using the kofaxop image with the
Kofax TotalAgility settings applied from dockersettings.env file with the credentials and
forwarding the port 80 from the container into the 5000 port on the container host:
docker run --env-file "C:\Docker\TotalAgility\dockersettings.env" -p
5000:80 kofaxop
5. To attach the current powershell session in the docker server to a command prompt one inside the
container, you can use "docker attach <containerIDgoeshere>" or add "-it" parameter as part of the
"docker run" command .

Additional information
This table includes some useful docker commands.
Docker command

Purpose

docker images

Gets the list of all docker images currently
available on the server.

docker ps -a

Gets a list of all containers available on the
server.

docker start <containerID>

Starts the container with the ID
<containerID> on the server.

docker attach <containerID>

Stops the container with the ID
<containerID> on the server.

docker rm <containerID>

Deletes the container with the ID
<containerID> on the server.

docker rmi <imagename>

Deletes the image with the ID <imagename>
on the server, this will be successful only
if there are no child containers using this
image
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Docker command

Purpose

docker inspect -f
"{{ .NetworkSettings.Networks.nat.IPAddress }}"
<containerID>

Gets the IP address of the container with the
ID <containerID>

docker cp "<containerID>:/
<fullfilepathoncontainer>" "<pathtofolderonserver>"

Copies a file from the container to the
server.

docker cp "<fullfilepathonserver>" "<containerID>:/
<fullfilepathoncontainer>"

Copies a file from the container to the
server.

Use Windows authentication with IIS and SQL server
Docker containers cannot join an Active Directory domain. However, when running a container, you
can specify that it should use a specific AD Group Managed Service Account (gMSA) for any local
Windows services and IIS Application pool in the container that are configured to run as LocalSystem or
NetworkService accounts.
When running as these accounts in the container, the services and App pool will automatically get the
access rights of the gMSA to allow them to use Windows authentication to access other VMs/machines
outside of the container.
When setting up a TotalAgility docker container to use Windows authentication, you must modify the
SilentInstallConfig.xml file to specify LocalSystem as the account to use for all TotalAgility services and IIS
App pool. This account will be used when the container is built.
Ensure the following prerequisites are met:
• Add docker server, SQL server machine and machines that will use gMSA under required domain
controller.
• Add these machines in the Active Directory under "Computer" folder.
• Create a Global Security group, such as " ContainerHostGroupName" in the Active Directory under
"Builtin" folder.
• Add docker server, SQL server machine or machines that will use gMSA as members to the new group.
Perform the following steps to use Windows authentication with IIS and SQL server.
1. Create the KDS root key.
This key is used by the KDS service on DCs (along with other information) to generate passwords.
You can generate this key only once per domain.
a. Login to domain controller and execute the following commands:
Import-module ActiveDirectory
Add-KdsRootKey -EffectiveImmediately
b. Verify your key using the following command:
Get-KdsRootKey
2. Create a gMSA account.
a. Login to domain controller and execute the following command:
GMSA account name : containerhost
Domain name: TotalAgilityexample.com
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New-ADServiceAccount -Name containerhost -DNSHostName TotalAgilityexample.com
-PrincipalsAllowedToRetrieveManagedPassword "Domain Controllers",
"domain admins", "CN= ContainerHostGroupName,CN=Builtin, DC=
TotalAgilityexample, DC=COM" -KerberosEncryptionType RC4, AES128, AES256

b. Verify the new gMSA account using the following command: .
Get - ADServiceAccount - Identity containerhost
c. A new gMSA object appears in your domain's Managed Service Account.
3. Add gMSA account to the servers you want to use.
a. Open the Active directory Admin Center and go to Managed service accounts.
b. Select the gMSA account and click Properties.
c. Select the security and click Add.
d. Select the computers where you want to use gMSA such as docker server and SQL server
machine.
e. Reboot Domain controller for the changes to take effect.
f. Reboot the computers that will be using gMSA.
4. Install gMSA Account on servers.
a. Login to the machine that will be used as docker server.
b. If Active Directory features are not available, execute the following command:
Enable-WindowsOptionalFeature -FeatureName ActiveDirectory-Powershell
-online -all
c. To install and test gMSA, execute the following commands:
// check whether you are able to account
Get-ADServiceAccount -Identity containerhost //Name of GMSA
// install on machine
Install-ADServiceAccount -Identity containerhost
// test
Test-AdServiceAccount -Identity containerhost

If the output does not contain any errors, it will look like as follows:
Path :
Online : True
RestartNeeded : False
DistinguishedName : CN=containerhost,CN=Managed Service Accounts, DC=local
Enabled : True
Name: containerhost
objectClass : msDs-GroupManagedServiceAccount
ObjectGUID : containerhost$
SamAccountName : containerhost$
SID : S-1-5-21-3914853822-719528391-929614657-1606
UserPrincipalName :
True
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5. Associate Service Principal Name with the gMSA:
a. This step is required for kerberos authentication to work and for automatic login in Chrome and
Internet Explorer browsers. If you skip this step, authentication still works but will always prompt
for username/password since it will fallback to NTLM.
GMSA account : containerhost
Domain name: TotalAgilityexample .com
Container host machine: machine1
b. Login to domain controller and execute the following command:
setspn -c -s HTTP/ machine1 TotalAgilityexample \ containerhost
setspn -c -s HTTP/ machine1. TotalAgilityexample.com TotalAgilityexample \
containerhost

6. To test Active Directory access on the container host, run the following command on the host
machine: nltest /parentdomain
At this point, if no errors occurs, the LocalSystem account on the container will be a proxy for the
configured gMSA account. Any process run as the LocalSystem principal on the container will
appear to be the GMSA principal to all assets on the Active Directory domain.
7. Generate credential specifications file which must be passed to the docker during container creation
to utilize this service account. Run the following commands to downloads module which will create
this file from Microsoft github account and will create a JSON file containing required data.
GMSA account : containerhost
Domain name: TotalAgilityexample.com
Invoke-WebRequest "https://raw.githubusercontent.com/Microsoft/VirtualizationDocumentation/live/windows-server-container-tools/ServiceAccounts/
CredentialSpec.psm1" -UseBasicParsing -OutFile $env:TEMP\cred.psm1
import-module $env:temp\cred.psm1
New-CredentialSpec -Name win -AccountName containerhost
#This will return location and name of JSON file
Get-CredentialSpec
Name Path
---- ---win C:\ProgramData\docker\CredentialSpecs\win.json

8. For SQL server configuration to allow gMSA, enter the gMSA account as "containerhost" and domain
name as "TotalAgilityexample.com" and run the following SQL commands on your SQL database:
CREATE LOGIN " TotalAgilityexample \containerhost$"
FROM WINDOWS
GO

To create user for all the TotalAgility databases:
CREATE USER containerhost FOR LOGIN " TotalAgilityexample \ containerhost$"
GO
EXEC sp_addrolemember 'db_datareader', containerhost
EXEC sp_addrolemember 'db_datawriter', containerhost

9. If there are no errors, the LocalSystem account on the container will be a proxy for the configured
gMSA account. Any process run as the LocalSystem principal on the container will appear to be the
gMSA principal to all assets on the Active Directory domain. To test Active Directory access on the
container, run the following command on the container: nltest /parentdomain
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Install TotalAgility on a non-standard port
To install TotalAgility on a non-standard port, you must first edit bindings to specify the port number, and
update the base address and restart the streaming service.

Edit bindings
1. Click Start > Run > InetMgr > Sites > Default Web Site.
By default, the Default Web Site is selected.
2. Right click on the Default Website and click Edit Bindings.
3. Select the default port 80 and click Edit.
4. In the Edit Site Binding window, change the port number to 81 and click OK.
5. Install Kofax TotalAgility. See TotalAgility installation.
6. Enter the following URL in your browser and change the port number to 81 in the URL to logon.
http://ServerName:81/TotalAgility/forms/GeneralWorkQueue.form.

Update the base address
You can edit the base address setting either manually or using the Configuration Utility.

Manually
1. On the installation media, open the Agility.Server.StreamingService.exe.config file available at \
\TotalAgility\Agility.Server.Web\bin> and change the base address section.
< baseAddresses >
<add baseAddress="http://<ServerName>.<DomainName>:
<non default port>/TotalAgility/Services/Sdk/StreamingService.svc" />
</ baseAddresses >

2. Similarly, change the base address section in the Agility.Server.StreamingService.exe.config file
available at \\TotalAgility\CoreWorkerService>.
< baseAddresses >
<add baseAddress="http://<ServerName>.<DomainName>:
<non default port>/TotalAgility/Services/Core/StreamingService.svc" />
</ baseAddresses >

3. The streaming service hosts an http server. If the Streaming service and Package streaming service
are running under a non-admin account on a non-standard port, you need to reserve a namespace
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for them. To do so, on the Command Prompt, run the following command using an account that has
administrator rights on the local machine:
• For StreamingService.svc:
netsh http add urlacl url=http://+:<non default port>/TotalAgility/
Services/Sdk/StreamingService.svc user=%domainuser%
• For PackageStreamingService.svc:
netsh http add urlacl url=http://+:<non default port>/TotalAgility/
Services/Sdk/PackageStreamingService.svc user=%domainuser%
If both of these URLs are not reserved then the Streaming service will not start when using a nonadmin service account.

Using the Configuration Utility
Run the Configuration utility and update the base address property for the streaming service. The
streaming service must be restarted for the change to take effect.

Restart the Streaming Service
Once the base address is changed or the command to reserve the namespace is completed, restart the
Streaming service.

Install databases manually
The following procedure describes installing databases manually.
Note the following:
• You can either create a single database for Main, Audit and Finished databases or create separate
Main, Audit and Finished databases.
• Simulator must have its own database because it has the same table names as the Main database.
• By default, the Document Repository is installed into its own database. However, you can create tables
for the document repository within the main TotalAgility database by running the scripts.
• If the Application Server and databases are installed on the same server, it is not required to start
MSDTC. When you have split databases such as Main database and Archive database, or when
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Application Server and databases are in a distributed environment, you require Microsoft Distributed
Transaction Coordinator (MSDTC).
• The MSDTC should be enabled on the machine and the following settings should be selected:
• Network DTC Access
• Transaction Manager Communication (Authentication is not required)
• Enable XA transactions
• Enable SNA LU 6.2 Transactions
• On a Windows Server, do the following to enable the settings:
1. Navigate to Control Panel > System and Security > Administrative Tools.
2. Click Component Services.
The Component Services window appears.
3. In the left panel, under Console Root expand the Component Services > Distributed
Transaction Coordinator and select Local DTC.
4. From the Local DTC context menu, select Properties.
5. In the Local DTC Properties window, on the Security tab, select Network DTC Access and
Enable SNA LU 6.2 Transactions.
• After the settings are completed, you should start the Distributed Transaction Coordinator service.
To start MSDTC manually, on the Command Prompt window, run the following command: net
start msdtc. Alternatively, at Run, type Services.msc and press Enter. Right-click the Distributed
Transaction Coordinator service and click Start.
• TotalAgility license tables are installed by running the Create_KLS_OnPremise.sql.
1. Ensure that you create the following databases:
• TotalAgility
• Finished Jobs
• Audit
• TotalAgility_Reporting
• TotalAgility_Reporting_Staging
• TotalAgility_Simulator
2. Edit the Initialise_Main.sql script by using the comments in the script. For example, update the details
of the user who will log on to TotalAgility initially by editing the following:
a. @NTNAME = ‘INSTALL_NTUSERID’, where the User Domain and User ID replaces
INSTALL_NTUSERID. For example, ‘DomainName\USERA’
b. @FULLNAME = ‘INSTALL_FULLNAME’, where the User name replaces
INSTALL_FULLNAME. For example, ‘USER A’
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3. Run the scripts in the following order across databases and follow the instructions inside each script.
a. Main(Create, Initialise)
Run the following scripts on the Main database:
• Create_Main.sql
• Initialise_Main.sql
• Create_Forms.sql
• Initialise_Forms.sql
• Create_KFS.sql
• Initialise_KFS.sql
• LicenseScripts\Create_KLS_OnPremise.sql
b. Finished Jobs(Create)
Run the following script on the Finished Jobs database (can exist on the Main database):
• Create_Archive.sql
c. Audit(Create, Intialise)
Run the following scripts on the Audit database (can exist on the Main database):
• Create_Audit.sql
• Initialise_Audit.sql
d. Simulator(Create)
Run the following script on the Simulator database:
• Create_Simulator.sql
e. Data Layer Database(Create)
The Repository2012_Create.sql script creates the documents database.
1. Run Repository2012_Create.sql script on the DataLayer database depending on the
version of SQL Server. For example, run Repository2012_Create.sql.
2. In the SQL Management Studio, select Main menu>Query> SQLCMD mode.
3. Assign the database create permission if installing on a separate computer.
USE <TotalAgility_Documents>;
GRANT CREATE DATABASE TO <Domain\resource name>
GO

4. Update the "DatabaseName" and "DefaultFilePrefix" parameters in the script to the
name of your database. For example,
:setvar DatabaseName "TotalAgility_Documents"
:setvar DefaultFilePrefix "TotalAgility_Documents"
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4. The following scripts are used for installing reporting databases manually.
• Scripts for creating the Staging database.
• Kofax.Reporting.Analytics.Staging.SQL_TablesCreate.sql
• Kofax.Reporting.Analytics.Staging.SQL_Initialize.sql
• Scripts for creating the Reporting database.
• Kofax.Reporting.Analytics.SQL_TablesCreate.sql
• Kofax.Reporting.Analytics.SQL_Initialize.sql
Note Before running these scripts, verify that a compatible database server is already installed.
The Reporting tables must be in the default schema.
5. In the Installation wizard, in the Databases window, do the following:
a. Clear the check boxes for "Install Databases" and "Overwrite databases if they exist check".
b. Rename the databases under Database Name to match with the name given while creating
databases manually.
Change the name of the Data Layer database to either Repository2012 or the name given while
creating the databases.
c. Click Next. Ensure the installation completes before updating the configuration files.
6. You can edit the value of the database connections in the Web.config manually or run the
Configuration Utility available on the installation media.
• Open Web.config available at \\TotalAgility\Agility.Server.Web. In the appSettings
section, update the value of the following database connections:
• MainDBConnectionString
• ArchiveDBConnectionString
• AuditDBConnectionString
• SimulatorDBConnectionString
• ReportingMainDBConnectionString
• ReportingStagingDBConnectionString
Note The database should point to the machine where Kofax TotalAgility is installed.
• Run the Configuration Utility and modify the values of the preceding database connections
available on the Common settings tab.
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7. To modify the value of database connections in Agility.Server.Core.WorkerService.exe.config, do
either of the following:
• Open Agility.Server.Core.WorkerService.exe.config available at \\TotalAgility
\CoreWorkerService and modify the values of following connection strings:
• MainDBConnectionString
• ArchiveDBConnectionString
• AuditDBConnectionString
• SimulatorDBConnectionString
• ReportingMainDBConnectionString
• ReportingStagingDBConnectionString
Note The database should point to the machine where the Kofax TotalAgility is installed.
• Run the Configuration Utility and modify the values of the preceding connection strings available
on the Common settings tab.
8. To modify the values of database connections in the Agility.Server.StreamingService.exe.config, do
either of the following:
• Open Agility.Server.StreamingService.exe.config available at \\TotalAgility
\CoreWorkerService and update the following connection strings:
• MainDBConnectionString
• ArchiveDBConnectionString
• AuditDBConnectionString
• SimulatorDBConnectionString
• ReportingMainDBConnectionString
• ReportingStagingDBConnectionString
Note The database should point to the machine where Kofax TotalAgility is installed.
• Run the Configuration Utility and modify the values of the preceding connection strings available
on the Common settings tab.
9. To connect TotalAgility to the desired documents database:
a. Go to the TotalAgility Main database > SERVER_DATA table > CEBPM_SETTINGS column.
b. Open the CEBPM_SETTINGS XML file.
c. In the <Common Settings> section, update the Data Source value to your computer name,
Integrated Security to True, and the value of the Initial Catalog to the Data Layer Database
name.
<Common_Settings>
<ReportingSettings />
<DataLayerConfiguration RepositoryDBConnectionString=";Data Source=<computer
name>;Initial Catalog=Data Layer Database;User ID=;Password=;Integrated
Security=True;Connect Timeout=30;Encrypt=False;TrustServerCertificate=False"
RepositoryBlobStorageAccountConnectionString="{DATA_LAYER_BLOB_CONNSTRING}"
RepositoryBlobStorageContainerName="{DATA_LAYER_BLOB_CONTAINER}" />
</Common_Settings>

10. Restart the TotalAgility CoreWorker service for the change to take affect.
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Import Artifacts
You must import the standard forms, style sheets and custom assets after installing TotalAgility databases.
Note After upgrading TotalAgility, you must manually import the System maps and standard forms.
You can import all the artifact from WorkspacePackage.zip available at the following location:
\\TotalAgility\Agility.Server.Web\Packages

Configure TotalAgility for high availability
You can install a second License Server on a different computer and use it as a backup server for Kofax
TotalAgility.
1. On the installation media, navigate to \\TotalAgility > Licensing.
2. Click KSALicServerSetup.
The License Server Setup window opens.
3. Click Next.
4. In the Destination Folder window, select the default folder (C:\Program Files (x86)\Kofax
\License Server\) for the License Server or click Change to select a different folder.
5. Click Next and follow the instructions to complete the installation.

Access TotalAgility through iPad or iPhone
To access TotalAgility through iPad or iPhone, update the Web.config file. You can use Windows
authentication between the Web and Application servers and still use TotalAgility authentication from the
client device to the Web server.
1. Access TotalAgility Web.config file from the following directory on the Web server: C:\Program
Files\Kofax\TotalAgility\Agility.Server.Web\Web.config.
2. Search the .config file for the following: <binding name="BasicHttpBinding_Service".
3. Copy the entire block of code, from <binding> to </binding>.
4. Paste the block under the copied block and rename it to: <binding
name="BasicHttpBindingCore_Service".
5. In the copied binding, ensure HTTP with Windows authentication is enabled. This enables the
authentication from the Web server to the Application server.
6. Navigate to the start of the core end points, search for: <!--START CORE END POINTS -->.
7. For each core end point replace BasicHttpBinding_Service with
BasicHttpBindingCore_Service.
8. To use the authentication from the client device to the web server, update the original
BasicHttpBinding_Service binding to use Anonymous authentication and SSL (if required).
9. Save the Web.config file.
10. Log on to TotalAgility ensuring you have been previously added as a TotalAgility user.
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Federated Security-Generate a common machine key
When using Federated Security with TotalAgility in a load balance environment, TotalAgility cannot
consistently decrypt the encrypted token passed from an Identity Provider using WsFed tokens. This
is because, by default, each load balanced server has a unique machine key identifier used for token
encryption/decryption.
We recommend that you generate a common machine key and propagate it to all servers in the load
balanced environment. For example, if you generate a machine key for the TotalAgility application, the
Web.config file gets automatically updated with the machine key element. The configuration of a machine
key can be done at Web Server, Site or Application level.
To generate a machine key, perform the following steps:
1. Open Internet Information Services(IIS) manager.
2. Select the TotalAgility application, website or web server from the left panel to generate a machine
key.
3. In Features View, right-click Machine Key, and then click Open Feature.
4. On the Machine Key page, select an encryption method from the Encryption method drop-down
list.
5. Select a decryption method from the Decryption method drop-down list.
6. Optionally, configure settings for Validation and Decryption keys.
7. In the Actions panel, click Generate Keys, and then click Apply.
When you click apply, the changes are automatically saved in the Web.config file.
To encrypt and decrypt the machine key, see Encrypt and decrypt the TotalAgility configuration files.

Encrypt and decrypt the TotalAgility configuration files
The TotalAgility configuration files include the DB Connection settings, including sensitive information.
Therefore, we recommend that you encrypt the following TotalAgility files.
• Web config
• Core Worker config
• Export Worker config

Encrypt and decrypt the Web Config file
The TotalAgility Web.config file is located under <Kofax Install location>\TotalAgility
\Agility.Server.Web.
Use Microsoft ASP.NET IIS Registration Tool (aspnet_regiis) to encrypt or decrypt any section of the
Web.config file. See the following link for more information: http://msdn.microsoft.com/en-us/
library/zhhddkxy(v=vs.100).aspx.
In this case, encrypt the appSettings section as it includes the Database connection information.
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Encrypt and decrypt the Core Worker or Export Worker config file
The TotalAgility Core Worker config and Export Worker config files are located under <Kofax
Install location>\TotalAgility\CoreWorkerService.
The TotalAgility Server supports two encryption methods depending on command line parameters using
Kofax.CEBPM.EncryptConfig.exe utility:
• DPAPI encryption
• RSA encryption

Use the Kofax.CEBPM.Encryption.exe utility
The Kofax.CEBPM.EncryptConfig.exe (located in the TotalAgility installation_folder) utility encrypts (-enc)
or decrypts (-dec) any section of the configuration file.
In this case, encrypt the appSettings section as it includes the user ID and password as well as other
information. Use the optional -h flag to display help for the command.
Kofax.CEBPM.EncryptConfig.exe cannot work with Web.config, it can only work with configs of
executables.
Important Add the following security provider in the config file before encrypting them:
<configProtectedData>
<providers>
<add useMachineProtection="true"
name="DPAPIProtection"
type="System.Configuration.DpapiProtectedConfigurationProvider,
System.Configuration, Version=2.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a" />
<add name="RSAProvider"
type="System.Configuration.RsaProtectedConfigurationProvider,
System.Configuration,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a,
processorArchitecture=MSIL"
keyContainerName="CPUServerKeys" useMachineContainer="true" />
</providers>
</configProtectedData>

Use the DPAPI encryption method
Because you must decrypt the file on the same machine where it was encrypted, use this utility to encrypt
one server at a time.
Run the utility on each TotalAgility Server individually.
1. Stop the TotalAgility Core Worker Server service.
2. Navigate to the TotalAgility Core Worker installation directory.
3. Copy the Kofax.CEBPM.EncryptConfig.exe to the same folder where
Agility.Server.Core.WorkerService.exe.config resides.
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4. Open a Command Prompt window and run the following command:
Kofax.CEBPM.EncryptConfig.exe -f Agility.Server.Core.WorkerService.exe.config -s
"appSettings" -p DPAPIProtection -enc

Use the RSA encryption method
An algorithm for public key encryption and digital signatures that uses two separate keys. Create a
key and encrypt the configuration file on one Server, and export the key to all the other Servers. All the
TotalAgility Servers with the exported key installed can access the configuration file. Use this method if
you have several Servers with the same configuration.
The following instructions differentiate between the source TotalAgility Server where you create the key
and the target TotalAgility Servers onto which you import the key.

Prepare the key
Perform these steps on one source TotalAgility Server.
1. Create the custom RSA key container:
a. Log on to the TotalAgility Server with administrator rights.
b. Open a command-line window.
c. Navigate to the .NET Framework version 4.0 directory. For example, enter the following
command:
cd \WINDOWS\Microsoft.Net\Framework\v4.0.*
d. Run the following command:
aspnet_regiis -pc "<KeysFile> "-exp
where:
• <KeysFile> is the name of the key file.
• The -exp option makes the key exportable.
2. Run the following command to grant the TotalAgility Core Worker Server service user permission to
read the <KeysFile> RSA container file.
aspnet_regiis -pa "<KeysFile> " "<TotalAgilityserviceuser> "
where:
• <KeysFile> is the name of the key file you created in Step 1d.
• <TAserviceuser> is the TotalAgility Core Worker Server service user.
3. Encrypt the file:
a. Log on to the TotalAgility Server as the Kofax TotalAgility Core Worker Server service user.
b. Navigate to the installation directory for the TotalAgility Server and open a command-line
window.
c. Run the following command:
Kofax.CEBPM.EncryptConfig.exe -f
Agility.Server.Core.WorkerService.exe.config -s "appSettings" -p
RSAProvider -enc
This command encrypts the appSettings section of the configuration file. The appSettings
section includes the user ID, password and other information.
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4. Export the key by running the following command:
aspnet_regiis -px "<KeysFile>" "<c:\keys.xml>" -pri
where:
• <KeysFile> is the default keystore keyContainerName.
• <c:\keys.xml> is the path and file name of the exported key file.

Import the key
Perform these steps on every target TotalAgility Server.
1. Import the key:
a. Log on to the TotalAgility Server with administrator rights.
b. Copy the keys.xml file from the source TotalAgility Server to the root C:\ directory of the target
TotalAgility Server.
c. Open a command-line window.
d. Run the following command:
aspnet_regiis -pi "<KeysFile>" "c:\keys.xml"
where:
• <KeysFile> is the default name of the key file.
• <c:\keys.xml> is the path and file name to the imported key file.
e. Delete the keys.xml because it contains the unprotected private key.
2. Run the following command to grant the TotalAgility Core Worker Server service user permissions to
use the <KeysFile> RSA container file:
aspnet_regiis -pa "<KeysFile>" "TotalAgilityserviceuser"
where:
• <KeysFile> is the name of the key file you imported in step 1.
• <TotalAgilityserviceuser> is the TotalAgility Core Worker Server service user.
3. Repeat these steps on all remaining TotalAgility Servers.

Decrypt the configuration file
1. Stop the TotalAgility Core Worker Server service.
2. Navigate to the TotalAgility Server installation directory and open a command-line window.
3. Run the following command:
Kofax.CEBPM.EncryptConfig.exe -f
Agility.Server.Core.WorkerService.exe.config -s "appSettings" -p
DPAPIProtection -dec
Important Repeat the encrypt and decrypt procedures for Export configuration file also.
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Edit the TotalAgility configuration settings
After installing TotalAgility, to change or update any parameters, edit the following configuration files
available in the installation directory:
• Agility.Server.Core.WorkerService.exe.config
• Agility.Server.Core.ExportService.exe.config
• Web.config
You can either edit each of these files separately or run the TotalAgility configuration utility to modify all
the settings at one go. The configuration utility is available on the installation media and must be manually
copied to your Kofax TotalAgility server. See the Kofax TotalAgility Configuration Utility Guide.

Update the parameter values
When you initially install the TotalAgility Server, the system stores the configuration settings in a .NET file,
Agility.Server.Core.WorkerService.exe.config. To change the value of any parameters, do the following.
1. If you encrypted the configuration file after you installed the TotalAgility server, decrypt the file. See
Decrypting the configuration file.
Note If you use RSA encryption, decrypt the configuration file only on the source TotalAgility server
where you initially encrypted the file.
2. Navigate to the installation directory for the TotalAgility server.
3. Open Agility.Server.Core.WorkerService.exe.config in a text editor.
4. Locate the following section:
<appSettings>
<add key="KeyNameString" value="which may contain passwords;"/>
</appSettings>

5. Edit the parameter values as needed.
6. Save and close the configuration file.
7. To re-encrypt the configuration file, run the encryption utility. See Encrypting and decrypting the
configuration files.
Note If you use RSA encryption, export the key, and install the encryption key file on any target
TotalAgility servers imported the original encrypted configuration file.
8. Restart the Kofax TotalAgility Core Worker Server service.

Support export vertical scaling
By default, there is no export instance. An export instance is only spawned if there is an export activity
that is ready for export. More export instances are spawned if there are more export activities that are
ready for export. You can configure TotalAgility to support multiple export instances on an export server.
1. Navigate to the installation directory for the TotalAgility Server.
2. Open Agility.Server.Core.ExportService.exe.config in a text editor.
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3. Locate the <appSettings> section and change the value of MaxExportProcessesNumber as
needed. (Default: 0)
<appSettings>
<add key="MaxExportProcessesNumber" value="0"/>
</appSettings>

Note Maximum number = Round of ((The number of machine processor count) * 1.25)
Maximum number = Round of ((The number of machine processor count) * 1.25)

The formula is only used if MaxExportProcessesNumber is less than or equal to 0. If the number is
>= 1, the export processes count is equal to the defined value (MaxExportProcessesNumber).

Configure the wait time for export activities
You can configure the wait time for export activities in seconds so that the Export Service will wait for
the configured seconds for new export activities to progress based on the availability of the child export
processes.
If all the child export processes are in inactive mode (that is, there are no export activities available),
TotalAgility Export Service will wait for the configured seconds for new export activities to process. If
any child export process is in an active mode (that is, any child process is executing the Export activity),
TotalAgility Export Service will instantaneously take new export activities to export without waiting for the
configured seconds.
1. On the installation media, navigate to \\TotalAgility\CoreWorkerService.
2. Open Agility.Server.Core.ExportService.exe.config in a text editor.
3. Locate the <appSettings> section and change the value of
"WaitForAvailableExportActivitiesTimeoutInSeconds" as needed. (Default: 30)
<appSettings>
<add key="WaitForAvailableExportActivitiesTimeoutInSeconds" value="30"/>
</appSettings>

Note The minimum value for WaitForAvailableExportActivitiesTimeoutInSeconds is 1 and
maximum value is 600.
You must restart the TotalAgility Export Service for the change to take effect.

Update settings for manual authentication
Perform the following steps on the Web or combined Web/Application server and Application Server.
Edit the setting manually or use the Configuration Utility for manual authentication.

Web server or combined Web/Application server
Perform the following steps on the Web or combined Web/Application server and Application Server.
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Manually
1. Open the TotalAgility Web.config file from the following directory: C:\Program Files\Kofax
\TotalAgility\Agility.Server.Web.
2. Locate the following bindings, "CustomBinding_CoreService", "BasicHttpBinding_Service" and
"WebHttpBinding_Service" and comment out all the three security mode configurations for manual
logon over http.
<!-- The following are the different options for securing the services -->
<!-- All commented out is application manual logon over HTTP -->
<!-- Only one option should be uncommented at a time -->
<!-- Azure should use HTTPS SSL with application logon-->
<!-- On premise default: HTTP with Windows authentication-->
<!-- HTTPS SSL with application logon-->
<!--<security mode="Transport">
<transport clientCredentialType="None"/>
</security>-->
<!-- HTTP with Windows authentication-->
<security mode="TransportCredentialOnly">
<transport clientCredentialType="Windows" />
</security>
<!-- HTTPS SSL with Windows authentication-->
<!--<security mode="Transport">
<transport clientCredentialType="Windows" />
</security>-->

Note In the TotalAgility Web.config file, under the section,
TransformationServerExternalService_Binding, the "security mode" and "transport
clientCredentialType" should be same as specified in the Transformation Server Web.config file.

Using the Configuration Utility
Run the Configuration Utility and change the mode of authentication on the Web settings tab as needed.

Application server
Manually
1. Open the TotalAgility Web.config file from the following directory: C:\Program Files\Kofax
\TotalAgility\Agility.Server.Web.
2. Locate the following bindings, "CustomBinding_CoreService", "BasicHttpBinding_Service" and
"WebHttpBinding_Service" and comment out all the three security mode configurations for manual
logon over http.
<!-- The following are the different options for securing the services -->
<!-- All commented out is application manual logon over HTTP -->
<!-- Only one option should be uncommented at a time -->
<!-- Azure should use HTTPS SSL with application logon-->
<!-- On premise default: HTTP with Windows authentication-->
<!-- HTTPS SSL with application logon-->
<!--<security mode="Transport">
<transport clientCredentialType="None"/>
</security>-->
<!-- HTTP with Windows authentication-->
<security mode="TransportCredentialOnly">
<transport clientCredentialType="Windows" />
</security>
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<!-- HTTPS SSL with Windows authentication-->
<!--<security mode="Transport">
<transport clientCredentialType="Windows" />
</security>-->

Using the Configuration Utility
Run the Configuration Utility and change the mode of authentication on the Web settings tab as needed.

Update settings for the TotalAgility linked servers
Edit the setting manually or use the Configuration Utility for manual authentication.

Manually
On installing TotalAgility, the Web.config file is updated automatically with machine name / TotalAgility for
linked servers. If you want to connect from a public IP Address, you must update the Web.config file.
1. Open the TotalAgility Web.config file from the following directory: \\TotalAgility
\Agility.Server.Web
2. Locate the following section and replace the IP Address with your machine name.
<add key="TotalAgilityHostNameLive" value = "<ip_address>/TotalAgility" />
<add key="TotalAgilityHostNameDev" value = "<ip_address>/TotalAgility"/>

See the Kofax TotalAgility help for more information.

Using the Configuration Utility
Run the Configuration Utility and update the TotalAgilityHostNameLive key.

Alter the virtual root for the Kofax TotalAgility website
1. Open the TotalAgility Web.config file from the following directory: \\TotalAgility
\Agility.Server.Web
2. Modify the following configuration keys to alter the virtual root for the Kofax TotalAgility website:
<add key="WebsiteBaseName" value="TotalAgility"/>
<add key="ProcessDocumentsRootFolder" value="/TotalAgility/documents/process"/

Note The value for the "WebsiteBaseName" should be the name of the virtual directory used within
the IIS.

Add custom job thread pools
A job thread performs multiple operations at a time, such as job evaluation, raising an exception job or
ingestion through Kofax Import Connector. Multiple operations can lead to bottlenecks in the production
systems. For example, when there are thousands of jobs to be archived, ingestion and job evaluation take
longer time because the job threads are busy archiving jobs. Adding custom job thread pools, helps in
achieving better throughput and prioritizing the background tasks.
You can add custom job thread pools, specify the number of threads in the thread pool and assign the
worker task to a thread pool manually or use the Configuration Utility.
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Manually
1. Navigate to the installation directory for the TotalAgility server.
2. In a text editor, open Agility.Server.Core.WorkerService.exe.config from the following directory:
\\TotalAgility\Agility.Server.Web
3. Locate the following section:
<configSections>
<section name="CoreWorker" type="Agility.Server.Core.Worker.Configuration,
Agility.Server.Core.Worker"/>
</configSections>

4. Add one or more job thread pools within the CoreWorker section and add worker tasks, as required.
The following is a sample from the configuration file.
Example
<CoreWorker>
<JobThreadPools>
<add Id ="1" Size ="16" WorkerTasks ="ArchiveJobTask, DeleteItemTask,
CreateExceptionTask, CreateJobTask, EvaluateJobTask,
ProcessStateActionTask, IngestSystemTask, CaptureBatchTask "/>
</JobThreadPools>
</CoreWorker>

Note You must assign the following worker tasks to some thread pool, otherwise, an error message
is displayed and the Core Worker Service stops working. You cannot assign the same worker task
to more than one thread pool.
• ArchiveJobTask
• EvaluateJob Task
• CreateException Task
• CreateJob Task
• IngestSystem Task
• CaptureBatch Task
• DeleteItem Task
• ProcessStateAction Task
5. Save and close the configuration file.
6. Restart the Kofax TotalAgility Core Worker service.

Using Configuration Utility
Run the Configuration utility and add or update the custom job thread pools, specify the number of threads
in the thread pool and assign the worker task to a thread pool.

Add a thread pool monitoring interval
When long running automatic activities are processed by the Core Worker, the threads in the automatic
activity thread pool are not freed up when the taken activity is reset due to timeout. Configure a thread
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pool monitoring interval to free up the threads for these long running taken activities to allow other
activities to progress once they timeout.
You can configure the thread pool monitoring interval manually or use the Configuration Utility.

Manually
1. Navigate to the installation directory for the TotalAgility server.
2. In a text editor, open Agility.Server.Core.WorkerService.exe.config from the following directory:
\\TotalAgility\Agility.Server.Web
3. Locate the following section and add a thread pool monitoring interval (default:60).
<appSettings>
<add key="CoreWorkerThreadPoolMonitoringIntervalInSeconds" value="60"/>
</appSettings>

4. Save and close the configuration file.
5. Restart the Kofax TotalAgility Core Worker service.

Using Configuration Utility
Run the Configuration utility and add the thread pool monitoring interval. See the Kofax TotalAgility
Configuration utility Guide.

Manually
1. Navigate to the installation directory for the TotalAgility server.
2. In a text editor, open Agility.Server.Core.WorkerService.exe.config from the following directory:
\\TotalAgility\Agility.Server.Web
3. Locate the following section and add the thread pool monitoring interval as required:
<appSettings>
<add key="CoreWorkerThreadPoolMonitoringIntervalInSeconds" value="60"/>
</appSettings>

The default value is 60.
4. Save and close the configuration file.
5. Restart the Kofax TotalAgility Core Worker service.

Using Configuration Utility
Run the Configuration utility and add the thread pool monitoring interval. See the Kofax TotalAgility
Configuration utility Guide.

Add performance monitoring counters
Use the performance counters to record application states and activities.
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The following categories for TotalAgility performance monitoring counters are automatically installed on
the target machine when the Core Worker Service and the Export Service are installed:
• Kofax TotalAgility Core Worker: Locked Activities
• Kofax TotalAgility Core Worker: System Tasks
• Kofax TotalAgility Core Worker: Threads
• Kofax TotalAgility Core Worker: Worker Tasks
• Kofax TotalAgility Export Service
• Kofax TotalAgility Child Export Processes
Each category is associated with the performance counters. When the performance monitor is launched,
you can select the installed counters and add to the current monitoring session. Each instance is recorded
for a performance counter. For example, the Active Threads Per Thread pool performance counter
records an instance per thread pool as shown in the image below.

You can log each performance counter to the TotalAgility log file by enabling the logging function. For
more information on performance monitoring counters, see the Kofax TotalAgility Administrator's Guide.

Install the language pack
The languages files are available at the following location in the installation directory:
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\\TotalAgility\Agility.Server.Web\LocalizationFiles
After installing TotalAgility, import <Language>.zip using the "Import Languages" feature of the TotalAgility
Form Designer.
When you change your browser to one of the supported languages, the corresponding translation is
displayed.
Note Only the Workspace is localized according to the browser display language after installing the
language pack.

Install the .NET Framework language packs
To localize the system error messages from .NET, you must install the .NET Framework language packs
on both the Web and Application servers.
You can download the .NET Framework language pack from the Microsoft website.

Access TotalAgility documentation
You can access help online as well as in offline mode.

Online documentation
The product documentation for Kofax TotalAgility 7.6.0 is now available at the following location:
https://docshield.kofax.com/Portal/Products/KTA/7.6.0-d4fslp3xyr/KTA.htm
To launch the online help for the installed version of the product, click the Help icon on the application.
Note
• After upgrading to TotalAgility 7.6.0 from an earlier version, to view the TotalAgility Workspace help,
you must import the WorkspaceHeader form from the TotalAgility Workspace package.
• When upgrading to TotalAgility 7.6.0 from an earlier version, ensure that the check box for "Import
system Workspace package" is selected to view the Workspace help online; otherwise, you must
import the WorkspaceHeader form from the Workspace package.

Offline documentation
To access the documentation offline, you can download it from the Kofax Fulfillment Site. For each
language, a separate documentation package is available to download as a compressed file, such as
Kofax TotalAgilityDocumentation7.5.0_EN.zip for English or Kofax TotalAgilityDocumentation7.5.0_FR.zip
for French.
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The English .zip file includes both help and print folders. The print folder contains all guides, such as
installation guide and administrator's guide. The .zip files for other languages contain only the localized
help files.
1. From the Kofax Fulfillment Site, download the documentation.zip file for the applicable language.
2. Extract the contents of the compressed documentation file and do the following:
Note In a distributed environment, perform copying files on the Web server, and the Web.config
changes on the Application and Web servers.
• Copy the contents of the extracted TotalAgility_help to:
•
•
•
•
•
•
•
•
•
•
•

\\TotalAgility\Agility.Server.Web\Help\TotalAgility_designer
Copy the extracted KTAW_EN (for Workspace help in English) folder to:
\\TotalAgility\Agility.Server.Web\Help
Copy the extracted KTAWCC_EN (for Web Capture control help in English) folder to:
\\TotalAgility\Agility.Server.Web\Help
Copy the extracted ProjectBuilder (Transformation Designer in English) folder to:
<%ProgramFiles%>\Kofax\Transformation\Help\en_US\
Copy the extracted TotalAgility_opmt_help folder to:
\\TotalAgility\Agility.Server.Web.TenantManagement\TenantManagement\Help
Copy the extracted TotalAgility_KEC_help folder to:
\\TotalAgility\Agility.Server.Web\Help\ExportConnector_help
Copy the contents of the extracted ThinClientServer help to:
\\TotalAgility\Agility.Server.Web\Forms\Controls\Capture\help
Copy the contents of KFS_adminconsoleTA (Devices help) to:
\\TotalAgility\Agility.Server.Web\bin\Administrative\Help
Copy the contents of TotalAgility_repositorybrowser help to:
\\TotalAgility\Agility.Server.Web\Help\TotalAgility_repositorybrowser
Copy the contents of the extracted SDK_Documentation to:
\\TotalAgility\Agility.Server.Web\Help\API
Copy the contents of the extracted TotalAgility_documentconverterhelp to:
\\Kofax\Document Converter\web\help
Copy the contents of the extracted KIC_mchelp to:
\\Kofax\KIC-ED\MC\web\en\WebHelp
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3. Navigate to the installation folder and do the following:
• For TotalAgility help and Devices help:
a. Open TotalAgility Web.config in a text editor from the following location:
\\TotalAgility\Agility.Server.Web
b. Locate the <appSettings> section and remove http://docshield.kofax.com/
KTA from the key value: <add key="OnlineHelpURL" value="http://
docshield.kofax.com/KTA"/>.
Alternatively, run the Configuration Utility (available from the Installation media: \ \TotalAgility
\Utilities\ConfigurationUtility) and remove the URL for online help from the OnlinehelpURL
setting.
• For Kofax Export Connector help:
a. Open Agility.Server.ExportConnector.exe.config in a text editor from the following location:
\\TotalAgility\Agility.Server.Web\bin
b. Locate the <appSettings> section and remove http://docshield.kofax.com/
KTA from the key value: <add key="OnlineHelpURL" value="http://
docshield.kofax.com/KTA"/>.
• For Message Connector help:
a. Open configuration.xml in a text editor from the following location:
\\Kofax\KIC-ED\MC\web
b. Locate the <OnlineHelp>1</OnlineHelp> section and replace 1 with 0.
• For Document Converter help:
a. Open configuration.xml in a text editor from the following location:
\\Kofax\Document Converter\web
b. Locate the <OnlineHelp>1</OnlineHelp> section and replace 1 with 0.
4. Save and close the configuration file.
Clicking the Help icon will launch the help for the installed product.

Run EVRSCheck utility
The EvrsCheck utility helps in testing how an image will look once the eVRS setting is applied to it. The
left half of the application window displays the original image and the right half displays the processed
image once the setting is applied to it.
1. Run the EvrsCheck.exe available at the following location in the Installation folder:
\\TotalAgility\Utilities\EvrsCheck

The Before and After window opens.
2. Click Choose and select an image.
The selected image with its metadata appears in the left half of the window. If the selected image is a
multi-page image, you can use the "<" and ">" buttons to navigate between pages.
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3. Copy the desired eVRS setting and paste it into the EVRS Settings box.
The image is processed based on the eVRS settings. The output along with its metadata is displayed
in the right half of the window.
Note You can edit the eVRS setting; the image starts reprocessing as you type.
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Transformation Server Bundle installation
The Transformation Server Bundle includes:
• Transformation Server
• Transformation Core modules
To install any component, you must install the entire Transformation Server Bundle.
Either install the Transformation Server Bundle when you install TotalAgility, or install the Transformation
Server Bundle separately.
Note
• For development environments, install the Transformation Server Bundle where you installed
TotalAgility. For production environments, install the Transformation Server Bundle on a separate
computer.
• If you install Transformation Server or Transformation Designer independent of TotalAgility, make sure
the supported version of .NET Framework is already installed on that machine.
• The user who will run the Transformation Server must have "Log on as Service" rights. Also, the user
who is running Transformation Server will be used for all communication channels where Windows
authentication is used. For example, if Windows authentication is being used for SQL Server, this user
must have rights on this server, otherwise Transformation Server will not work.
• After installing the Transformation Server, you can modify the configuration settings by editing the
Transformation Server config file or by running the configuration utility. See the Kofax TotalAgility
Configuration Utility Guide.

Perform a silent installation
This section describes installing the Transformation Server Bundle silently, independent of TotalAgility.
1. On the installation media, navigate to \\TotalAgility\Transformation Server.
2. On the Command prompt window, run the following command:
TransformationServerSetup.exe /quiet /log %LogFile% TS_INSTALLLOCATION=
%InstallLocation% TS_SERVICE_ACCOUNT=%WindowsServiceAccount%
TS_SERVICE_PASSWORD=%WindowsServicePassword% TS_USE_SPECIFIC_POOL=
%UseSpecificPool% TS_POOL_NAME=%PoolName% TS_OL_ENABLED=%OLEnabled
% TS_WCF_PORT=%WcfPort% TS_RESERVED_SLOTS=%ReservedSlots%
TS_OVERRIDE_DEF_SLOTS=%OverrideDefSlots% TS_MAX_SLOTS=%MaxSlots%
TS_ENABLE_SYNC_CALLS=%EnableSyncCalls% TS_SYNCHRONOUS_ONLY=FALSE
TS_STARTSERVICE=TRUE TS_MAIN_DB_CONNECTION_STRING=
%MainDBConnectionString% TS_AUDIT_DB_CONNECTION_STRING=
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%AuditDBConnectionString% TS_REPORTING_STAGING_DB_CONNECTION_STRING=
%ReportingStagingDBConnectionString% TS_ARCHIVE_DB_CONNECTION_STRING=
%ArchiveDBConnectionString%
Optionally, call TS_SETUP_CONFIG_FILE (default: empty): This property requires an absolute path
to a configuration file for the installer. The configuration file can have one parameter per line only.
Using such a configuration file will prevent the setup.exe from logging sensitive data.
TS_SETUP_CONFIG_FILE example:
TS_SERVICE_ACCOUNT=.\serviceUser
TS_SERVICE_PASSWORD=secretPwd
TS_MAIN_DB_CONNECTION_STRING=Server=localhost;Trusted_Connection=Yes;
Database=TotalAgility;
TS_AUDIT_DB_CONNECTION_STRING=Server=localhost;Trusted_Connection=Yes;
Database=TotalAgility;
TS_ARCHIVE_DB_CONNECTION_STRING=Server=localhost;Trusted_Connection=Yes;
Database=TotalAgility;
TS_REPORTING_STAGING_DB_CONNECTION_STRING=Server=localhost;Trusted_Connection=Yes;
Database=TotalAgility_Reporting_Staging;

See the Transformation Server Info section in Silent installation of Web and Application on the same
server for more information on the Transformation Server parameters.
The parameter names are case-sensitive. If the value of a parameter has spaces, enclose the value
in quotation marks.

Perform a standard installation
1. Ensure that the user who will run the Transformation Server has" Log on as Service "rights.
2. Access the Transformation Server Bundle installer from one of the following methods:
• Production systems: Install the Transformation Server Bundle separately from TotalAgility.
Navigate to Transformation Server\Transformation Server\ on the installation media and run
one of the following commands:
• To install without creating a log file, run TransformationServerSetup.exe.
• To install and create a log file, run setup.exe/log <path\install_log.txt> where <path
\install_log.txt> is the path and name of the log file.
• Development systems: If you are installing the Transformation Server Bundle as part of the
TotalAgility installation, the Transformation Server Bundle installer opens automatically.
3. Click Install.
The system installs any necessary prerequisites.
4. Click Next.
The Transformation Server Setup window opens.
5. Click Next.
6. In the license agreement window, select I accept the terms in the License Agreement.
This window is not displayed if the Transformation Server is installed automatically as part of
TotalAgility installation.
7. Click Next.
The system prompts you for a destination folder for the Transformation Server.
8. Enter the destination and click Next.
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9. In the Service Account Setup window, enter the credentials for the user who will run the
Transformation Server. These credentials are also used to encrypt sensitive data.
a. In the Username field, enter the user name. To specify a domain user, enter the user name in
the format Domain\User.
b. Enter and confirm the Password.
c. Click Next.
The Setting up connection data window opens.
10. Enter the connection string for the Main, Archive, Audit and Reporting_Staging databases to connect
to and authenticate with the databases.
Use the following syntax:
Server=<server address>;Database=TotalAgility;User ID=<user_name>;
Password=<password>;

If installing on split web/app, use the following syntax:
Server=<server name>; Trusted_Connection=yes; Database=<database name>;

Specify the address of the database server and the user name and password to authenticate with
database where indicated. Example:
Server=dbserver\dbinstance;Database=TotalAgility;User
ID=dbo_id;Password=dbopassword;

11. Click Next.
12. Specify the connection options:

a. To enable the Transformation Server to process online learning tasks, select Enable Online
Learning processing by this Transformation Server instance.
b. Optionally, select Process activities from specific Transformation Server pool and select a
Pool name.
Note To select the default pool, select Default Transformation Server Thread Pool.
c. Click Next.
13. Click Next.
The Advanced execution options window opens. These options control the slots reserved for
incoming high-priority activities.
14. Select the advanced execution options:
• Select Enable synchronous calls processing to select the TCP/IP port and number of reserved
processing slots. The default TCP/IP port is 9001, and the number of reserved processing slots is
0.
Note If you are upgrading from version 7.0.0, "Enable synchronous calls processing" is
disabled if the number of reserved processing slots is zero and enabled if there are one or more
reserved processing slots.
• Select Override default number of processing slots to specify a number of slots other than the
default.
Click Next.
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15. Click Install to install the Transformation Server.
The system displays the installation status and a message when Transformation Server setup is
complete.
16. Click Finish to continue.
The system displays the Transformation Server Bundle setup status and a message when the
Transformation Server Bundle setup is successful.
17. Click Close to close the success message window.
18. From the Service console, start the Kofax Transformation Server service.
19. If applicable, restart the anti-virus or firewall applications.

Encrypt and decrypt the configuration file
The configuration file includes the Transformation Server settings, including sensitive information.
Therefore, we recommend that you encrypt this file. The Transformation Server supports two encryption
methods depending on command line parameters:
• DPAPI encryption: Because you must decrypt the file on the same machine where it was encrypted,
use this utility to encrypt one server at a time. See Use Kofax.CEBPM.EncryptConfig.exe.
• RSA encryption: An algorithm for public key encryption and digital signatures that uses two separate
keys. Create a key and encrypt the configuration file on one Transformation Server, and export the key
to all the other Transformation Servers. All the Transformation Servers with the exported key installed
can access the configuration file. Use this method if you have several Transformation Servers with the
same configuration (TAService ID, pool name, and so on). See Use RSA encryption.
To decrypt the configuration file, see Decrypting the configuration file.

Use Kofax.CEBPM.EncryptConfig.exe
The Kofax.CEBPM.EncryptConfig.exe utility encrypts (-enc) or decrypts (-dec) the CPUServer and
appSettings sections of the configuration file. The CPUServer section includes the TotalAgility Session ID.
The appSettings section includes the user ID and password as well as other information. Use the optional
-h flag to display help for the command.

Encrypt a File with Kofax.CEBPM.EncryptConfig.exe
Run the utility on each Transformation Server individually.
1. Stop the Transformation Server service.
2. Navigate to the Transformation Server installation directory and open a command Prompt window.
3. Run the following command:
Kofax.CEBPM.EncryptConfig.exe -f Kofax.CEBPM.CPUServer.ServiceHost.exe.config -s
"appSettings" -p DPAPIProtection -enc

97

Kofax TotalAgility Installation Guide

Use RSA encryption
Use RSA encryption to encrypt the configuration file, export the key, and install the encryption key file on
multiple Transformation Servers. Use this method if you have several Transformation Servers with the
same configuration (TAService ID, pool name, and so on).
The following instructions differentiate between the source Transformation Server where you create the
key and the target Transformation Servers onto which you import the key.

Prepare the key
Perform these steps on one source Transformation Server.
1. Create the custom RSA key container:
a. Log on to the Transformation Server with administrator rights.
b. Open a Command Prompt window.
c. Navigate to the .NET Framework version 4.0 directory. For example, enter the following
command:
cd \WINDOWS\Microsoft.Net\Framework\v4.0.*
d. Run the following command:
aspnet_regiis -pc "<KeysFile>" -exp
where:
• <KeysFile> is the name of the key file.
• The -exp option makes the key exportable.
2. Run the following command to grant the Transformation Server service user permission to read the
<KeysFile> RSA container file.
aspnet_regiis -pa "<KeysFile>" "<TSserviceuser>"
where:
• <KeysFile> is the name of the key file you created in Step 1d.
• <TSserviceuser> is the Transformation Server service user.
3. Encrypt the file:
a. Log on to the Transformation Server as the Transformation Server service user.
b. Navigate to the installation directory for the Transformation Server and open a Command
Prompt window.
c. Run the following command:
Kofax.CEBPM.EncryptConfig.exe -f
Kofax.CEBPM.CPUServer.ServiceHost.exe.config -s "appSettings" -p
RSAProvider -enc
This command encrypts the CPUServer and appSettings sections of the configuration file. The
CPUServer section includes the TotalAgility Session ID. The appSettings section includes the
user ID, password and other information.
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4. Export the key by running the following command:
aspnet_regiis -px "<KeysFile>" "<c:\keys.xml>" -pri
where:
• <KeysFile> is the default keystore keyContainerName.
• <c:\keys.xml> is the path and file name of the exported key file.

Import the key
Perform these steps on every target Transformation Server.
1. Import the key:
a. Log on to the Transformation Server with Administrator rights.
b. Copy the keys.xml file from the source Transformation Server to the root C:\ directory of the
target Transformation Server.
c. Open a Command Prompt window.
d. Run the following command:
aspnet_regiis -pi "<KeysFile>" "c:\keys.xml"
where:
• <KeysFile> is the default name of the key file.
• <c:\keys.xml> is the path and file name to the imported key file.
e. Delete the keys.xml because it contains the unprotected private key.
2. Run the following command to grant the Transformation Server service user permissions to use the
<KeysFile> RSA container file:
aspnet_regiis -pa "<KeysFile>" "TSserviceuser"
where:
• <KeysFile> is the name of the key file you imported in step 1.
• <TSserviceuser> is the Transformation Server service user.
3. Repeat these steps on all remaining Transformation Servers.

Decrypt the configuration file
1. Stop the Transformation Server service.
2. Navigate to the Transformation Server installation directory and open a command-line window.
3. Run the following command:
Kofax.CEBPM.EncryptConfig.exe -f
Kofax.CEBPM.CPUServer.ServiceHost.exe.config -s "appSettings" -p
DPAPIProtection -dec
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Edit the configuration file
Modify the Transformation Server configuration file, Kofax.CEBPM.CPUServer.ServiceHost.exe.config
if the system configuration has changed, or when you need to resolve a technical or performance issue.
1. If you encrypted the configuration file after you installed the Transformation Server, decrypt the file.
See Decrypt the configuration file .
Note If you used RSA encryption, decrypt the configuration file only on the source Transformation
Server where you initially encrypted the file.
2. Go to the installation directory for the Transformation Server and locate
Kofax.CEBPM.CPUServer.ServiceHost.exe.config.
3. Back up the file and save it in a secure location.
4. Open the file in a text editor.
5. To change system configuration options, modify the keys in the <appSettings> section.
The section contains a list of keys for setting configuration options. The ones that can be modified
have comments that describe the setting and supported values, as in this example.
<!-- Maximum number of instances allowed for Executor Process -->
<add key="MaxNumberOfTenantProcesses" value="1"/>

6. Change the value within the quotation marks to a supported value, as indicated in the comments.
7. To change how errors are reported in the application event log, which can be viewed in the Event
Viewer, modify the <system.diagnostics> section as follows:
a. Under <switches>, locate the following element:
<add name="TraceLevelSwitch" value="Warning"/>

By default, the value is set to Warning, which reports error and warning messages. Change the
value to any of the options listed in the comment to change the type of messages reported.
b. Under <sharedListeners>, locate the following line:
<add name="CPUServerLogTxt"
type="Kofax.CEBPM.CPUServer.Common.Diagnostics.DateTimeTaggedTraceListener,
Kofax.CEBPM.CPUServer.Common" initializeData="KofaxCPUServerLog.log" >

To specify a different log file or change the format for timestamps, change the value of
initializeData as shown in the comments in the file.
8. Save and close the configuration file.
9. To re-encrypt the configuration file, run the encryption utility. See Encrypt and decrypt the
configuration file.
Note If you used RSA encryption, export the key, and install the encryption key file on any target
Transformation Servers imported the original encrypted configuration file.
10. Restart the Kofax Transformation Server service.

100

Kofax TotalAgility Installation Guide

Uninstall the Transformation Server
Uninstall Transformation Server depending on how you have installed it.
• When you install Transformation Server as part of Kofax TotalAgility standard installation, uninstalling
Kofax TotalAgility will automatically uninstall Transformation Server.
• When you install Transformation Server on a separate system, uninstall the Transformation Server
Bundle from the Control Panel.
• To uninstall in a silent mode, do the following:
• Navigate to the root directory of TransformationServerSetup.exe.
• Run TransformationServerSetup.exe / uninstall / quiet.
The system uninstalls the Transformation Server and automatically creates a log file in the temporary
files folder. This log file contains information on errors, if any.

101

Chapter 4

Reporting Server installation
This chapter describes two methods for installing the Kofax Reporting Server:
• Silent installation of Reporting Server independent of TotalAgility
• Standard installation using the installation wizard.
For development environments, install the Reporting Server where you installed TotalAgility. Otherwise,
install the Reporting Server on a separate system in the same domain where you installed TotalAgility.
Note If you choose to install the Reporting Server on a separate system in the same domain where you
installed TotalAgility, then you must assign the following roles to service account:
• For the Staging database: kfx_staging
• For the data warehouse: kfx_etl, kfx_reader, kfx_advanced_reader

Perform a silent installation
The section describes the silent installation of the Reporting Server, independent of TotalAgility.
See the following table for the silent installation parameters required to install the Reporting Server.
Parameter

Default Value

Description

INSTALLLOCATION

C:\Program Files\Kofax
\TotalAgility\

Specify the Reporting Server destination directory.

Reporting Server\
WINSERV_ACCOUNT

no default

Enter the name of the user who will run the
Reporting Server. To specify a domain user, enter
the user name in the format Domain\User.
Ensure that the account details are correct, as
under this account Reporting Server authenticates
in all places where Windows authentication is used.
Example, TotalAgility database.
All communication and resource access is run
under this account. Therefore, the account under
which Reporting Server is running must not be a
dummy account.

WINSERV_PASSWORD

no default

Enter the Password for the user.
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Parameter

Default Value

Description

MAIN_DB_CONNECTION
_STRING

no default

Enter the connection string for the Main database.
Example:
"Server=<hostname>;Trusted_Connection=Yes;"
"Database=TotalAgility;"

AUDIT_DB_CONNECTION_

no default

Enter the connection string for the Audit database.

no default

Enter the connection string for the Reporting
Staging database.

no default

Enter the connection string for the Reporting
Workhouse database.

STRING
REPORTING_STAGING_
DB_CONNECTION_STRING
REPORTING_WORKHOUSE_
DB_CONNECTION_STRING

Note Parameter names are case-sensitive.
1. On the installation media, navigate to \\TotalAgility\Reporting\ TAReportingService.
2. Run the following command:
msiexec.exe /i Kofax.Reporting.TAService.msi /q WINSERV_ACCOUNT=
%WindowsServiceAccount% WINSERV_PASSWORD=%WindowsServicePassword
% MAIN_DB_CONNECTION_STRING="%MainDBConnectionString%"
INSTALLLOCATION="%InstallLocation%"
AUDIT_DB_CONNECTION_STRING="%AuditDBConnectionString%"
REPORTING_STAGING_DB_CONNECTION_STRING="%ReportingStagingDBConnectionString
%" REPORTING_WAREHOUSE_DB_CONNECTION_STRING="%ReportingConnection%"

Perform a standard installation
1. On the Installation media, navigate to TotalAgility > Reporting > TAReportingService
> Kofax.Reporting.TAService.msi.
The TotalAgility Reporting Server Setup window opens.
2. Click Next.
3. In the End-User License Agreement window, select I accept the terms in the License Agreement
and click Next.
4. In the Destination Folder window, select the default folder (C:\Program Files (x86)\Kofax
\TotalAgility\Reporting Server\) for the Reporting server or click Change to choose
another folder.
5. Click Next.
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6. In the Service Account Setup window, enter the credentials for the user who will run the Kofax
TotalAgility Reporting Server service:
a. In the Username field, enter the username.
Note To specify a domain user, enter the username in the format Domain\User.
b. Enter and confirm the Password.
c. Click Next.
7. In the Obtaining TotalAgility Configuration window:
a. Specify TotalAgility Server service URL in the following format: http://<server_name>/
TotalAgility/Services/Core/ServerService.svc
Here <server_name> is the TotalAgility server name.
Note To install Web Service over SSL, use ‘https://’ instead of ‘http://’ in the URL.
b. In the Main DB connection string box, enter the connection string for the TotalAgility database.
c. Click Next.
The system downloads the configuration settings.
8. Click Install to begin installation.
9. Click Finish.

Uninstall the Reporting Server
Uninstall the Reporting Server depending on how you have installed it.
• When you install the Reporting Server as part of Kofax TotalAgility standard installation, uninstalling
TotalAgility will automatically uninstall the Reporting Server.
• When you install the Reporting Server on a separate system using the Wizard, uninstall the Reporting
Server from the Control Panel.
• If you install the Reporting Server in a silent mode, you must do the following to uninstall the Reporting
Server in a silent mode:
1. On the Command Prompt, change the command line to the root directory of the
Kofax.Reporting.TAService.msi file.
2. Run msiexec.exe/quiet/x Kofax.Reporting.TAService.msi/L*V"%LogFileName%".
The system uninstalls the Reporting Server and automatically creates a log file in the temporary
files folder. This log file contains information on errors, if any. You can use "msiexec/help"
(Windows installer help) to check options for the installation and logging.
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Integrate Microsoft SharePoint with TotalAgility
Set up the SharePoint server and the TotalAgility server for using SharePoint in TotalAgility.
Note The SharePoint integration components should not be installed on the same machine where
TotalAgility is installed.
1. Navigate to \\SharePointInstallation on the installation media, and double click Setup.exe.
The system opens the TotalAgility for SharePoint Setup wizard.
2. Click Next.
The system displays the TotalAgility SharePoint Components window.
3. Select the TotalAgility SharePoint components to install.
a. To install the SharePoint web parts, select the TotalAgility SharePoint WebParts check box.
b. To install the SharePoint web service and event-handler dlls, select the TotalAgility
SharePoint Event-Handling Components check box.
c. To install the TotalAgility SharePoint custom pages, select the TotalAgility SharePoint Custom
Pages check box.
• By default, the Add Assembly To GAC check box is selected. The files are automatically
added to Global Assembly Cache.
• If you do not have access to GAC, clear the Add Assembly To GAC check box and enter
the SharePoint Site Port Number. The files are automatically added to the bin folder (default
location is C:\inetpub\wwwroot\wss\VirtualDirectories\[PortNumber]\bin)
within the site.
d. On the list of Website to host TotalAgility SharePoint components, select a website.
Note You must not select the SharePoint related websites.
Note You can rerun the setup at a later date to install the custom pages if you did not do it initially.
4. Click Install.
5. Update the Web.config file to get custom pages, support event handlers and configure SharePoint
site. See Update the Web.config File.
Further configure:
• TotalAgility custom web pages in SharePoint.
• TotalAgility Web parts in the SharePoint server.
• Microsoft SharePoint Server and TotalAgility to provide fault tolerance.
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Configure the Application Pool for the SharePoint communicator
site
1. Ensure that SharepointAppPool user should be either Primary or Secondary site collection
administrator.
2. Ensure that this user also resides in TotalAgility.
Note You can get this information from the appropriate SharePoint site.
3. Configure the same application pool in the SharePoint communicator site.

Update the Web configuration file
Update the Web.config file for the TotalAgility components.

To get custom pages
Add the following optional “appsettings” key values to the Web.config file in the target SharePoint web
application folder. For example, C:\inetpub\wwwroot\wss\VirtualDirectories\[PortNumber]
where [PortNumber] is the port number of the target SharePoint web application.
Appsetting

Description

If not specified

TAEmbeddedSolutionURL

Point to the TotalAgility site URL to
integrate into the SharePoint web
application.

TheTotalAgility Form site is available
at the same location as the
SharePoint web application.

TALogonUserIdentifier

Point to the identifier that passes
the SharePoint logon user name
into embedded forms in TotalAgility
Forms site.

The LOGON_USER is used as the
identifier.

TAWorkqueueEmbeddedForm:

Point to the form in the TotalAgility
Form site to use in the Workqueue
custom page.

The WorkQueue.form is used.

TAJobListEmbeddedForm

Point to the form in the TotalAgility
Form site to use in the JobList
custom page.

The JobList.form is used.

TADocURLIdentifier

Point to the identifier that passes
the SharePoint document URL into
embedded CreateNewJob forms in
TotalAgility.

The DOC_URL is used.

TADocNameIdentifier

Point to the identifier that passes
the SharePoint document name into
embedded CreateNewJob forms in
TotalAgility.

The DOC_NAME is used.
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Example: Settings in Web.config file to get custom pages
<appSettings>
<add key="TAEmbeddedSolutionURL" value="http://<TAServer name/IP>:80/Totalagility/
Forms" />
<add key="TALogonUserIdentifier" value="LOGON_USER" />
<add key="TAWorkqueueEmbeddedForm" value="WorkQueue.form "/>
<add key="TAJobListEmbeddedForm" value="JobList.form"/>
<add key="TADocURLIdentifier" value="DOC_URL"/>
<add key="TADocNameIdentifier" value="DOC_NAME"/>
</appSettings>

Note If the value of TAEmbeddedSolutionURL key is cross domain, remove the following section from
the TotalAgility Web.config file: <add name="X-Frame-Options" value="SAMEORIGIN"/>

To load the assembly from GAC
If you select to add assembly from GAC during installation, then edit the Sharepoint Web.config file with
the following:
<system.web>
<compilation>
<assemblies>
<add assembly="Agility.Server.Integration.Sharepoint.CustomPages,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=d86c87abe4a71948" />
</assemblies>
<compilation>
</system.web>

To support event handlers
Note If you copy and paste the code from this guide, fix the line breaks.
<configSections>
<section name="exceptionHandling"
type="Microsoft.Practices.EnterpriseLibrary.
ExceptionHandling.Configuration.ExceptionHandlingSettings,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
requirePermission="true" />
<section name="loggingConfiguration"
type="Microsoft.Practices.EnterpriseLibrary.
Logging.Configuration.LoggingSettings,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
</configSections>
<loggingConfiguration
name=""
tracingEnabled="true"
defaultCategory="General">
<listeners>
<add name="Event Log Listener"
type="Microsoft.Practices.EnterpriseLibrary.Logging.
TraceListeners.FormattedEventLogTraceListener,
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Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
listenerDataType="Microsoft.Practices.EnterpriseLibrary.
Logging.Configuration.FormattedEventLogTraceListenerData,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
source="Total Agility" formatter="Text Formatter"
log="" machineName="." traceOutputOptions="None" />
</listeners>
<formatters>
<add type="Microsoft.Practices.EnterpriseLibrary.Logging.
Formatters.TextFormatter,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
template="Timestamp: {timestamp}
{newline}&#xA;Message: {message}
{newline}&#xA;Category: {category}
{newline}&#xA;Priority: {priority}
{newline}&#xA;EventId: {eventid}
{newline}&#xA;Severity: {severity}
{newline}&#xA;Title:{title}
{newline}&#xA;Machine: {localMachine}
{newline}&#xA;App Domain: {localAppDomain}
{newline}&#xA;ProcessId: {localProcessId}
{newline}&#xA;Process Name: {localProcessName}
{newline}&#xA;Thread Name: {threadName}
{newline}&#xA;Win32 ThreadId:{win32ThreadId}
{newline}&#xA;Extended Properties:
{dictionary({key} - {value}{newline})}"
name="Text Formatter" />
</formatters>
<categorySources>
<add switchValue="All" name="General">
<listeners>
<add name="Event Log Listener" />
</listeners>
</add>
</categorySources>
<specialSources>
<allEvents switchValue="All" name="All Events" />
<notProcessed switchValue="All" name="Unprocessed Category" />
<errors switchValue="All" name="Logging Errors &amp; Warnings">
<listeners>
<add name="Event Log Listener" />
</listeners>
</errors>
</specialSources>
</loggingConfiguration>
<exceptionHandling>
<exceptionPolicies>
<add name="Agility Exception Policy">
<exceptionTypes>
<add name="All Exceptions" type="System.Exception,
mscorlib,
Version=4.0.0.0,
Culture=neutral,
PublicKeyToken=b77a5c561934e089"
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postHandlingAction="NotifyRethrow">
<exceptionHandlers>
<add name="Logging Exception Handler"
type="Microsoft.Practices.EnterpriseLibrary.
ExceptionHandling.Logging.LoggingExceptionHandler,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
logCategory="General" eventId="100" severity="Error"
title="Total Agility"
formatterType="Microsoft.Practices.EnterpriseLibrary.
ExceptionHandling.TextExceptionFormatter,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling,
Version=5.0.505.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35" priority="0" />
</exceptionHandlers></add>
</exceptionTypes>
</add>
</exceptionPolicies>
</exceptionHandling>

Note SharePoint event handler executes in the context of the user who initiated the action.

For a SharePoint Site
Note If you copy and paste the code from this guide, fix the line breaks.
• Update the <system.serviceModel>:
<system.serviceModel>
<bindings>
<basicHttpBinding>
<binding name="BasicHttpBinding_Service" openTimeout="00:10:00"
closeTimeout="00:10:00" sendTimeout="00:10:00" receiveTimeout="00:10:00"
allowCookies="true"
maxBufferSize="2147483647" maxReceivedMessageSize="2147483647"
maxBufferPoolSize="524288">
<readerQuotas maxDepth="2147483647" maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647" />
<security mode="TransportCredentialOnly">
<transport clientCredentialType="Windows" />
</security>
</binding>
</basicHttpBinding>
</bindings>
<client>
<endpoint name="CoreIntegrationEventServiceEndpoint"
binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_Service"
contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService"
address="http://TotaAgility server name
or IP Address/TotalAgility/Services/Core/IntegrationEventService.svc"/>
</client>
</system.serviceModel>

Replace the <IP Address> with the IP Address of the TotalAgility server.
Note Make the endpoint address point to the integration service URL for TotalAgility.
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Configure the TotalAgility Integration with SharePoint using SSL
1. On the TotalAgility server, perform the following:
a. Add the SharePoint site location and Kofax TotalAgility SharePoint communicator using HTTPS
into the Kofax TotalAgility integration module (Home>Integration>SharePoint).
b. On Kofax TotalAgility server, open the Web.config file, locate the
BasicHttpBinding_SharePointCommunicatorService and set the security
mode="Transport"
2. On SharePoint server, to enable SharePoint events using HTTPS, perform the following:
a. Apply certificate onto SharePoint Server for that particular Sharepoint site.
b. For the SharePoint site, open the Web.config file, locate the BasicHttpBinding_Service
and set the security mode="Transport".

Network authentication for SharePoint and TotalAgility
Configure the network authentication for SharePoint and TotalAgility when they are on the same domain
or when they are on different domains.

TotalAgility and SharePoint are on the same domain
1. Ensure that TotalAgility site has Windows Authentication in Internet Information Services (IIS) and
the required SharePoint users are added to the TotalAgility server. Perform the following in the
TotalAgility server:
a. Open Internet Information Services (IIS) Manager.
b. Click Sites > Default Web Site > TotalAgility.
c. On the Features View tab, double-click Authentication.
d. Right-click Windows Authentication and click Providers.
e. Check if, Negotiate and NTLM are available as providers. If not, add them from the Available
Providers list.
2. Ensure that TotalAgility SharePoint Communicator site has Windows authentication in Internet
Information Services (IIS). Perform the following in the SharePoint server:
a. Open Internet Information Services (IIS) Manager.
b. Click Sites > Default Web Site > TotalAgilitySharePointCommunicator.
c. On the Features View tab, double-click Authentication.
d. Right-click Windows Authentication and click Providers.
e. Check if, Negotiate and NTLM are available as providers. If not, add them from the Available
Providers list.
f. Ensure that Site App pool is changed to SharePoint site App pool.
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TotalAgility and SharePoint are on different domains
Ensure that TotalAgility and SharePoint domains are trusted. If domains are not trusted, Windows
authentication will not work, so it must be disabled and Anonymous authentication must be enabled in IIS.
The Web.Config files must also be updated.
Perform the following steps in the TotalAgility server and SharePoint server:
1. Open Internet Information Services (IIS) Manager.
2. Click Sites > Default Web Site > TotalAgility.
For SharePoint server, click Sites > Default Web Site > TotalAgilitySharePointCommunicator
3. On the Features View tab, double-click Authentication.
4. Right-click Windows Authentication and click Disable.
5. Right-click Anonymous Authentication and click Enable.
6. Update the Web.config files.
a. In the Web.config file for TotalAgility, replace <transport
clientCredentialType="Windows" /> with <transport
clientCredentialType="None" /> in the following bindings:
• BasicHttpBinding_SharepointCommunicatorService
• BasicHttpBinding_Service
• CustomBinding_CoreService
• WebHttpBinding_Service

b. In the Web.config file for the TotalAgilitySharepointCommunicator site on the
SharePoint server, replace <transport clientCredentialType="Windows" /
> with <transport clientCredentialType="None" /> for
BasicHttpBinding_SharepointCommunicatorService binding.
c. In the Web.config file for the SharePoint site (C:\inetpub\wwwroot\wss\VirtualDirectories
\<site port>), replace <transport clientCredentialType="Windows" /
> with <transport clientCredentialType="None" /> for
BasicHttpBinding_SharepointCommunicatorService binding.

Configure the TotalAgility custom Web pages in SharePoint
Integrate a TotalAgility site directly into SharePoint web interfaces to add the following TotalAgility forms to
the SharePoint:
• Create new job/workflow
• Work queue
• Take activities (displaying TotalAgility take activity forms)
• Job/workflow list and job properties

Enable Single Sign-On
Provide single sign-on to access the SharePoint website and the TotalAgility site.
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Note Clear the Header Form option while creating the custom pages.
Use the default username initialization variable called “LOGON_USER” in the “top level” forms
(CreateNewJob, WorkQueue and JobList) in the TotalAgility site.
Note You can modify the name in the "LOGON_USER" if needed.
When implementing these forms, SharePoint passes the "LOGON_USER" variable into the embedded
TotalAgility forms to call the TotalAgility API, UserService::GetSingleSignOnSession().
1. Map form variable, LOGON_USER to userId.
2. Provide 7 to logOnProtocol.
3. Map global variable, SESSION_ID to SessionId.
4. Map global variable, RESOURCE_ID to ResourceId.
Using the GetSingleSignOnSession() API, you can avoid a separate logon to the TotalAgility forms
that are integrated into SharePoint. The GetSingleSignOnSession() API gets the TotalAgility session
ID for the user if they are already logged on, otherwise it just logs the user.
Note The SharePoint user must also be a user in TotalAgility for single logon to work.
Add links to the "top level" TotalAgility custom web pages in the SharePoint Quick Launch menu.

Add the TotalAgility custom web pages to the SharePoint quick launch menu
1. Go to Site Actions > Site Settings.
2. Under Look and Feel category, click Quick Launch.
3. Add the following new headings and rename the headings if needed.
Heading

Web Address

TotalAgility Workqueue

/_layouts/WorkQueue.aspx?EmbeddedForm=WorkQueue.form
Note Rename WorkQueue.form to point to your TotalAgility
work queue form; do not change the name if the form is called
WorkQueue.form.
If the Quick Launch menu is on a subsite, prefix the subsite name
in the link as follows: /SubSiteName/_layouts/WorkQueue.aspx?
EmbeddedForm=WorkQueue.form

TotalAgility Create Workflows

/_layouts/CreateJob.aspx?EmbeddedForm=Create%20Jobs.form
Note Rename Create%20Jobs.form to point to your TotalAgility
CreateNewJob form; do not change the name if the form is called
Create Jobs.form.
You can create multiple TotalAgility Create Workflow headings to
point to different TotalAgility CreateNewJob embedded forms.
If the Quick Launch menu is on a subsite, prefix the URL with
SubSiteName as explained for TotalAgility Workqueue .
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Heading

Web Address

TotalAgility Workflows

/_layouts/JobList.aspx?EmbeddedForm=JobList.form
Note Rename JobsList.form to point to your TotalAgility JobList form;
do not change the name if the form is called JobList.form.
If the Quick Launch menu is on a subsite, prefix the URL with
SubSiteName as explained for TotalAgility Workqueue.

Add the create TotalAgility workflow context menu item to a document library
Provide context menu links in SharePoint document libraries to launch the TotalAgility Create Workflow
custom page. Pass in the selected SharePoint document URL as an initialization variable to the new
TotalAgility workflow/job so it can be used in Activity forms to provide hyperlinks to the document.
Before you add a new context menu item to a document library, complete the following steps:
1. Create a process with two initialization parameters, DOC_URL and DOC_NAME.
2. Build a Create New Job form and add these initialization parameters, DOC_URL, DOC_NAME and
LOGON_USER.
3. Modify the Getinitvarlist action to clear the DOC_URL and DOC_NAME parameters o retain values
from the query string.
Then, do the following:
1. Create a text file with the following JavaScript:
<script>
function Custom_AddDocLibMenuItems(m, ctx)
{
// parse the URL out of the itemTable
var URL = "";
var DocName = "";
var index = itemTable.innerHTML.indexOf("href=");
if (index > 0)
{
var str = itemTable.innerHTML.substr(index + 6);
index = str.indexOf('"');
if (index > 0)
{
URL = str.substr(0, index);
index = str.indexOf('>');
var index2 = str.indexOf('<');
DocName = str.substr(index + 1, index2 - index - 1);
}
}
if (URL != "")
{
strAction = 'window.location = "http://[domainname]:
[Port Number]/[SubSiteName]/_layouts/CreateJob.aspx?DocUrl='
+ URL + '&DocName=' + DocName +
'&EmbeddedForm=[CreateNewJobFormName.form]"';
var strDisplayText = "Create workflow in TA";
var strAction;
var strImagePath = "";
// Add menu item
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CAMOpt(m, strDisplayText, strAction, strImagePath);
// add a separator to the menu
CAMSep(m);

}
return false;
}
</script>

2. Replace the [ domainname ] text in preceding script with the location of the SharePoint web
application that contains the TotalAgility custom web pages.
3. If required, specify the SharePoint subsite name in [ SubSiteName ].
4. Replace the [ CreateNewJobFormName.form ] text with the name of your TotalAgility CreateNewJob
form.
5. If required, rename the menu item display text "Create workflow in TA" in the script.
6. Upload this file to SharePoint Shared Documents.
7. Provide the link to this file in Content Editor Web Part:
a. Go to Site Actions > Edit page.
b. Click Add a Web Part.
c. In the Media and Content group, select Content Editor Web Part.
This mechanism injects JavaScript into the SharePoint page.
8. Save changes to the SharePoint page and exit Edit mode.
A new menu item called "Create Workflow in TA" becomes available from the Context list for a
document in this document library. Select the menu item to go to the CreateJob.aspx TotalAgility
custom web page (passing in the document URL and name).
9. Add more context menu items to use multiple Create Workflow pages.

Configure the custom web pages
Perform the following steps if you configure the TotalAgility custom web pages in SharePoint.
1. Download a copy of existing Seattle.master from the Master Page gallery and rename it to
KTA.master.
2. Open the KTA.master file in the editor.
3. To change the page logo to Kofax, update the LogoImageURL as follows.
LogoImageUrl= <SharePoint:SiteLogoImage CssClass="ms-siteicon-img"
name="onetidHeadbnnr0"id="onetidHeadbnnr2"LogoImageUrl="/_layouts/15/
images/<Image>?rev=23"runat="server">
Replace <image> with the Kofax image name.
4. If using Internet Explorer, update the content attribute value of <meta> tag to "IE=Edge" in the
KTA.master file as follows:
<meta http-equiv="X-UA-Compatible" content="IE=Edge"/>.
5. Upload the new KTA.master in the Master Page gallery as ASP NET Master Page file.
6. Publish the new KTA.master as a major version.
7. Set the new Master Page as Primary master page of your site.
8. Navigate to Site settings > Master Page and select the KTA.master page.
9. Update custom pages to use KTA.master.
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Configure TotalAgility Web Parts in SharePoint Server
Configure the SharePoint site that contains TotalAgility web parts to communicate with the TotalAgility
sever either using web services or enabling session.

Use the Web Services
1. Open the Web.config file.
2. Add the following keys:
• <add key="SPPServerName" value="<http or https>://<TA server
name><:port>/<TASiteName>"/>. For example, <add key="SPPServerName"
value="https://DL-WDEML-32:85/TotalAgility">
• <add key="SystemSessionId" value="<TA System Session Id>"/>. Get the value for
the key from System Settings in the Kofax TotalAgility Designer.
Note
• If you do not add the "SPPServerName" key, a message informs you that the Web services
communications layer for TotalAgility is not configured. In the key, do not mention the Port if
running under port 80.
• If you do not add the "SystemSessionId" key, a message informs you that the System Session Id
key is not found.

Enable session
1. Navigate to the C:\Inetpub\wwwroot\VirtualDirectories\<Port> folder.
Note Get the <Port> from address bar in Internet Explorer.
2. Open the Web.config file and do the following:
a. Search for “<add name=”Session”> and uncomment this line.
Note If add name ="Session" is not available, add the following code: <add name="Session"
type="System.Web.SessionState.SessionStateModule, System.Web, Version=4.0.0.0,
Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a" />
b. Search for the “<pages enableSessionState” tag and change the
“enableSessionState” attribute value from “false” to “true”.
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Set Up the Microsoft SharePoint Server and Kofax TotalAgility to
provide fault tolerance
Set up the TotalAgility server
Install MSMQ support:
1. Open Server Manager on the SharePoint Server.
2. Select to add Message Queuing feature.
3. Select the Message Queuing Server, Directory Service Integration and HTTP Support.
To set up the Kofax TotalAgility server:
1. Create a physical MSMQ queue on the TotalAgility Server:
a. Go to Computer Management\Message Queuing\Private Queues.
b. Create a Transactional private queue called: TotalAgility/Services/Core/
IntegrationEventService.svc.
Note Select the Transactional check box when creating the queue.
2. Enter the following two commands to configure IIS 7 to enable WAS to listen to the message queue
and activate your service when new messages arrive:
appcmd set site "Default Web Site" -+bindings.
[protocol='net.msmq',bindingInformation='localhost']
appcmd set app "Default Web Site/TotalAgility" /
enabledProtocols:net.msmq,http
3. Open the Web.config file located in the TotalAgility\Agility.Server.Web folder in your install location,
for example, C:\Program Files\Kofax\TotalAgility\Agility.Server.Web.
4. Add the following msmq binding in the <bindings> section:
<netMsmqBinding>
<binding name="MsmqBindingTransactionalNoSecurity" maxRetryCycles="3"
receiveErrorHandling="Move" receiveRetryCount="3" retryCycleDelay="00:01:00">
<security mode="None"/>
</binding>
</netMsmqBinding>

5. Open the Web.config file located in the Core folder in your install location, for example, C:
\Program Files\Kofax\TotalAgility\Agility.Server.Web\Services\Core.
6. Locate for <service
name="Agility.Server.Core.Services.IntegrationEventService"
behaviorConfiguration="Agility.Server.Web.Services.Behavior">
7. Add the following endpoint below this service tag:

<endpoint address=
"net.msmq://localhost/private/TotalAgility/Services/Core/
IntegrationEventService.svc"
binding="netMsmqBinding" bindingConfiguration="MsmqBindingTransactionalNoSecurity"
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contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService" /
>

8. Verify that the Microsoft Windows net.msmq Listener Adapter service is started.

Set up the Microsoft SharePoint server
1. Open the Web.config file for a SharePoint site.
2. Add the following tags under <bindings> section:
<netMsmqBinding>
<binding name="MsmqBindingTransactionalNoSecurity" maxRetryCycles="3"
receiveErrorHandling="Move" receiveRetryCount="3" retryCycleDelay="00:30:00">
<security mode="None"/>
</binding>
</netMsmqBinding>

3. Add the following tags under <client> section:

<endpoint address=
"net.msmq://<TA_MACHINENAME>/private/TotalAgility/Services/Core/
IntegrationEventService.svc"
behaviorConfiguration="MsmqBindingTransactionalTransportSecurity"
binding="netMsmqBinding"
bindingConfiguration="MsmqBindingTransactionalNoSecurity"
contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService"
name="Agility.Server.Core.Services.IntegrationEventService" />

4. Remove or comment out the following tag under <appSettings> section:
<add key="SPP_EventHandler_WebServiceURL" value="" />

5. Replace <TA_MACHINENAME> with the TotalAgility server name.
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Integrate Microsoft Dynamics CRM with
TotalAgility
To install Dynamics CRM, the users must have the administrator rights.
See also:
• Dynamics CRM installation
• Update the Web configuration file for Dynamics CRM

Dynamics CRM installation
1. Navigate to \\DynamicsCRMInstallation on the installation media, and double-click Setup.exe.
The installation wizard appears.
2. Click Next.
3. In the CRM Server URL box, replace the <ServerName> with CRM server name and replace Port
with the port on which CRM is running.
4. In the CRM Service URL box, replace the <ServiceName> with CRM service name.
5. In the Metadata Service URL box, replace the <MetaDataServiceName> with CRM metadata
service name.
6. In the Domain box, enter the domain name.
7. Enter the Username and Password.
8. Click Finish. The installation starts and registers Event Handler in CRM and places necessary files in
GAC.

Update the Web configuration file for Dynamics CRM
Add the following script for TotalAgility components to support event handlers:
Note If you copy and paste the code from this guide, fix the line breaks.
<configSections>
<section name="exceptionHandling"
type="Microsoft.Practices.EnterpriseLibrary.
ExceptionHandling.Configuration.ExceptionHandlingSettings,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
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<section name="loggingConfiguration"
type="Microsoft.Practices.EnterpriseLibrary.Logging.Configuration.LoggingSettings,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
</configSections>
<loggingConfiguration
name=""
tracingEnabled="true"
defaultCategory="General">
<listeners>
<add name="Event Log Listener"
type="Microsoft.Practices.EnterpriseLibrary.Logging.TraceListeners.
FormattedEventLogTraceListener,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
listenerDataType="Microsoft.Practices.EnterpriseLibrary.Logging.
Configuration.FormattedEventLogTraceListenerData,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
source="Total Agility" formatter="Text Formatter"
log="" machineName="." traceOutputOptions="None" />
</listeners>
<formatters>
<add type="Microsoft.Practices.EnterpriseLibrary.Logging.Formatters.TextFormatter,
Microsoft.Practices.EnterpriseLibrary.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
template="Timestamp: {timestamp}{newline}&#xA;Message: {message}
{newline}&#xA;Category: {category}{newline}&#xA;Priority:
{priority}{newline}&#xA;EventId: {eventid}
{newline}&#xA;Severity: {severity}{newline}&#xA;Title:
{title}{newline}&#xA;Machine: {localMachine}
{newline}&#xA;App Domain: {localAppDomain}
{newline}&#xA;ProcessId: {localProcessId}
{newline}&#xA;Process Name: {localProcessName}
{newline}&#xA;Thread Name: {threadName}
{newline}&#xA;Win32 ThreadId:{win32ThreadId}
{newline}&#xA;Extended Properties:
{dictionary({key} - {value}{newline})}"
name="Text Formatter" />
</formatters>
<categorySources>
<add switchValue="All" name="General">
<listeners> <add name="Event Log Listener" />
</listeners>
</add>
</categorySources>
<specialSources>
<allEvents switchValue="All" name="All Events" />
<notProcessed switchValue="All" name="Unprocessed Category" />
<errors switchValue="All" name="Logging Errors &amp; Warnings">
<listeners> <add name="Event Log Listener" />
</listeners>
</errors>
</specialSources>
</loggingConfiguration>
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<exceptionHandling>
<exceptionPolicies>
<add name="Agility Exception Policy">
<exceptionTypes>
<add name="All Exceptions" type="System.Exception, mscorlib,
Version=4.0.0.0,
Culture=neutral,
PublicKeyToken=b77a5c561934e089"
postHandlingAction="NotifyRethrow">
<exceptionHandlers>
<add name="Logging Exception Handler"
type="Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.
Logging.LoggingExceptionHandler,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.Logging,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
logCategory="General" eventId="100" severity="Error"
title="Total Agility"
formatterType="Microsoft.Practices.EnterpriseLibrary.
ExceptionHandling.TextExceptionFormatter,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling,
Version=5.0.505.0,
Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
priority="0" />
</exceptionHandlers>
</add>
</exceptionTypes>
</add>
</exceptionPolicies>
</exceptionHandling>

Update Web.config for the CRM Virtual Directory
<system.serviceModel>
<bindings>
<basicHttpBinding>
<binding name="BasicHttpBinding_Service" openTimeout="00:10:00"
closeTimeout="00:10:00"
sendTimeout="00:10:00" receiveTimeout="00:10:00" allowCookies="true"
maxBufferSize="2147483647"
maxReceivedMessageSize="2147483647" maxBufferPoolSize="524288">
<readerQuotas maxDepth="2147483647" maxStringContentLength="2147483647"
maxArrayLength="2147483647" maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647" />
<security mode="TransportCredentialOnly">
<transport clientCredentialType="Windows" />
</security>
</binding>
</basicHttpBinding>
</bindings>
<client>
<endpoint name="CoreIntegrationEventServiceEndpoint"
binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_Service"
contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService"
address="http://<TotaAgility server name or
IP Address>/TotalAgility/Services/Core/IntegrationEventService.svc"/>
</client>
</system.serviceModel>
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Note Replace the <TotalAgility server name or IP Address> with the IP Address of the TotalAgility
server.
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Integrate Microsoft Dynamics AX with
TotalAgility
To install Dynamics AX,
• Users created in TotalAgility must have Deployment Administrator rights.
• If a user does not use the default Deployment Administrator to install the TotalAgility Dynamics AX
integration, the user must meet the following conditions:
• Be the system administrator in AX.
• Have full CAL access.
Failure to meet the preceding criteria generates the following error message during installation: "System
unable to process request error."
1. Navigate to \\DynamicsAXInstall on the installation media and double-click Setup.exe.
The Kofax TotalAgility for Dynamics AX Setup wizard appears.
2. Click Next.
The window displays a list of prerequisite software for Dynamics AX.
Note If the required software is not installed, first install the software and then install Dynamics
AX. If using Dynamics AX 2009, install .NETFramework 3.5. If using Dynamics AX 2012,
install .NETFramework 4.0.
3. Click Next.
The Destination window appears.
4. Use the information in the following table to specify file paths in the Destination folder:
Destination Folder

Sample Path for Dynamics AX 2009

Sample Path for Dynamics AX 2012

DAX website Physical
Location

C:\inetpub\wwwroot
\MicrosoftDynamicsAXAif50\

C:\Program Files\Microsoft
Dynamics AX\60\AifWebServices

DAX website URL

Default Web Site/
MicrosoftDynamicsAXAif50/

Default Web Site/
MicrosoftDynamicsAXAif60/

DAX Client Physical
Location

C:\Program Files\Microsoft
Dynamics AX\50\Client\Bin\

C:\Program Files
(x86)\Microsoft Dynamics AX
\60\Client\Bin

DAX Server Physical
Location

C:\Program Files\Microsoft
Dynamics AX\50\Server
\DynamicsAx1\Bin

Not Applicable

5. Click Next.
The Credentials window appears.
6. Enter your Username and Password to associate with DAX Application pool.
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7. Click Next.
The system displays the installation status and a summary of installation report when installation is
complete.
8. Click Finish.
Important If you are using 64 bit operating system and Dynamics AX 2009 32 bit application,
enable the Application Pool account associated with the DAX Communicator site. In the IIS
Manager, click Application Pools > DAXAppPool > Advanced Settings and set True
for Enable 32-Bit Applications.
See also:
• Create Dynamics AX service reference to the TotalAgility web service
• Add a reference
• Copy files manually
• Import the TotalAgility connector class into Dynamics AX
• Edit database X++ event methods
• Verify the Application Pool account

Create Dynamics AX service reference to the TotalAgility web
service
As AOT (Application Object Tree) is in the Development Workspace, ensure to deploy the Development
Workspace to add in references. Otherwise, you cannot integrate TotalAgility with Dynamics AX. See the
following URL for instructions: http://msdn.microsoft.com/en-us/library/gg846350.aspx.

Create Dynamics AX 09 service reference to the TotalAgility web service
1.
2.
3.
4.

Start Dynamics AX 09.
Click AOT (Application Object Tree) and press Ctrl+D.
In the application object tree, Right-click References and select Add service reference.
Complete the Add service reference window with the following information:
a. WSDL URL: Enter the web URL of the DynamicsAxIntegrationService within the Agility IIS
web application, for example, http://Server/Agility.Server.Web/Services/SDK/
DynamicsAxIntegrationService.svc.
b. .NET code namespace: KtaEventsService.
c. Reference name: KtaEventsService.

d. Service description: Description of the service reference.
5. Click OK.

Create Dynamics AX 12 service reference to the TotalAgility web service
1. Start Dynamics AX 12.
2. Click AOT (Application Object Tree) and press Ctrl+Shift+W.
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3. In the application object tree, right-click References and select Add Reference.
4. Browse to the TotalAgility assembly, KtaEvents.Services.dll which was installed previously. For
example,
C:\Program Files (x86)\Microsoft Dynamics AX\60\Client\Bin
5. Click OK.

Add a reference
Add a reference to the Agility.Server.Integration.Common.dll assembly in Dynamics AX.

In Dynamics AX 09
1. Right-click References and select Add reference.
The assembly browsing form opens.
2. Browse to the client\bin directory of the Dynamics AX 09 installation. For example,
C:\Program Files (x86)\Microsoft Dynamics AX\50\Client\Bin)
3. Select the Agility.Server.Integration.Common.dll assembly and click OK.
The newly added assembly appears under references.

In Dynamics AX 12
1. Right-click References and select Add reference.
2. Browse to the TotalAgility assembly, Agility.Server.Integration.Common.dll, that was installed
previously. For example, C:\Program Files (x86)\Microsoft Dynamics AX\60\Client
\Bin.
The newly added assembly appears under references.
3. Click OK.

Edit the service configuration file for Dynamics AX 12
1. Browse to the client\bin directory of the Dynamics AX where the WCF service configurations file,
KtaEvents.Services.dll.config was copied by the installer.
2. Edit the endpoint to point to the valid TotalAgility Service for Dynamics AX notifications (…Services/
SDK/DynamicsAxIntegrationService.svc).

Copy files manually
To successfully add a Dynamics AX 2012 R2 site in TotalAgility, you must perform the following steps
manually:
1. Open Microsoft Dynamics AX 2012 and navigate to Dynamics AX server folder.
2. Copy version 6.2.0 of Microsoft.Dynamics.BusinessConnectorNet.dll and paste it to the bin directory
of the DAXCommunicatorService that you install on to the Dynamics AX server.
3. On your TotalAgility release media, navigate to \\TotalAgility\DAXInstallation
\Agility.Server.Integration.DynamicsAx.Web\Dax2012R2.
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4. Copy Web.config and paste it to the following location on your DAX Server:
<\\Microsoft Dynamics AX\60\AifWebServices\DAXCommunicatorService>
This Web.config tells the service to use the 6.2.0 version of the dll.
Note For DAX 2012 R3, the Web.config file needs updated to use 6.3.0 version of
Microsoft.Dynamics.BusinessConnectorNet.dll.

Import the TotalAgility connector class into Dynamics AX
1. In the AOT, click Import or press Ctrl+Shift+I.
2. Click Browse and navigate to the Dynamics AX Setup installation folder (in the Program Files(x86)
or Program Files directory). For example,
C:\Program Files\Dynamics AX Setup
3. Select the XPO class, such as Class_KtaController.xpo.
4. Click OK to initiate the import or compilation process.
Note Once the class is imported, the Status tab in the compiler output page displays any errors.

Edit database X++ event methods
You can edit the database X++ event methods in the DAX Development Workspace under Classes and
Application folders.
1. To alter the Application CUD (create, update and delete) class event methods, call the custom class
method EventChangeNotifyKtaWebService when a CUD event has been performed within Dynamics
AX.
2. Edit the Application class methods (InsertLog, DeleteLog & UpdateLog) by adding a single line to
the appropriate location within each method:
• Insertlog method: new
ktaController().EventChangeNotifyKtaWebService("Create", recordInserted,
null, conNull(), recordInserted.RecId);
• Deletelog method: new
ktaController().EventChangeNotifyKtaWebService("Delete", recordDeleted,
null, conNull(), recordDeleted.RecId);
• Updatelog method: new
ktaController().EventChangeNotifyKtaWebService("Update", recordOrig,
recordUpdated, changedFields, recordUpdated.RecId);
Note The onsite AX Administrator registers the Databaselog events for various AX documents.
For example, if the Customer, SalesOrder and Purchase Requisition documents have the Insert,
Update and Delete events registered against them, and when one of these events execute for
one of these documents, TotalAgility is informed through a WCF call.
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Register the database log events
1. Open Microsoft Dynamics AX 2012.
2. In the left hand panel, expand the configure buttons

and select System Administration.

3. In the System Administration page, under Setup, click Database logsetup. Database log window
appears.
4. Click File > New. Logging Database changes wizard appears where you can add and remove tables
and fields from the database log.
5. Click Next. Tables and Fields window appears.
6. Select the Show all tables radio button.
7. In the Tables and Fields window, under General Ledger, select Customers / Vendor Tables as
required and click Next.
8. Select the type of change (insert, update, delete, or rename) to register in the database log by
selecting the appropriate check box for the table.
9. Click Next. Logging Database changes window appears with the details of the selected tables and
fields.
10. Click Finish.

Verify the Application Pool account
Verify that the Application pool account is using the correct Business Connecter.NET (BC.NET) Windows
credentials.
1. On the Start menu, select All Programs > Accessories > Run.
2. Enter inetmgr and click OK.
The IIS Manager appears.
3. Navigate to Application Pool accounts.
4. Select the DAXKTA account and verify that the identity is the same as the BC.NET Windows
credentials.
5. If the credentials differ, do the following:
a. On the Actions panel, click Advanced Settings.
6.
7.
8.
9.

b. Select the identity and click Edit.
Click OK.
The Application Pool Identity window appears.
Click Set.
The Set Credentials window appears.
Enter the user credentials that are associated with the BC.NET account within Dynamics AX. (The
Kofax WCF service uses the BC.NET account to connect to Dynamics AX).
Click OK.
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Integrate Microsoft Outlook with TotalAgility
Integrate Microsoft Outlook 2010 and 2013 with TotalAgility to view, complete, save and cancel various
TotalAgility tasks directly from Outlook.
1. Navigate to \\OutlookInstallation on the installation media and double-click Setup.exe.
The system opens the TotalAgility for Outlook Setup wizard.
2. Click Next.
3. Click Finish.
4. Click Install.
5. Click Close.
6. Click OK on the confirmation message.
Once Outlook is integrated with TotalAgility, a new TotalAgility menu appears on the Outlook menu
bar where you can configure the TotalAgility-related actions.
Note You must associate Outlook with an account. See "Configure Microsoft Outlook settings for
TotalAgility" in TotalAgility help. If you do not associate an account with Outlook, the activities are
not retrieved and a message is displayed.
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Integrate Micro Focus Content Manager with
TotalAgility
This chapter provides the instructions for integrating Micro Focus Content Manager.

Identify the Content Manager SDK Version
These instructions only apply to Content Manager version below 8.
1. Navigate to the C:\Program Files\Kofax\TotalAgility\ folder.
2. Right-click TrimSDKPIA20.dll and select Properties.
The TrimSDKPIA20.dll properties window appears.
3. On the properties window, select the Version tab.
The File Version displays the current TRIM version. For example, 7.3.
Note For TRIM SDK 7.3.0 and later, you will require to enter this number in the <assemblyBinding>
section of the Web.config file (see Set up the Micro Focus Content Manager server).

Set up the Micro Focus Content Manager server
To set up the Content Manager server, install and configure TotalagilitytrimCommunicatorService and then
configure the event handler in Content Manager system.

Install and configure TotalAgilityTrimCommunicatorService
To install and work with Content Manager, users must have administrator rights.
1. Log on to the Content Manager server with an account with Local Administrator privilege.
2. Navigate to the \\ContentManagerInstallation on the installation media, right click on the
executable Setup.exe and select Run as administrator.
The User Account Control window appears.
3. Click Yes.
The installation wizard appears.
4. Click Next.
5. Click Finish.
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6. Configure the Web.config file:
a. In C:\Program Files\Kofax\TotalAgility
\TotalAgilityTrimCommunicatorService, open the Web.config file in the text editor.
b. Locate the configuration > runtime tag and edit the <assemblyBinding> section as follows:
<assemblyBinding>
<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>
<assemblyIdentity name="TrimSdkPIA20"
publicKeyToken="533fc65e30e543fa" />
<bindingRedirect oldVersion="6.2.2.8614"
newVersion="<latest version>" />
</dependentAssembly>
</assemblyBinding>

Replace the <latest version> with the version of TRIM SDK. See Integrate Content Manager
with TotalAgility.
c. Edit the <appsettings> as follows:
<appSettings>
<add key="TrimDocumentRecordType"
value="DocumentRecordType" />
<add key="TrimFolderRecordType"
value="FolderRecordType" />
<add key="WorkGroupServerName" value="ServerName" />
</appSettings>

• Replace the DocumentRecordType with the value taken from the Content Manager server by
checking the record type of Document.
• Replace the FolderRecordType with the value taken from the Content Manager server by
checking record type of Folder.
• Replace the ServerName with the computer name of the Server.
To identify the computer name of the server, open Windows Explorer, right-click Computer
and click Properties. In the Computer name, domain, and workgroup settings group, click
Change Settings. Copy the computer name.
Important When you first install the TotalAgility Micro Focus Content Manager, a
TrimIntegrationAppPool with a local system identity is created. This causes an error if the
Content Manager server is remote.
To resolve this error, you must update the TrimIntegrationAppPool identity to account with
Administratior permission.
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Configure the event handler in Content Manager
Configure TotalAgility events for actions in the Content Manager System.
1. Copy the following DLLs.
• If using Content Manager version below 8, copy the following DLLs to the TRIM binaries directory
(usually c:\Program Files\Hewlett-Packard\HP Records Manager.)
• Agility.Server.Integration.Trim.dll
• Agility.Server.Integration.Model.dll
• Agility.Server.Integration.Common
• If using Content Manager version 8 and above, copy Agility.Server.Integration.Trim.dll to the
TRIM directory.
2. For Content Manager to fire events in TotalAgility, register the Agility.Server.Integration.Trim.dll file
using RegAsm (regasm /codebase Agility.Server.Integration.Trim.dll).
3. To register the dll:
a. Open Content Manager.
b. Select Tools > Context Administration > External Links.
The Content Manager Context External Links window appears.
c. Click New Record AddIn.
The Record AddIn Properties window appears.
d. Enter a Link Name.
e. In the COM Add-In PROGID box, enter the
ProgId,Agility.Server.Integration.Trim.TrimIntegrationEventHandler.
f. Select Add-In supports a multi-threaded environment.
g. Click OK.
The Content Manager Context External Links window displays the new link.
h. Select the link and click Properties.
The Record AddIn Properties window appears.
i. Click the Used By tab.
j. Check the Document and File Folder under Record list and click OK.
This configures the Event handler on Content Manager.
4. In the Explorer, find trim.exe.config file, open it in a text editor and add or replace the following tags:
Note If you cut and paste code from this guide, correct any incorrect line breaks.
<?xml version="1.0" encoding="utf-8" ?>
<configuration>
<configSections>
<section name="loggingConfiguration"
type="Microsoft.Practices.EnterpriseLibrary.Logging.Configuration.LoggingSettings,
Microsoft.Practices.EnterpriseLibrary.Logging, Version=5.0.505.0,
Culture=neutral, PublicKeyToken=31bf3856ad364e35" requirePermission="true" />
<section name="exceptionHandling"
type="Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.Configuration.
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ExceptionHandlingSettings,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling,
Version=5.0.505.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"
requirePermission="true" />
</configSections>
<exceptionHandling>
<exceptionPolicies>
<add name="Agility Exception Policy">
<exceptionTypes>
<add name="All Exceptions" type="System.Exception, mscorlib, Version=4.0.0.0,
Culture=neutral, PublicKeyToken=b77a5c561934e089"
postHandlingAction="NotifyRethrow">
<exceptionHandlers>
<add name="Logging Exception Handler" type=
"Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.Logging.LoggingExceptionHandler,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.Logging,
Version=5.0.505.0,
Culture=neutral, PublicKeyToken=31bf3856ad364e35" logCategory="General"
eventId="100" severity="Error" title="Total Agility"
formatterType=
"Microsoft.Practices.EnterpriseLibrary.ExceptionHandling.TextExceptionFormatter,
Microsoft.Practices.EnterpriseLibrary.ExceptionHandling, Version=5.0.505.0,
Culture=neutral, PublicKeyToken=31bf3856ad364e35" priority="0" />
</exceptionHandlers>
</add>
</exceptionTypes>
</add>
</exceptionPolicies>
</exceptionHandling>
<system.serviceModel>
<bindings>
<basicHttpBinding>
<binding name="BasicHttpBinding_Service" openTimeout="00:10:00"
closeTimeout="00:10:00"
sendTimeout="00:10:00" receiveTimeout="00:10:00" allowCookies="true"
maxBufferSize="2147483647"
maxReceivedMessageSize="2147483647" maxBufferPoolSize="524288"> <readerQuotas
maxDepth="2147483647"
maxStringContentLength="2147483647" maxArrayLength="2147483647"
maxBytesPerRead="2147483647"
maxNameTableCharCount="2147483647" />
<security mode="TransportCredentialOnly">
<transport clientCredentialType="Windows" />
</security>
</binding>
</basicHttpBinding>
</bindings>
<client>
<endpoint name="CoreIntegrationEventServiceEndpoint"
binding="basicHttpBinding" bindingConfiguration="BasicHttpBinding_Service"
contract="Agility.Server.Core.Model.Interfaces.Services.IIntegrationEventService"
address="http://<TotaAgility server name or IP Address>/TotalAgility/Services/
Core/IntegrationEventService.svc"/>
</client>
</system.serviceModel>
</configuration>

Replace <TotalAgility server name or IP Address> with the IP Address of the TotalAgility server.
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Integrate Kofax SignDoc with TotalAgility
This chapter provides the instructions for integrating Kofax SignDoc with TotalAgility.

Set up the Kofax SignDoc server
Configure the Kofax SignDoc server to point to the relevant TotalAgility server to allow callback to occur
when the signing is completed. The SignDoc server can be configured per SignDoc account to allow the
same SignDoc server to callback to multiple TotalAgility servers.
Refer to the section on integration with TotalAgility in SignDoc documentation to know how to set up the
SignDoc server to point to the TotalAgility server.
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KCM proxy installation on the Web server
This chapter describes two methods for installing the KCM Proxy Web server:
• Silent installation
• Standard installation
Ensure that the Microsoft plugin, Web Platform Installer is installed before installing the KCM Proxy Web
server. You can install the Microsoft Web Platform from the Microsoft website.

Silent installation
1. On the installation media, navigate to \\KCMProxyInstallation.
2. Launch a Command Prompt window and run Setup.exe and enter the KCM Server URL in the
following format: http(s)://<CCMServer>:<Portnumber>.
Provide the IP address and port number of the KCM server. The installer updates the Web.config file
with KCM server details and enables the proxy rewrite rules on the web server (IIS).
3. Press Enter.
The KCM Proxy is installed in the silent mode.
The system generates a log file on the desktop which reports errors (if any).

Standard installation
1. On the installation media, navigate to \\KCMProxyInstallation and double-click Setup.exe.
The KCM Proxy Configuration window appears.
2. Enter the KCM Server URL in the following format: http(s)://<CCMServer>:<Portnumber>.
The Web.config file is automatically updated with the KCM Server IP and the Port number.
3. Click Configure.
4. Click OK.

Update the KCM Server URL in TotalAgility Web.config
You can manually update the KCM Server URL in TotalAgility Web.config or run the Configuration tool and
update the settings before setting up the integration to KCM.
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Manually update the KCM Server URL in TotalAgility Web.config
1. Navigate to the installation directory for the TotalAgility server.
2. In a text editor, open TotalAgility Web.config from the following directory:
\\TotalAgility\Agility.Server.Web
3. Locate the following section:
<rewrite>
<rules>
<rule name="CCMInteractiveProxy" stopProcessing="true">
<match url="CCM/Proxy/Interactive/(.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/ccm/Interactive/
{R:1}" />
</rule>
<rule name="CCMDesignerProxy" stopProcessing="true">
<match url="CCM/Proxy/Repository/(.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/ccm/Repository/
{R:1}" />
</rule>
<rule name="ComposerUIJavascriptProxyRule" stopProcessing="true">
<match url="CCM/Proxy/ccmcomposerui.js" />
<action type="Rewrite" url="{http://ccmserver:port}/proxy/
ccmcomposerui.js" />
</rule>
<rule name="ComposerUICssProxyRule" stopProcessing="true">
<match url="CCM/Proxy/ccmcomposerui.css" />
<action type="Rewrite" url="{http://ccmserver:port}/proxy/
ccmcomposerui.css" />
</rule>
<rule name="ComposerUIImgProxyRule" stopProcessing="true">
<match url="CCM/Proxy/img/(.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/proxy/img/{R:1}" />
</rule>
<rule name="CCMDesignerStaticProxyRule" stopProcessing="true">
<match url="CCM/Proxy/static/(.*)" />
<action type="Rewrite" url="{http://ccmserver:port}/ccm/static/
{R:1}" />
</rule>
<rule name="ComposerUIFontProxyRule" stopProcessing="true">
<match url="CCM/Proxy/fonts/(.*)" />
<action type="Rewrite" url="http://{ccmserver:port}/proxy/fonts/
{R:1}" />
</rule>
</rules>

4. Replace the http://<kcmserver>:<port> with the kcmserver URL.
5. Save and close the configuration file.

Using the Configuration Utility
Run the Configuration Utility and update the configuration settings. See the Kofax TotalAgility
Configuration Utility Guide. (Navigate to Configuration settings >On-premise >App section).
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Install KCM Proxy manually
You can install KCM proxy without using Web platform installer and KCM proxy installer.
1. Install IIS URL Rewrite 2.0.
2. Install Microsoft Application Request Routing 2.5 or higher for IIS.
3. In the IIS Manager, do the following:
a. On server level, double-click Application request routing cache.
b. Click Server Proxy Settings.
c. Select Enable Proxy.
d. Click Apply.
4. In TotalAgility web.config, find {http://ccmserver:port} and replace with http://
servername:port where servername is the host name of the KCM machine and port is the port
KCM listed as (default 8081). See Manually update the KCM Server URL in TotalAgility Web.config.
5. Uncomment the <rewrite> section.
6. Save and close the configuration file.
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Configure HTTPS communication
Configure TotalAgility and Transformation Designer for HTTP communication.

Configure TotalAgility for HTTPS communication
Enable SSL (Secure Sockets Layer) communication for the TotalAgility web layer and Kofax TotalAgility
Core Worker to communicate with core services and Transformation Server.
You can enable SSL for TotalAgility at the time of installation. However, if you have not enabled SSL at
the time of installation, you can do so post installation by running the Configuration Utility available on the
installation media. See the Kofax TotalAgility Configuration Utility Guide.
Note Before changing the bindings in the TotalAgility configuration files, ensure that SSL is enabled for
TotalAgility in the IIS.

Enable SSL for the TotalAgility application in IIS
1. Open Internet Information Services (IIS) Manager.
2. Right-click the Default Web Site and click Edit Bindings.
3. Click Add.
a. On the Type list, select https.
b. On the SSL certificate list, select the certificate.
c. If installing a separate web server, additionally specify the IP address of the web server, and
Port number.
d. Click Ok.
4. Click TotalAgility and click SSL settings on the Features tab.
a. Select the check box for Require SSL.
b. Accept the Client certificates.
c. Click Apply.

Update the TotalAgility configuration files
Update the following configuration files:
• Web.config
• Agility.Server.Core.WorkerService.exe.config
• Agility.Server.StreamingService.exe.config
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Update Web.config
1. Open Web.config located at your installed location. The default location is:
C:\Program Files\Kofax\TotalAgility\Agility.Server.Web
2. In <servicebehaviors>, update the httpsGetEnabled setting as follows:

<serviceBehaviors>
<behavior name="Agility.Server.Web.Services.Behavior">
<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
</serviceBehaviors>

3. By default <security mode="TransportCredentialOnly">. If using HTTPS mode, update the
<security> settings as follows:
• If using Windows Authentication, comment out the default Windows authentication section:
<!-- HTTPS SSL with Windows logon-->
<security mode="Transport">
<transport clientCredentialType="Windows"/>
</security>

• If logging on manually, uncomment the HTTPS section:
<!-- HTTPS SSL with application authentication-->
<security mode="Transport">
<transport clientCredentialType="None" />
</security>

4. Perform the above HTTPS transport authentication for all the bindings:
• BasicHttpBinding_SharepointCommunicatorService
• BasicHttpBinding_TrimCommunicatorService
• BasicHttpBinding_ExchangeNotificationService
• BasicHttpBinding_DynamicsAxCommunicatorService
• BasicHttpBinding_DynamicsAxIntegrationService
• BasicHttpBinding_Service
• CustomBinding_CoreService
• BasicHttpBinding_RemoteLinkedService
• BasicHttpBinding_LicenseServerService
• BasicHttpStreamingBinding_Service
• BasicHttpBinding_DeviceManagerService
• BasicHttpBinding_InsightDataService
• BasicHttpBinding_SigningIntegrationService
• WebHttpBinding_Service
• WebHttpBinding_DeviceManagerService
• WebHttpBinding_SigningIntegrationService
5. The Secure attribute for sensitive cookies in HTTPS sessions is not set by default. This allows
a browser to send these cookies in plain text over an HTTP session. To secure the cookies,
uncomment the httpCookies tag.
<httpCookies requireSSL="true"/>

137

Kofax TotalAgility Installation Guide

6. To connect TotalAgility to a specific SQL server, ensure that "encrypt=true" for the TotalAgility
database connection string.
Note Ensure that SSL is enabled and certificates are installed for the SQL server. See the
Microsoft documentation.
If SSL encryption has been turned on globally at the SQL server level using force encryption, you
do not need to update the TotalAgility connection strings.
7. Save the file.

Update Agility.Server.Core.WorkerService.exe.config
1. Open Core Worker Agility.Server.Core.WorkerService.exe.config located at your installed
location. The default location is:
C:\Program Files\Kofax\TotalAgility\CoreWorkerService
2. Perform the HTTPS transport authentication for all the bindings:
• BasicHttpBinding_Service
• CustomBinding_CoreService
• BasicHttpBinding_SharepointCommunicatorService
• BasicHttpBinding_TrimCommunicatorService
3. Save the file.
4. Restart the TotalAgility CoreWorker service.

Update Agility.Server.StreamingService.exe.config
1. Open the Agility.Server.StreamingService.exe.config located at your installed location. The default
location is:
C:\ProgramFiles\Kofax\TotalAgility\Agility.Server.Web\bin
\Agility.Server.StreamingService.exe.config
Note Edit the Agility.Server.StreamingService.exe.config for both the Application and Web server.
2. In <servicebehaviors>, update the httpsGetEnabled setting as follows:

<serviceBehaviors>
<behavior name="Agility.Server.Web.Services.Behavior">
<serviceMetadata httpGetEnabled="false" httpsGetEnabled="true" />
</serviceBehaviors>

3. By default, <security mode="TransportCredentialOnly">. If using HTTPS mode, update
the <security> settings (for Windows authentication or logging on manually) as follows:
• <!-- HTTPS SSL with Windows logon-->
<security mode="Transport">
<transport clientCredentialType="None"/>
</security>

4. Perform the HTTPS transport authentication for all the bindings as follows:
• WebHttpExportBinding_Service
<binding name="WebHttpExportBinding_Service"> transferMode="StreamedResponse">
<security mode="Transport">
<transport clientCredentialType="None">
</transport>
</security>
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</binding>

• WebHttpImportBinding_Service
<binding name="WebHttpImportBinding_Service"> transferMode="StreamedRequest">
<security mode="Transport">
<transport clientCredentialType="None">
</transport>
</security>
</binding>

• BasicHttpStreamingBinding_Service

<binding name="BasicHttpStreamingBinding_Service" transferMode="Streamed"
<security mode="Transport">
<transport clientCredentialType="None">
</transport>
</security>
</binding>

• BasicHttpBinding_Service

<binding name="BasicHttpBinding_Service">
<security mode="Transport">
<transport clientCredentialType="Windows" />
</security>
</binding>

• BasicHttpStreamingBinding_CoreService

<binding name="BasicHttpStreamingBinding_CoreService" transferMode="Streamed"
<binding name="BasicHttpStreamingBinding_CoreService" transferMode="Streamed"
<security mode="Transport">
<transport clientCredentialType="Windows" />
</security>
</binding>

Note The streamed transfer mode causes the Microsoft WCF runtime to enforce some
restrictions on security. The Windows authentication is not possible with streamed transfer
mode. Therefore, we recommend that you use anonymous authentication. However, TotalAgility
always validates the session ID before serving a request.
• CustomBinding_CoreService
<binding name="CustomBinding_CoreService">
<!-<httpTransport authenticationScheme="Negotiate" for http with windows
authentication
<httpsTransport authenticationScheme="Anonymous" for https with None
authentication
-->
<httpsTransport authenticationScheme="Anonymous" allowCookies="true"
maxBufferSize="2147483647" maxReceivedMessageSize="2147483647"
maxBufferPoolSize="524288" />
</binding>

5. Change the <baseAddresses> from http to https.
6. Save the file.
7. Restart the TotalAgility Streaming Service to apply the new settings.
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Configure the Transformation Designer for HTTPS communication
Update the Kofax Transformation Designer to use SDK SVC accessed via SSL by updating the
connection within Kofax Transformation Designer options. For Kofax Transformation Designer, you need
to do the following for HTTPS communication:
• Make sure you have installed a certificate that is trusted by the client on the server.
• If the Transformation Designer server is installed on-premise but is not part of a domain, disable
Windows Authentication for BasicHttpBinding_Service and WebHttpBinding_Service.
• Specify the URL for Transformation Designer for HTTPS as follows:
• For Azure: https://<Azure host name>/Services/SDK
• For other configurations: https://<host name>/TotalAgility/Services/SDK
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TotalAgility License Proxy installation
TotalAgility License Proxy enables unconnected Scan Workstations and/or other TotalAgility components
to get licensing from the TotalAgility Licence server.
We recommend to install TotalAgility License Proxy on the machine where VRS Elite server is installed.
Otherwise, you will need to run the license utility on each workstation and configure the server to point to
the proxy machine.
Do not install the Licence Proxy on the same computer as the Licence server (computer running the
'Kofax License Server' service). The Licence Proxy must run on a separate computer, because it needs
to route traffic to the licence server. As part of the License Proxy setup, the installer checks the local
computer for the TotalAgility License Server, stops the service and sets the startup type to "Disabled".
1. Navigate to \\TotalAgility > Licensing > Installs and click
Kofax.Licensing.TotalAgility.Proxy.Installer on the Installation media.
The Kofax TotalAgility License Proxy Setup window opens.
2. Click Next.
3. In the End-User License Agreement window, select I accept the terms in the License Agreement
and click Next.
4. In the Destination Folder window, select the default folder (C:\Program Files (x86)\Kofax
\Kofax TotalAgility License Proxy\) for the License server or click Change to choose
another folder.
5. Click Next.
6. In the Service Account Setup window, enter the credentials for the user who will run the TotalAgility
License Server service:
a. In the Username field, enter the user name.
b. To specify a domain user, enter the user name in the format Domain\User.
c. Enter and confirm the Password.
Note This account must have access to TotalAgility.
d. Click Next.
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7. In the TotalAgility Connection Setup window:
a. Enter the URL of the License Server where the configuration settings reside.
Use the following format: http://<server_name>/TotalAgility/Services/Core/
LicenseServerService.svc where <server_name> is the TotalAgility server name.
Note If using SSL, you must have a trusted, valid certificate.
b. Enter the System Session ID.
c. Click Next
The system downloads the settings.
8. Click Install to install the License Server.
9. Click Finish.

Modify the TotalAgility license proxy information
You can modify the TotalAgility license proxy information after the installation, in one of the following ways.
• Run the Kofax.Licensing.TotalAgility.ProxyConfig.exe typically located at C:\Program
Files (x86)\Kofax\Kofax TotalAgility License Proxy\. Example: If you regenerate the
system session ID in TotalAgility Designer, the same session ID must be reflected in the License Proxy
configuration.
• Use command line parameters. Replace the parameters with the following values, if needed.
Parameter

Value

/URL

TotalAgility URL

/sessionID

System Session ID for the specified user.

/retrySpan

Length of time to retry connections to Kofax TotalAgility. Format is that accepted by
TimeSpan.Parse, for instance "00:00:30" represents the default of 30 seconds.

/silent

Enables silent mode for configuration utility. User Interface does not appear.

For example, Kofax.Licensing.TotalAgility.TenantProxyConfig /url https://
tenantSpecific /sessionId {66FFD7D5-F618-4BEE-903A-54C151671BC8} /retrySpan:
00:05:00.
Note When you run the command with any invalid parameters an error message is sent to the
standard error file.
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Configure VRS Elite for TotalAgility
Install Kofax VRS and configure the VRS license server. Refer to the Kofax VRS Elite Installation Guide
for more details.

Kofax VRS Basic or Professional OEM installations
If your scanner includes an OEM version of VRS Basic or Professional, install VRS by running setup.exe
on the scan station. The VRS software is automatically activated based on the attached scanner model.

Standalone installations
If you purchased a standalone VRS license, install VRS by running setup.exe and select Standalone
as the setup type. When prompted, specify the part number (such as VP-P005-0001), product code, and
serial number to activate the software.
Note VRS remains activated on the workstation unless you manually deactivate it.

Kofax VRS Elite licensing managed by the Kofax TotalAgility
License Server
Use this configuration to manage VRS licenses through the TotalAgility License Server while also enabling
VRS Elite shared profiles and auto profile training data.
This configuration requires installation of the VRS Elite 5.1.2 or higher.

Install VRS Server
1. Run setup.exe from the VRS Elite installation media.
2. When prompted, select Server as the setup type.
3. Confirm the KTA license server information.
Note If the VRS Server does not have a direct connection to the Kofax TotalAgility license server,
you need to install a license proxy.
4. Use the generated deployment Kofax VRS.msi to install VRS on the scan stations. Refer to the Kofax
VRS Elite Installation Guide for details.
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Use Kofax VRS Elite with the TotalAgility Scan Client
After you install VRS Elite, Kofax Software VRS - TWAIN appears in the list of scanners when you scan a
document in TotalAgility. See the Kofax TotalAgility Scan Client help for more information.
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Kofax Web Capture Service installation
Install the Kofax Web Capture Service either at the default location or to a custom location.

Install at the default location
1. When opening a scan-enabled form for the first time, a prompt appears asking you to install the new
Web Capture Service. See Build a Scan Create New Job form in TotalAgility Help.
2. Click Run.
3. Select Save As if you want to keep a copy of the msi installer. The msi installer can be used for
Enterprise central deployment scenarios.
4. Refresh the page once installation completes.
5. The View and Change Settings icon
on the Scan Create New Job form becomes available after
page refresh.
6. The Kofax Web Capture Service icon
in the System Tray icons indicates if the service is running.

Install at custom location
For enterprise deployment scenarios where a custom Web Capture service installation location is
required, install Web Capture service as follows.
On the Command Prompt, type the following command:
msiexec /i Kofax.WebCapture.Installer.msi INSTALLFOLDER=<Installation Folder>

Use the Web Capture Service on multiuser environment
You can use the Web Capture Service on multiuser environments, such as MS Terminal Server and
Citrix. Multiple users can work with Web Capture Service at the same time from different Windows logon
sessions.

Use the Web Capture Service on MS Terminal Server
When using a Terminal Server, users can connect to the scan server simultaneously and perform
scanning tasks or import files in parallel. The Web Capture Service Host determines who exactly has
made the request and forwards the request to the appropriate Web Capture Service Worker. The Web
Capture Service Worker then works with devices and files that are available to the specific user.
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Note The Web Capture Service can only work with scanners attached to a remote Terminal Server; it
cannot work with locally connected scanners.
Similarly, for file import, the Web Capture Service provides access to files on a Terminal Server.

Use the Web Capture Service on Citrix
When both the Browser app and Web Capture Service are installed on the Citrix Server, the Web Capture
Service physically runs on a remote Citrix server, while a scanner is connected to the client user’s
computer. This works transparently for Web Capture Service when Citrix TWAIN Redirection is enabled.
Note The number of simultaneously active user sessions for one Citrix Server is limited to 50 sessions.

Install the Web Capture Service as Windows Service
To deploy and upgrade the Web Capture Service installed as Windows Service, you must have
Administrator rights.
To install the Web Capture Service as a Windows Service, enable the multiuser support features by using
the INSTALLASSERVICE command line option as follows:
msiexec /I Kofax.WebCapture.Installer.msi INSTALLASSERVICE=1
The MSI installation package is available in the TotalAgility installation folder at:
\\TotalAgility\TotalAgilityInstall\Agility.Server.Web\Forms\Controls\Capture
\external\webcapture

Upgrade the Web Capture Service
To upgrade the Web Capture Service installed as Windows Service, use the same command line
parameter that you used for installing the Web Capture Service.
Note You cannot upgrade the Web Capture Service installed as a Windows Service to the standalone
version. If you try to do so, the following message appears: This application cannot be installed because
you already have Web Capture Service installed as Windows service.
However, you can upgrade from the standalone installation to Windows.
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Scan Agent Service installation
The Scan Agent Service is offered through lightweight local agents that can be deployed through an msi
file included in the TotalAgility installation media.
You must have sufficient privileges to install system services, otherwise the Scan Agent Service
(ScanAgentService) cannot be installed.
Service account to use for Scan Agent Service:
If TotalAgility is configured to use Windows authentication then Active Directory account must be specified
that can authenticate within TotalAgility. Otherwise, the LocalSystem account can be used.
As Scan Agent Service needs access to user profile specific folders (to access scanned images) then
service account that is used for Scan Agent Service must have access to different user profiles. This
means that this account must have administrative privileges. For example, when Scan Agent Service is
installed on terminal server and/or different users (scan operators) use the same computer.
If Scan Agent Service is going to be deployed to end user computer then you may not require
administrator privileges. For example, if Scan Agent Service is going to upload images only for a particular
user then you can install Scan Agent Service under this user account.

Standard installation
1. On the installation media, navigate to \\ScanAgentService.
2. Double-click Kofax.TotalAgility.ScanAgentService.Installer.msi.
The Kofax TotalAgility Scan Agent Service Setup wizard starts.
3. Click Next.
4. In the End-user License Agreement window, select I accept the terms in the License
Agreement.
5. Click Next.
6. In the Destination Folder window, either accept the default location where the Scan Agent Service
must be installed, or click Change to choose another folder.
7. Click Next.
8. In the Service account setup window, specify the logon account (Windows account) for the Kofax
TotalAgility Scan Agent service.
9. Click Next.
10. Click Install to begin installation.
Once installed, a local service, "Kofax TotalAgility Scan Agent Service", is created on the workstation.
A companion "Scan Agent Monitor" is available, which can be used to monitor job upload status.
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Scanning with Scan Agent Service
The status bar of the Scan Create New Job form indicates if the session is connected to Scan Agent
Service.
The Scan Create New Job form offloads actual upload of images to Scan Agent Service. However if
image enhancement is enabled, the Scan Create New Job form performs image processing in a regular
way.
Once image processing operation (if any) is done, the "Create Job" button becomes available, even if
images have not been completely uploaded to the server. When you click "Create Job", the job appears in
the Scan Agent Monitor.
The Scan Agent Monitor can be used to monitor job upload status. The job upload statuses include:
• Pending: Job is being prepared for upload.
• In Progress: Job is currently being uploaded.
• Finished: Job has successfully being uploaded.
• Error: Job encountered an error and has been stopped.
• Paused: Job has been paused.
Depending on the job status, the following actions are available.
• Abort: Aborts and cancels the corresponding job, and prompts you for a TotalAgility user account to
cancel the job with.
Note This action uses a separate TotalAgility user session; if “Allow Multiple Logon” is not enabled,
the abort action ends any other session using the same user account.
• Pause: Pauses the upload session for the job. You must explicitly resume a paused job.
• Retry: Queues uploading job again if the job encounters an error. This action helps in recovering from
an upload error.
• Resume: Resumes a paused job.
• Clear Completed: Removes all uploaded complete jobs from the list.
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Launch TotalAgility
1. Enter http://[TA server hostname or IP]/TotalAgility/Designer/default.htm
URL in the browser.
2. Enter the login credentials used during installation.
TotalAgility Designer is launched in the browser.
3. Alternatively, click Start > All Programs > Kofax TotalAgility > Designer.

Launch TotalAgility Workspace
1. Enter http://[TA server hostname or IP]/TotalAgility/Forms/Custom/Logon.html
URL in the browser.
2. Enter the login credentials used during installation.
TotalAgility Workspace launches in the browser.
3. Alternatively, click Start > All Programs > TotalAgility > Workspace.

Guidance notes on logon
You can configure a single Kofax TotalAgility web installation using either of the following as these
configurations are mutually exclusive:
• Windows Authentication
• Manual Logon
For example, if an organization requires "manual logon" for external users and "Windows authentication"
for internal users, you cannot achieve this with a single web installation. You need two separate web sites,
one to use Windows authentication and the other to use Manual logon. You can use the following options
to achieve this configuration.
• Two separate web servers where one web server will have a Kofax TotalAgility web installation using
Windows authentication, and another web server will have a Kofax TotalAgility web installation using
manual logon (preferred). You can upgrade the servers as they are installed using the Kofax TotalAgility
installation program (by the Kofax TotalAgility installation / upgrade program).
• Single web server containing two TotalAgility web sites, where one website is configured to use manual
logon and another website configured to use Windows authentication. The administrator setting up this
server will install Kofax TotalAgility web installation and then clone the virtual directory.
Note You can upgrade the original Kofax TotalAgility web installation, but not the cloned virtual
directory.

149

Chapter 18

Repair the TotalAgility installation
Repairing TotalAgility will only repair the application and not the database.
To repair any TotalAgility product components that are installed incorrectly:
1. Click Start > All Programs > Kofax TotalAgility and select Uninstall or Repair.
The Repair/Uninstall window opens.
2. Click Repair and click Next.
The Components To Repair window opens and lists all the components you can repair.
3. Select the components to repair.
4. Click Browse and select the installation files.
5. Click Next.
The Credentials window opens.
6. Enter the Password or select the Run as System Account check box to choose the system
credentials.
7. Click Next.
The Repair Progress window opens. When the repair is complete, the Repair Complete window
opens. The summary report lists the components, servers, applications and services repaired.
8. Click Finish.
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Uninstall TotalAgility
Uninstalling TotalAgility only removes the application and not the database.

Use the installation wizard
1. Click Start > All Programs > Kofax TotalAgility and select Uninstall or Repair Kofax TotalAgility.
The Repair/Uninstall window opens.
2. Select Uninstall and click Next.
3. Follow the prompts until you are informed that the product is uninstalled, and then click Finish.
The summary report lists the components, servers, applications and services uninstalled.
If any errors occur during uninstallation, you can view them in the TotalAgility log file called Kofax
TotalAgilityInstallationErrorLog.txt on your desktop. This log file contains information about any
errors.

Use the silent mode
1. On the Command Prompt, change the command line to the root directory of the Setup.exe file.
2. Run Setup.exe /Silent /U.
The system uninstalls TotalAgility and automatically creates a log file on your desktop. This log file
contains information on errors, if any. The removal of the product is indicated in the event log.
Note Uninstalling TotalAgility in silent mode not only removes the applied fix pack or service pack
but also removes the Kofax TotalAgility application completely. To reinstall TotalAgility, you must
install its base version and then apply any patches.
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Upgrade process
You can upgrade TotalAgility from 7.0.2, 7.1.0, 7.2.0 (or any interim patches), 7.3.0 (or any interim
patches) or 7.4.0 (or any interim patches) or 7.5.0 (or any interim patches) to 7.6.0.
You can choose to upgrade TotalAgility components and databases independent of each other or upgrade
TotalAgility components including databases.
Note Before upgrading TotalAgility, ensure TotalAgility App Pool and all the TotalAgility Services are
stopped, and the databases are backed up.
On upgrade, the TotalAgility installer restores the following configuration settings:
• All existing AppSettings
• All existing Security Bindings
• All HTTP URL Rewrites to be done for TotalAgility 7.6.0.

Upgrade TotalAgility components
To upgrade TotalAgility components such as License Proxy, Transformation Designer and Transformation
Server, perform the following steps.
1. Navigate to TotalAgility Installation media and double-click Setup.exe.
The User Account control window opens.
2. Click Next.
3. In the Kofax TotalAgility Upgrade window, select TotalAgility components and click Next.
The Credentials window opens.
4. Enter the credentials (password and confirm password) and click Next.
The Installation Review window opens and displays the settings.
5. Enter the credentials (password and confirm password) and click Next.
The Installation Progress window opens. The setup installs the required components.

152

Kofax TotalAgility Installation Guide

6. Click Finish to complete the installation.
If any errors occur during upgrade, TotalAgility creates a log file called Kofax
TotalAgilityInstallErrorLog.txt on your desktop. Fix the errors.
After upgrading TotalAgility components, if you want to upgrade databases, do the following:
a. Navigate to TotalAgility Installation media and double-click Setup.exe.
The Repair/Uninstall/Upgrade Databases window opens.
Note Alternatively, you can select the Upgrade Databases option from the Repair/Uninstall/
Upgrade Databases window by clicking Start > All Programs > Kofax TotalAgility and select
Uninstall or Repair Kofax TotalAgility.
b. Select Upgrade Databases.
c. To Import the Workspace package, select the Import system Workspace package check box.
d. Click Next and follow the instructions.

Upgrade TotalAgility databases
1. Navigate to TotalAgility Installation media and double-click Setup.exe.
The User Account control window opens.
2. Click Next.
3. In the Kofax TotalAgility Upgrade window, select TotalAgility databases and click Next.
The Credentials window opens.
4. Enter the credentials (password and confirm password) and click Next.
The Installation Review window opens and displays the settings.
5. Enter the credentials (password and confirm password) and click Next.
The Installation Progress window opens. The setup installs the required components.
6. Click Finish to complete the installation.
If any errors occur during upgrade, TotalAgility creates a log file called Kofax
TotalAgilityInstallErrorLog.txt on your desktop. Fix the errors.
If any database script errors occur, TotalAgilitycreates a log file called CEBPMDatabaseErrorLog.txt
on your desktop. Fix the errors and run Agility.server.upgrade.exe.
After upgrading databases, if you want to upgrade TotalAgility components, do the following:
a. Navigate to TotalAgility Installation media and double-click Setup.exe.
The User Account control window opens.
b. Click Next.
The Kofax TotalAgility Upgrade window opens.
c. To manually start the services after the installation is complete, clear the Automatically start
services check box. By default, the system starts the services automatically.
d. To Import the Workspace package, select the Import system Workspace package check box.
e. Click Next and follow the instructions.
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Upgrade Kofax TotalAgility components including databases
1. Navigate to TotalAgility Installation media and double-click Setup.exe.
The User Account control window opens.
2. Click Next.
3. In the Kofax TotalAgility Upgrade window, select Upgrade Kofax TotalAgility components
including databases and click Next.
The Credentials window opens.
4. Enter the credentials (password and confirm password) and click Next.
The Installation Review window opens and displays the settings.
5. Enter the credentials (password and confirm password) and click Next.
The Installation Progress window opens. The setup installs the required components.
6. Click Finish to complete the installation.
If any errors occur during upgrade, TotalAgility creates a log file called Kofax
TotalAgilityInstallErrorLog.txt on your desktop. Fix the errors.
If any database script errors occur, TotalAgility creates a log file called
CEBPMDatabaseErrorLog.txt on your desktop. Fix the errors and run Agility.server.upgrade.exe.

Upgrade databases manually
When upgrading TotalAgility from 7.0.2, 7.1.0, 7.2.0, 7.3.0, 7.4.0 or 7.5.0 to TotalAgility 7.6.0, do the
following.
1. To run scripts manually, go to \\TotalAgility\TotalAgilityInstall\DatabaseScripts
\SQL Server\Upgrade Database Scripts.
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2. Run the conversion scripts (if exist) for all releases and patches starting from the version upgrading
from to the version being upgraded to.
Example: If upgrading from 7.2.0.0 to 7.6.0, run the following conversion scripts.
• 7.2.0.0 to 7.2.1.0 Conversion Scripts
• 7.2.1.0 to 7.2.2.1 Conversion Scripts
• 7.2.2.1 to 7.3.0.0 Conversion Scripts
• 7.3.0.0 to 7.3.0.2 Conversion Scripts
• 7.3.0.2 to 7.3.1.0 Conversion Scripts
• 7.3.1.0 to 7.3.1.2 Conversion Scripts
•
•
•
•
•
•
•
•

7.3.1.2 to 7.4.0.0 Conversion Scripts
7.4.0.0 to 7.4.0.1 Conversion Scripts
7.4.0.1 to 7.4.1.0 Conversion Scripts
7.4.1.0 to 7.4.1.1 Conversion Scripts
7.4.1.1 to 7.5.0.0 Conversion Scripts
7.5.0.0 to 7.5.0.5 Conversion Scripts
7.5.0.5 to 7.5.0.10 Conversion Scripts
7.5.0.10 to 7.6.0.0 Conversion Scripts

Run the scripts in the following order across databases and follow the instructions inside each script.
a. Convert_Main.sql on the TotalAgility database.
b. Convert_Audit.sql on the Audit database.
c. Convert_Archive.sql on the Finished Jobs database.
Note If Audit and Archive databases are maintained with the same name as the TotalAgility
database, then run the Convert_Audit.sql and Convert_Archive.sql scripts on the
TotalAgility database.
d. Convert_Forms.sql on the TotalAgility database.
e. Convert_KLS_OnPremise.sql on the TotalAgility database.
f. Convert_Simulator.sql on the TotalAgility_Simulator database.
g. Convert_PI.sql on the PI database. Run this script only if the PI database was already setup
in earlier install, otherwise do not run this script.
h. Convert_DataLayer.sql on the TotalAgility_Documents database.
i. Run the following conversion scripts for the Reporting databases:
• KofaxReportingAnalytics.SQL_Convert.sql on the TotalAgility_Reporting database.
• KofaxReportingAnalytics.Staging.SQL_Convert.sql on the
TotalAgility_Reporting_Staging database.

If the previous version of TotalAgility, such as TotalAgility 7.0.2 did not include
reporting databases, you must first create the TotalAgility_Reporting database and the
TotalAgility_Reporting Staging database and update the Web.config file accordingly.
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3. Navigate to <C:\Program Files\Kofax\TotalAgility\Agility.Server.Web\bin> and
open Agility.Installation.Server.Upgrade.exe.config. In the <appSettings> section, update the
value for the following settings.
• <add key="UpgradeFromVersion" value =""/> where the value is the TotalAgility
version from which you want to perform an upgrade. For example, if you are upgrading
TotalAgility from 7.5.0 to 7.6.0, set the value as follows: <key="UpgradeFromVersion" value
="7.5.0"/> .
• <add key="SystemSessionId" value="" />. Take the system session ID from the
TotalAgility Designer or from the database.
• <add key="UserName" value="" /> where the user name is the currently logged on user's
name.
4. From the command prompt, run Agility.Installation.Server.Upgrade.exe by passing
the Agility.Installation.Server.Upgrade.exe <ImportWorkspacepackage> as a
parameter, such as Agility.Installation.Server.Upgrade.exe false. If you want to
import the Workspace package, pass the Agility.Installation.Server.Upgrade.exe
true as a parameter.
5. Ensure that no error log is created. If any errors occur, a log file called
KofaxUpgradeDatabaseUtilityError.txt is created on your desktop. Fix those errors and repeat the
above steps.
6. Start the Kofax TotalAgility Core Worker service manually:
a. At Run, type Services.msc and press Enter.
b. Right-click Kofax TotalAgility Core Worker and click Start.

Upgrade reporting databases 2.0.2
Run the following scripts to upgrade the Reporting databases 2.0.2 manually:
1. Run the script from TotalAgilityInstall\DatabaseScripts\SQL
Database Scripts \ 7.0.2 -> 7.1.0.
2. Run the script from TotalAgilityInstall\DatabaseScripts\SQL
Database Scripts\ 7.1.0 -> 7.2.0.
3. Run the script from TotalAgilityInstall\DatabaseScripts\SQL
Database Scripts\ 7.2.0 -> 7.3.0.
4. Run the script from TotalAgilityInstall\DatabaseScripts\SQL
Database Scripts\ 7.3.0 -> 7.4.0.
5. Run the script from TotalAgilityInstall\DatabaseScripts\SQL
Database Scripts\ 7.4.0 -> 7.5.0.
6. Run the script from TotalAgilityInstall\DatabaseScripts\SQL
Database Scripts\ 7.5.0 -> 7.6.0.

Server\Upgrade
Server\Upgrade
Server\Upgrade
Server\Upgrade
Server\Upgrade
Server\Upgrade

Note If you are upgrading from TotalAgility 7.1.0 to 7.6.0 (with Reporting as a part of TotalAgility
7.6.0), ensure that all the Reporting Staging database tables are empty before performing any
automatic or manual upgrade.
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Upgrade TotalAgility in silent mode
See Upgrade TotalAgility in silent mode.
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Troubleshooting
This section describes the issues you may encounter and their resolution.

Installation failure in IPv4 and IPv6 environment
If SQL server is configured to listen only on IPv6 addresses on a dual-stack (IPV46), client connection
attempts using IPv4 address will fail and it may take longer than default timeout, contributed by default
TCP timeout logic during connection establishment handshakes. Even though the subsequent IPv6
connection can succeed immediately, the connection may still fail.
To resolve this issue, disable IPv4 in SQL Server Configuration Manager.
1. Start SQL Server Configuration Manager.
2. Open the Properties for the TotalAgility server instance TCP/IP protocol.
3. Set Listen All to No.
Note This setting allows fine control over which interfaces the TAServerSQLInstance will listen for
connections.
4.
5.
6.
7.

Click the IP Address tab.
Set Enabled to No for all entries except for ::1 which is the IPv6 local host address.
Select OK to commit changes and OK at the service restart dialog.
Restart the SQL Server (<TAServerInstance>) service where TAServerInstance is the actual instance
used by TotalAgility (for example, Kofax TotalAgility).

TotalAgilityAppPool exists
TotalAgility creates an application pool called TotalAgilityAppPool. Ensure you do not have an existing
application pool of the same name as it may cause issues when installing or upgrading.

Images not displayed in Workspace after scanning
No images are displayed on Workspace after scanning if you log into machine as non-admin user. The
images display normally if you login as admin user.
1. If you have not installed DosadiLog, the diagnostic logging tool for the WebCapture plugin, please do
so now. See the instructions and download link at: http://www.eztwain.com/dosadilog.htm.
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2. Edit the <system.diagnostics> section of the Web.config file as follows:
Note If you copy and paste the code from this guide, fix the line breaks.
<system.diagnostics>
<!--<sources>
<source name="System.ServiceModel"
switchValue="Information, ActivityTracing"
propagateActivity="true">
<listeners>
<add name="traceListener"
type="System.Diagnostics.XmlWriterTraceListener"
initializeData= "c:\log\Traces.svclog" /> </listeners> </source> </sources>-->
<trace autoflush="true">
<listeners> <add name="ThinClientServer" traceOutputOptions="DateTime,ThreadId"
type="System.Diagnostics.TextWriterTraceListener" initializeData="c:
\ThinClientServerLog.txt">
<filter type="System.Diagnostics.EventTypeFilter" initializeData="Verbose" /> </
add>
<!--<add type="Microsoft.WindowsAzure.Diagnostics.DiagnosticMonitorTraceListener,
Microsoft.WindowsAzure.Diagnostics, Version=1.0.0.0, Culture=neutral,
PublicKeyToken=31bf3856ad364e35"
name="AzureDiagnostics">
<filter type="" />
</add>-->
</listeners>
</trace>
</system.diagnostics>

3. To ensure that non-admin users are able to log in, add the link to Trusted Sites:
a. Go to Internet Options in IE 11.
b. Click the Security tab.
c. Click Sites.
d. Add the domain to the trusted sites, for example, http://<domain>.

Exception during Transformation Designer projects import
An exception is thrown while importing projects using Transformation Designer that connects to a
TotalAgility web service that uses SSL.
1. If you select to run your server using SSL, make sure the Client certificates option is set to Ignore
under SSL Settings.
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2. If you want to use Client certificates for authentication (Accept or Require), you must set the value for
uploadReadAheadSize in IIS. Use either option to adjust this setting:
• In the IIS Manger:
a. Open the Configuration Editor of the TotalAgility site.
b. In the Section list, expand system.webServer and select serverRuntime.
c. In the From list, select ApplicationHost.config <location path=’Default Web Site/
Totalgility’/>.
d. Set an appropriate value in bytes for uploadReadAheadSize.

• Or, modify the IIS main config file:
a. Open the applicationHost.config file located under C:\Windows\System32\inetsrv
\config\.
b. If the <serverRuntime> node does not exist yet, add it below the <security> node within
<system.webServer>.
<location path="Default Web Site">
<system.webServer>
<security>
…
</security>
<serverRuntime uploadReadAheadSize="10485760" />
</system.webServer>
</location>

c. Set an appropriate value in bytes for uploadReadAheadSize.

Download software updates
When downloading an installation package or a service pack from ftp.kofax.com site, please ensure this
site is added as a trusted site, otherwise the downloaded file may get corrupted.
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Search feature not working in TotalAgility help
• The TotalAgility Help Search functionality does not work when Designer is run from Start > All
Programs.
To resolve this issue, add the site as a trusted site in Internet Explorer: Internet Options > Security >
Trusted Sites > Sites
• The TotalAgility Help Search functionality does not work in Designer and Workspace for Internet
Explorer 9.
To resolve this issue, navigate to Tools > Compatibility Settings in Internet Explorer 9 and clear the
following two options:
• Include updated website lists from the Microsoft
• Display intranet sites in Compatibility View

Site location invalid error
SharePoint security issues can occur when the TotalAgilitySharePointCommunicator web service hosted
in IIS does not have permission to access the SharePoint site in IIS. This can cause a "Site location is
invalid" error when integrating TotalAgility with SharePoint.
To resolve this issue:
1. Ensure the TotalAgilitySharePointCommunicator web service is running under the same application
pool as your SharePoint site. Depending on the security trust level within SharePoint, TotalAgility can
cause communication failures between TotalAgilitySharePointCommunicator and SharePoint due to
permissions.
2. Turn off ASP impersonation on the TotalAgilitySharePointCommunicator web service in IIS (if
enabled); ASP impersonation is not supported by the SharePoint application pool and may cause
permission issues with remote SharePoint and TotalAgility servers.

(405) Method not allowed error
While Installing TotalAgility, the error "(405) Method Not Allowed" may occur.
To resolve the issue, re-register ASP.NET 4.x for IIS.
1. Open the command prompt.
2. Navigate to %WINDIR%\Microsoft.NET\Framework\v4.0.30319 .
3. Execute aspnet_regiis.exe-i.

MimeType error
When trying to access the Tenant Management or TotalAgility websites from the IIS, and the web page
does not render with the following error: Cannot add duplicate collection entry of type
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mimeMap with unique attribute field Extension set to .xap; this means there are
conflicting mime types in two different configuration files (for example, one at the application level and the
other at the site level).
To resolve this issue, do either of the following:
1. Remove one of the two conflicting mimeMap extensions from the configuration files.
2. If the IIS Administrator needs both the conflicting mime mappings, add the remove tag above the
conflicting mimemap.
Example If your application has the following mimemap in the application level configuration file:
<mimeMap fileExtension=".xap" mimeType="application/octet-stream" /> (for
example, located at //inetpub/wwwroot/web.config); if this mimemap creates a conflict with
the same mimemap in the applicationhost.config file, add <remove fileExtension=".xap" /> above
the mimemap as follows:
<remove fileExtension=".xap" />
<mimeMap fileExtension=".xap" mimeType="application/octet-stream" />

where .xap is the mime type.
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